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Chapter 1:

INTRODUCTION
This chapter gives an overview of NetVault: Backup and describes the features
and benefits of the product. The information in this chapter is organized into the
following topics:

1.1.0



NetVault: Backup – At a Glance



Key Benefits



Feature Summary



About this Document



Target Audience



Recommended Additional Reading



Technical Support



Documentation Updates

NetVault: Backup – At a Glance
With NetVault: Backup (NVBU), you can take advantage of the power of simplicity
because having less time wrapped up in backup and recovery processes creates
more time for more interesting and strategic initiatives. For example, with the
NetVault: Backup Application Plugin Modules (APMs) you are not required to
script backup and recovery jobs, so you do not need to understand storage,
database or email internals. You select the backup strategy that best fits your
database or email environment, and then just point and click. The same holds true
for virtualization protection – no scripting required. NVBU protects data and
applications from a common, user friendly console. Plus, its ease of use makes it
simpler for a new person step in to assume data protection responsibilities. NVBU
is enterprise level software that does not require you to be an expert because it
installs out of the box, but has the flexibility to tune it as you want.
Every organization changes all the time, so BakBone engineered NVBU to keep
up with those changes and let you make choices that are best for your company.
For example, if an organizational merger takes place or a key department acquires
a major application that requires a different platform, that is no problem with
NVBU’s heterogeneous server and extensive application support. The freedom of
choice continues with BakBone’s disk-based data protection product,
NetVault: SmartDisk (NVSD) and its deduplication option which provides seamless
integration with NVBU to allow you to be in control of which data should be
deduplicated and which should not without restricting you to specific types of
storage drives and appliances. Additionally, administrators have increased choice
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including the ability to copy or move data between NVSD Instances, to Virtual
Tape Library (VTL) or tape based devices in order to place redundant backups at
offsite locations for failover and disaster recovery purposes. You can select your
backup device of choice from a very large list of supported Network Attached
Storage (NAS), VTL and tape systems. You decide when and where to encrypt to
reduce backup windows while still meeting regulatory requirements. You can
deploy and protect physical or virtual machines. With the APMs, you easily select
the best backup method to protect all the popular operating systems, messaging
and database applications. NVBU SmartClient gives you the freedom to attach
virtual and physical tape devices where you want to.
Budgets are not unlimited and are shrinking in many cases, so NVBU was
architected to protect and leverage existing investments in data protection while
making necessary changes and upgrades to support the growth and health of your
organization. NVBU’s ability to efficiently scale from small installations to very
large global companies means you would not be penalized by being forced to rip
and replace your data protection infrastructure just because your organization is
successful and growing. The NVSD product integrates with NVBU to shrink
backup windows and reduce storage costs with its post-process deduplication
option which can be scheduled outside the backup window. Your investment in
storage systems is protected through automated access to hundreds of different
storage devices. You avoid vendor lock-in by taking advantage of NVBU’s
heterogeneous server support as well as powerful messaging, database and
virtualization protection options. With NVBU, you protect your vital IT assets
because you can still recover your data even in a worst case scenario in which you
only have your backup media, but no NVBU database. Plus, you can redeploy into
a different operating system for an emergency recovery.

1.2.0

Key Benefits


Power of Simplicity
It is critical to an organization’s success that all employees work together to
meet its strategic initiatives. To ensure success, all employees must have
time to work on these strategic initiatives. NVBU’s power of simplicity frees
your time by enabling you to protect your data without requiring you to
understand the inner workings of storage, databases and e-mail applications.
NVBU provides enterprise-level functionality in an easy-to-use-and-deploy
solution. You can protect platforms, applications and technologies with the
same solution, to save you valuable time and resources.



Enhanced Administrator Productivity
Your organization’s world changes all the time, so we engineered NVBU to
work within your environment and not force you to modify your platform,
application, or storage to fit NVBU. We give you the widest range of
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supported storage devices with the flexibility to adjust to ever-changing
conditions.


Safeguards Your Investment
NVBU protection easily scales from a single server to Fortune 500
environments without having to rip and replace your data protection solution
as your organization grows. You also will not have to rip and replace NVBU if
you change strategic directions with regards to platforms, databases,
applications, or storage devices. NVBU’s seamless integration with NVSD
protects your storage investment with a powerful deduplication option that
does not require you to buy specific drives or appliances. NVBU also
provides very flexible disaster recovery options to protect your entire
datacenter for business continuity.

1.3.0

Feature Summary


Heterogeneous Server Support



Application Protection for Most Popular Database and Messaging Systems



Virtualization Protection for VMware and Hyper-V



Physical and Virtual Protection from Single Console



Disk-based Data Protection



Hardware Agnostic, Byte-Level Variable Block-Based Software Deduplication



Job-level Deduplication



Job-level Encryption



Workstation Protection



Easy-to-Navigate Console



Network Attached Storage Integration



Extensive Storage Device Coverage



Automated Device Discovery and Configuration



Reporting



Scalability



Extensive Event Notification



Dynamically Shared Devices



SmartClient



User Level Access



Policy Management



Job Management
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1.4.0

About this Document
This guide describes how to use NetVault: Backup and provides comprehensive
information on all NetVault: Backup features and functionality.

1.5.0

Target Audience
This guide is intended for Backup Administrators and other technical personnel
who are responsible for designing and implementing a backup strategy for the
organization. A good understanding of the operating systems under which the
NetVault: Backup Server and Clients are running is assumed.

1.6.0

Recommended Additional Reading


NetVault: Backup Installation Guide – This guide provides complete details
on installing the NetVault: Backup Server and Client software.



NetVault: Backup Configuration Guide – This guide explains how to change
the preferences and default settings for NetVault: Backup.



NetVault: Backup Command Line Interface Reference Guide – This guide
provides detailed description of the command line utilities.



NetVault: Backup Workstation Client Administrator’s Guide – This guide
provides complete information on administering the NetVault: Backup
Workstation Client software.



NetVault: Backup Workstation Client User’s Guide – This guide provides
complete information on using the NetVault: Backup Workstation Client
software.



NetVault: SmartDisk Installation Guide – This guide provides complete details
on installing the NetVault: Backup SmartDisk software.



NetVault: SmartDisk Administrator’s Guide – This guide provides complete
information on administering a NetVault: SmartDisk instance.

You can download these guides from the BakBone website at the following
address:
http://www.bakbone.com/documentation

1.7.0

Technical Support
BakBone Software is dedicated to providing friendly, expert advice to NetVault
customers. Our highly trained professionals are available to answer your
questions, offer solutions to your problems and generally help you make the most
of your NetVault purchase. Log on to our web site for more information:
http://support.bakbone.com
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Documentation Updates
For the latest documentation updates, refer to the BakBone Software Knowledge
Base. BakBone's Knowledge Base article for NetVault: Backup v8.5 can be found
at the following link:
http://kb.bakbone.com/5205
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Chapter 2:

NVBU CONSOLE
This chapter provides an overview of the NVBU Console. The information in this
chapter is organized into the following topics:


Starting and Stopping the NVBU Service



Starting NVBU Console





Starting NVBU Console on Linux/UNIX



Starting NVBU Console on Windows

Logging on to NVBU


2.1.0

Logging on as a Different User



NVBU Console Basics



Using the Shortcut Keys

Starting and Stopping the NVBU Service
The NVBU Service will start automatically when the software installation
completes on the Server and Client machines. In situations when you want to
manually stop or start the NVBU Server, perform the following steps:
1. Start NVBU Configurator as described below:
a. Linux/UNIX
1. Log on to the system with root user privileges.
2. Start a terminal session and issue the following command:
nvconfigurator
Alternatively, add ampersand (&) for an open prompt:
nvconfigurator &
You can issue this command from any directory.
b. Windows
1. Log on to the system with administrator privileges.
2. Click Start on the taskbar.
3. Point to Programs, point to BakBone Software, point to NetVault
Backup, and then click NVBU Configurator.
2. Click the Service tab.
3. To stop the Service, click Stop Service.
4. To start the Service, click Start Service.
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5. Click OK to apply the changes and exit Configurator.

2.2.0

Starting NVBU Console
The following sections describe how to start the NVBU Console on Windows and
Linux/UNIX platforms.
Note: The NVBU Server and the Clients must be set to the same locale to display
the Console correctly.

2.2.1

Starting NVBU Console on Linux/UNIX
To start the NVBU Console on Linux/UNIX platforms, perform the following steps:
Note: Before you proceed, ensure that the path variable contains all the font
paths.
1. Log on to the system with root user privileges.
2. Start a terminal session and issue the following command from any directory:
nvgui
Alternatively, add ampersand (&) if you want an open prompt:
nvgui &
Note: On Linux Itanium platforms, the kernel logs several Unaligned Access To
messages when you start the NVBU Console. These messages are informative
and do not require any attention. To stop these messages run the command
dmesg -n4 after every reboot. For more information on the Unaligned Access To
messages, refer to the following article:
http://kbase.redhat.com/faq/docs/DOC-6022

2.2.2

Starting NVBU Console on Windows
To start the NVBU Console on Windows, perform the following steps:
1. Log on to the system with administrator privileges.
2. Click Start on the taskbar.
3. Point to Programs, point to BakBone Software, point to NetVault Backup,
and then click NVBU Console.
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Logging on to NVBU
By default, no login prompt is displayed when you start the NVBU Console. NVBU
automatically logs on as the default user when no password is configured for this
user account. You will see a login prompt if the administrator has set a password
for the default user account. In this situation, perform the following steps to log on
to the NVBU Console:

Figure 2-1:
NVBU Logon
window

1. In the Welcome To list, the NVBU Server that controls the Domain is
selected by default. Do not change it unless you want to log on to a different
NVBU Domain. To log on to a different Domain, select the NVBU Server for
that Domain in the list.
2. In the User box, enter your user name.
3. In the Password box, enter the password for your user account.
4. Select the Use this Login from Now On check box to save the user name.
5. Click OK.
Note: To change your password at logon, select the Change Password check
box. In the Set User Password window, set the new password. For details on
changing password refer to Setting User Account Password on page 200.

2.3.1

Logging on as a Different User
To change the user when NVBU has automatically logged on default, perform the
following steps:
1. On the NVBU home screen, click Log Off on the File menu to log out default.
2. In the NVBU Logon window, provide the login information. For details, refer to
Logging on to NVBU on page 21.
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2.4.0

NVBU Console Basics
The NVBU window consists of the menu bar, the toolbar, the Large Buttons panel
and the status bar.

Figure 2-2:
NVBU Home
Screen



Menu Bar
The menu bar displays the menus, which contain commands to perform
various tasks in NVBU. The main tasks are organized under the Operations
and Administration menu as follows:




Operations Menu – This menu contains the following commands:


Backup



Restore



Status



Media Management



Job Management



Reports



Logs

Administration Menu – This menu contains the following commands:


Client Management



Domain Management



Device Management



Policy Management



Access Control



Global Notification
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To perform a task, open the corresponding task window. For example, to
administer NVBU Clients, open the NVBU Client Management window as
described below:
On the Administration menu, click Client Management.
The commands on the menu bar vary depending on the active window. For
example, the menu items for the Client Management window are different
from the NVBU home screen.


Toolbar and the Large Buttons Panel
For the frequently accessed functions, NVBU provides toolbar buttons on the
standard toolbar and the Large Buttons panel. You can use these buttons to
open a window with a single click. For example, to open the NVBU Client
Management window, click Client Management on the toolbar or Large
Buttons panel.
To hide or show the toolbar and/or Large Buttons panel, perform the following
steps:
a. To hide the standard toolbar, clear the check mark for Tool Bar on the
View menu. To hide the Large Buttons panel, clear the check mark for
Large Buttons on the View menu.
b. To display them again, select Tool Bar and/or Large Buttons on the View
menu.



Status Bar
The status bar displays the user name and current BakBone Time on the
NVBU Server. For details on BakBone Time, refer to the NetVault: Backup
Configuration Guide.

2.5.0

Using the Shortcut Keys
You can also use the following shortcut keys to open a task window from the
NVBU home screen:
Shortcut Key

To do this

A

Open the About window

B

Open the NVBU Backup window

C

Open the NVBU Client Management window

D

Open the NVBU Device Management window

H

Show/hide the Large Buttons panel

J

Open the NVBU Jobs window

L

Open the NVBU Logs window
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Shortcut Key

To do this

M

Open the NVBU Media Management window

N

Open the NVBU Global Notification window

P

Open the NVU Policy Management window

R

Open the NVBU Restore window

S

Open the NVBU Status window

T

Show/hide the standard toolbar

U

Open the NVBU Access Control window

F1

Open the Help window

F2

Open the NVBU Report Component Editor
window

F3

Open the NVBU Report Job Editor window

F4

Open the NVBU Historic Reports window

F5

Open the NVBU Reports window

F6

Open the NVBU Domain Management window

F7

Open the NVBU Access Control window

F8

Open the NVBU Global Notification window
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Chapter 3:

NVBU CLIENT MANAGEMENT
This chapter describes how to add and manage the NVBU Clients. The
information in this chapter is organized into the following topics:


NVBU Clients – An Overview



Adding Heterogeneous Clients
Locating a Client



Adding NVBU Server as a Heterogeneous Client



Client Status Indicators



Administering Added Clients



3.1.0





Viewing NVBU Client Properties



Checking Client Access



Establishing the Firewall Relationship



Setting Client Description



Removing a Client from the NVBU Domain

Working with Client Groups


Client Groups – An Overview



Creating Client Groups



Modifying a Client Group



Removing a Client Group

NVBU Clients – An Overview
NVBU is designed to work in an environment in which one machine is configured
as NVBU Server and various other machines throughout the network act as NVBU
Clients assigned to it. A single NVBU Server and its Clients form an NVBU
Domain. The Server acts as the Domain Controller for the NVBU Domain. NVBU
Clients are machines which act as backup or restore targets. The NVBU Clients
are classified as Heterogeneous Clients or Workstation Clients.
Note: To understand the difference between Heterogeneous Clients and
Workstation Clients, refer to the NetVault: Backup Installation Guide.
NVBU Clients require at least the Client version of the NVBU software and TCP/IP
connectivity to the NVBU Server. The NVBU Server and Clients can reside on
separate networks. A Heterogeneous Client can be a member of more than one
NVBU Domain. An NVBU Server acts as a Heterogeneous Client to itself and can
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also be added as a Heterogeneous Client to another NVBU Server. Clients which
have locally-attached backup devices are called SmartClients. Such clients
require additional SmartClient licenses.

3.2.0

Adding Heterogeneous Clients
In order to target a Heterogeneous Client for a backup or restore operation, you
must first add the Client to the NVBU Server. The NVBU Client software version
cannot be higher than the NVBU Server software version. To add a
Heterogeneous Client, perform the following steps:
Note: For details on adding Workstation Clients to the NVBU Server, refer to the
NetVault: Backup Workstation Administrator's Guide.
1. Click Client Management on the toolbar or Large Buttons panel to open the
NVBU Client Management window. Alternatively, on the Administration
menu, click Client Management.
2. NVBU provides a list of eligible NVBU Clients under Available NVBU
Machines. These are machines on which you have installed either the NVBU
Server or the Client software. The icon to the left indicates the current status
of the Client:

Figure 3-1:
NVBU Client
Management
window
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A Blue or Dimmed Blue icon represents a Client that is up and running.
It can be added without any additional requirement.
A Blue/Dimmed Blue Icon with a Key represents a Client that is
currently available. However, this Client is password-protected. To add it,
you will require the NVBU password for the machine.
A Red Icon represents a Client that is currently not available. Try adding
it later when it becomes online.
3. To add an online Client, double-click the Client in the Available NVBU
Machines list. Alternatively, right-click the Client and select Add as Client.
4. Ignore this step if you have not created any user-defined Client Groups. For
details on NVBU Client Groups, refer to Working with Client Groups on page
32. NVBU automatically adds a Client to the default group if no user-defined
Client Groups have been created on the Server.
On an NVBU Server with one or more user-defined Client Groups, the Add
Client to Groups window will appear next.
Figure 3-2:
Add Client to
Groups
window

In the Select Group(s) list, select the Client Group(s) to which you want to
add the Client. Use the Shift+Click or Ctrl+Click keys to add the Clients to
multiple consecutive and non-consecutive groups, respectively.
Note: You can also change the group membership later by modifying a Client
Group. For details, refer to Modifying a Client Group on page 33.
5. Ignore this step for Clients which do not have an NVBU password. Such
Clients are added to the Server without any further action.
For password-protected Clients, a Password Required window will appear
next.
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Figure 3-3:
Password
Required
window

In the Enter Password box, enter the NVBU password for the Client and
click OK. Upon password verification, the Client will be added to the NVBU
Server and listed under Clients.

3.2.1

Locating a Client
To locate a Client that is not listed under Available NVBU Machines, perform the
following steps:
1. In the Machine Name or IP Address box under Find NVBU Machine, enter
the NVBU name for the client or its IP address.
2. Click Find. NVBU rescans the network to locate the client. If found, the client
is listed under Available NVBU Machines in alphabetical order.
Note that a search may fail for a number of reasons, including the following:

3.2.2



The DNS lookup table or the machine’s host table cannot be contacted.



The NVBU Service is not running on the machine.



NVBU software is removed from the machine.

Adding NVBU Server as a Heterogeneous Client
To add an NVBU Server as a Heterogeneous Client to another NVBU Server,
perform the following steps:
1. Start the Configurator.
2. On the Security tab, select This Machine May be Added as a Client to a
Server to change the default security settings.
3. To add the Server as a member client, refer to Adding Heterogeneous Clients
on page 26.
Note: An NVBU Server cannot simultaneously act as a Workstation Client and an
NVBU Server. An NVBU Server cannot be added as a Workstation Client to
another NVBU Server.
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Client Status Indicators
The NVBU Clients that are added to a Server are listed under Clients on the
NVBU Client Management window. The current status of these Clients is
indicated using one of the following status indicators:
A Blue or Dimmed Blue icon indicates that the Client is up and running.
A dimmed icon represents a machine running a version prior to v8.0.
A Blue/Dimmed Blue Icon with a Key indicates one of the following:


The Client is in the process of being added.



The NVBU password has changed since the Client was added.

A dimmed icon represents a machine running a version prior to v8.0.
A Red icon indicates that the Client is currently unavailable. Either the
machine is offline or the NVBU Service is not running.
A Yellow icon represents a Virtual Client which consists of a cluster of
Clients. For details on Virtual Clients, refer to NVBU Client Clusters on
page 237.
A Green Laptop indicates that the Workstation Client is online. It is
powered on and has network connectivity to the NVBU Server.
A Red Laptop indicates that the Workstation Client is offline. It is
powered off or does not have any network connectivity to the NVBU
Server.
The NVBU Server Status window provides a consolidated view of the Clients,
Devices and Jobs. To open the NVBU Server Status window, click Status on the
toolbar or Large Buttons panel. Alternatively, on the Operations menu, click
Status.

3.4.0

Administering Added Clients
This section describes the various NVBU Client administration procedures.

3.4.1

Viewing NVBU Client Properties
To view properties of a Client, perform the following steps:
1. Under Clients, right-click the Client and select Properties.
2. The Client Properties window contains three tabs – System, Plugins and
Installed Software. Click the corresponding tab to view the following
information:
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Figure 3-4:
Client
Properties
window



The System tab displays the machine name and description, NVBU
version and build number, machine ID, network name for the machine, IP
address, release information and operating system version number.



The Plugins tab lists the NVBU plugins installed on the Client. The details
include the plugin name, version number, plugin ID, and installation date
and time.



The Installed Software tab lists all the NVBU plugins installed on the
Client. The details include the plugin name and the installation date.

3. Click OK to close the window.

3.4.2

Checking Client Access
To check access between the NVBU Server and a Client, perform the following
steps:
1. Under Clients, right-click the machine and select Check Access.
2. NVBU attempts to connect to the Client and displays the status message
corresponding to the Client accessibility.
3. Click OK to close the dialog.

3.4.3

Establishing the Firewall Relationship
For NVBU Clients that are located outside the firewall, you must configure the
firewall relationship as Outside Firewall in order to adhere to port restrictions
while establishing data transfer channels, message channels and broadcast
channels through the firewall. Before configuring this option for a Client, consider
the following:


If the Client and the Server are on the same side of the firewall, or if no
firewall exists between the two networks, do not change the default
configuration which is set as Inside Firewall.
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The firewall relationship cannot be established for Clients running a version
prior to v8.0. Such Clients are represented with a dimmed blue icon on the
NVBU Client Management window. The communication with such Clients is
always treated as an Outside Firewall operation and the Server adheres to
the port restrictions set from the Firewall tab on the Configurator. Therefore,
you must open more ports to enable concurrent data transfers with multiple
Clients that are outside the firewall.



This feature is not intended for firewalls using NAT (Network Address
Translation) or IP Masquerading



This feature is not intended for configuring the firewall settings between two
Clients. Client to Client communication is always treated as an Outside
Firewall operation and adheres to the port restrictions configured from the
NVBU Configurator.

To establish the firewall relationship between the NVBU Server and Client
networks, perform the following steps:
1. Under Clients, right-click the Client and select Outside Firewall.
2. Once you select the Outside Firewall option, this command is replaced with
Inside Firewall option, which can be used to update the firewall settings if
there are any changes later.
Note: To enable communication with Clients that are outside the firewall, you must
configure valid ports for data transfer channels, message channels and broadcast
channels on the Firewall tab of the Configurator. For details on configuring the
firewall settings for NVBU, refer to the NetVault: Backup Configuration Guide.

3.4.4

Setting Client Description
To set a description for a Client, perform the following steps:
1. Under Clients, right-click the Client and select Set Description.
2. In the Enter Client Description box, enter a detailed description for the
Client.
3. Click OK.

3.4.5

Removing a Client from the NVBU Domain
To remove a Client from the NVBU Domain, perform the following steps:
1. Under Clients, right-click the Client and select Remove. For Clients with a
red icon, select Force Remove.
2. In the confirmation window, click Yes.
The Client is removed and listed again under Available NVBU Machines.
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3.5.0

Working with Client Groups
This section provides an overview of Client Groups, and describes the procedures
for creating and managing the user-defined Client Groups.

3.5.1

Client Groups – An Overview
Client Groups allow you to target multiple clients without individually selecting
each one for creating policy-based backups or granting user access to Clients. A
Client Group named default is automatically created on the NVBU Server during
installation. A Client is automatically added to this group if you have not created
any user-defined Client Groups on the Server. On an NVBU Server with one or
more user-defined Client Groups, you can select the Client Group in the Add
Client to Groups window which appears during Client Addition. Alternatively, you
can select the group members while creating a Client Group. A Client can be a
member of more than one Client Group. The group membership can be changed
any time by modifying the Client Group properties.

3.5.2

Creating Client Groups
To create a Client Group, perform the following steps:
1. Open the NVBU Client Management window.
2. Click the Client Groups tab.
3. Click Add Client Group to create a new Client Group. It is named New
Client Group, by default.
4. To rename the group, perform the following steps:

Figure 3-5:
Rename Client
Group window

a. Right-click the group and select Rename Group.
b. In the New Name for the Group box, enter the group name.
c. Click OK.
5. To set a detailed description for the group, perform the following steps:
a. Right-click the group and select Set Description.
b. In the Group Description box, enter the details.
c. Click OK.
6. To add the group members, perform the following steps:
a. Right-click the group and select Add Member Clients.
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Figure 3-6:
Add Clients to
Group window

b. In the Select Clients to Add list, select the Clients. Use Shift+Click to
select consecutive Clients, or Ctrl+Click to select non-consecutive Clients.
Alternatively, you can select the Group Includes ALL Clients check box
to add all the existing Clients to the group.
c. Click OK.

3.5.3

Modifying a Client Group
To modify a Client Group, perform the following steps:
1. Open the NVBU Client Management window.
2. Click the Client Groups tab and locate the Client Group.
3. To add new members, perform the following steps:
a. Right-click the group and select Add Member Clients.
b. In the Select Clients to Add list, select the Clients. Use Shift+Click to
select consecutive Clients or Ctrl+Click to select non-consecutive Clients.
Alternatively, you can select the Group Includes ALL Clients check box
to add all the existing Clients to the group.
c. Click OK.
4. To remove group members, perform the following steps:
a. Right-click the group and select Remove Member Clients.
b. In the Remove Clients from Group list, select the Clients. Use
Shift+Click to select consecutive Clients, or Ctrl+Click to select nonconsecutive Clients.
c. Click OK.
5. To rename a group, perform the following steps.
a. Right-click the group and select Rename Group.
b. In the New Name for the Group box, enter the group name.
c. Click OK.
6. To set or change the group description, perform the following steps:
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a. Right-click the group and select Set Description.
b. In the Group Description box, enter the details.
c. Click OK.

3.5.4

Removing a Client Group
To remove a client group that is no longer in use, perform the following steps:
1. Open the NVBU Client Management window.
2. Click the Client Groups tab and locate the Client Group.
3. Right-click the group and select Remove Group.
4. In the confirmation window, click Yes. This will remove the Client Group.
However, the individual member clients remain part of the NVBU Domain.
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Chapter 4:

BACKUP DEVICE MANAGEMENT
This chapter describes how to add and manage the backup devices. The
information in this chapter is organized into the following topics:






Backup Devices – An Overview


General Considerations



SAN Considerations

NetVault: SmartDisk Devices


NVSD Devices – An Overview



Adding NVSD Devices



Administering NVSD Devices


Viewing NVSD Device Statistics



Configuring NVSD Device Group Label



Verifying NVSD Device Status



Removing an NVSD Device



Scanning an NVSD Device

NVBU Virtual Tape Libraries


NVBU VTL – An Overview



Creating and Adding NVBU VTLs



Configuring Software Compression Parameters





Removing an NVBU VTL

Virtual Standalone Drives




Software Compression and NVDB Restores

Creating and Adding Virtual Standalone Drives

NVBU Shared Virtual Tape Libraries


NVBU SVTL – An Overview



Planning for NVBU SVTLs



NVBU SVTL Prerequisites


General Prerequisites



Setting up Raw I/O on Linux



Setting up Raw I/O on RedHat Linux



Setting up Raw I/O on RedHat Enterprise Linux 5



Setting up Raw I/O on SUSE Linux
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Adding a Library to SVTL Controller



Distributing SVTL Drives



Sharing SVTL Drives

Adding Tape-based Devices


Adding Devices Using the Automatic Device Configuration Wizard


Manually Starting the Device Configuration Wizard



Adding the Libraries Manually



Adding Standalone Drives Manually



Configuring Physical Tape Libraries



Configuring Physical Tape Drives





Configuring General Parameters



Configuring NDMP Parameters



Tuning Drive Performance



Collecting Drive Performance Statistics



Configuring Timeout for SCSI Commands

Configuring Drive Cleaning Parameters for Physical Tape Drives


Configuring Slots and Barcodes for Cleaning Media



Configuring Generic Cleaning Properties






Establishing Automatic Cleaning Routine



Cleaning a Drive Manually



Viewing the Drive Cleaning Status

Adding Shared Devices in an NVBU Domain


Adding Shared Devices Automatically



Adding Shared Devices Using the Semi-Automatic Method



Adding Shared Devices Manually



Modifying Existing Libraries




Configuring the Life of Cleaning Media



Adding Shared Drives to Non-Shared Library Using the SemiAutomatic Method



Adding Shared Drives to Non-Shared Library Manually

Sharing Standalone Drives

Using Mixed Media Libraries


Organizing Media in a Mixed Media Library



Adding and Configuring a Mixed Media Library



Adding Media to a Library with Entry/Exit Ports
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Adding Media to a Library without Entry/Exit Ports

Administering Physical Tape Libraries


Viewing Device Details



Modifying a Library



Changing the Device View



Opening and Closing a Library Door



Opening and Closing Entry/Exit Ports



Checking an Offline Drive



Taking a Drive Offline in NVBU



Loading and Unloading Media



Exporting Media to Entry/Exit Port



Restarting ACSLS or NDMP Libraries



Importing NetApp VTL’s Shadow Tape



Removing a Physical Tape Library



Device Status Indicators

Backup Devices – An Overview
NVBU supports a wide range of backup devices which are targeted for storing
backups, including different types of disk-based devices such as BakBone's
NetVault: SmartDisk (NVSD) Devices with optional deduplication, NVBU's Virtual
Tape Libraries (VTLs) and Shared Virtual Tape Libraries (SVTLs), and third-party
virtual and physical tape libraries, appliances, autoloaders, and tape drives.
Physical backup devices can be configured for single or shared use, and
connected via SCSI, iSCSI, IP, SAS or Fibre Channel SAN interfaces and can be
connected to the NVBU Server, SmartClients or NAS Filers within an NVBU
Backup Domain. NVBU VTLs and SVTLs can be attached to the NVBU Server
and/or SmartClients while NetVault: SmartDisk Devices are added to the NVBU
Server.
To target a backup device for backup and restores, you must first add the device to
the NVBU Domain. A SmartClient attached device is recognized only after you
add the SmartClient to the NVBU Server. Similarly, a Filer attached device is
recognized only after you add the Filer to the NVBU Server using the NDMP
Plugin.
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4.1.1

General Considerations
Consider the following before adding a device to the NVBU Server:

4.1.2



On Windows, you must disable the Removable Storage Service before
adding a device to the NVBU Server. For instructions on disabling this
service, refer to the NetVault: Backup Installation Guide.



NVBU Server may not recognize a standalone tape device locally attached to
an RHEL4 U1 Client. This happens because on RHEL4 U1, the SG driver
that supports the standalone devices is not loaded automatically. You must
manually load this driver and restart the NVBU Service. This issue only
occurs when the RHEL4 U1 Client does not have any other locally attached
library or changer. For details on obtaining and loading the SG driver, refer to
the relevant RHEL4 U1 documentation.

SAN Considerations
BakBone recommends the following while configuring tape libraries within a SAN
environment:


In a SAN environment, BakBone recommends that you use persistent binding
(also known as SCSI mapping/persistent reservation/ persistent naming).
NVBU cannot communicate with a library if its logical address changes as a
result of changes within the SAN. Persistent binding assigns a fixed logical
address to the device which does not change as devices are added or
removed within the SAN. For the Fibre Channel Host Bus Adapters (HBAs),
you can map the Fibre Channel device address (World Wide Name(WWN) or
World Wide Identifier (WWID)) or a Loop ID to the logical SCSI address. This
ensures that changes within the SAN have no impact on NVBU operations.



You must also use persistent binding when the Server and the fibre devices
are attached to separate switches, or when zoning is implemented. NVBU
does not support multipathing to a tape library/device, so only one channel
must be logically or physically configured for use to ensure consistent
communication path. BakBone also recommends that you do not use the
tape libraries/drives on the same switch or in the same zone that has disk
devices attached. Problems might be encountered if packets from both
device types co-exist in a SAN environment. BakBone recommends that you
use separate HBAs for these devices.



Apple supports multipathing in the FC Host Adapter and XserveRAID, and
often this is the default setting after installation. However, multipathing is not
supported in NVBU. Therefore, the connections must be logically or
physically separated to ensure a consistent communication path.
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NetVault: SmartDisk Devices
NVSD Devices – An Overview
NVBU provides seamless integration with NVSD, BakBone's next generation diskbased backup and deduplication product. While NetVault: Backup provides
seamless integration with NVSD to provide disk-based backup and optional
deduplication, NVSD is a separate product which is installed and licensed
separately from NVBU.
An NVSD Device connects to an NVSD Instance which is comprised of one (1) or
multiple Storage Pools and a set of processes which perform disk-based backups
and byte-level variable block software deduplication. A single NVSD Instance can
be deployed on a dedicated server, the NVBU Server or an NVBU Client and can
accept data streams from heterogeneous platforms. An NVSD Storage Pool is
comprised of one or more file system volumes and can be easily extended by
adding additional file system paths.
For more information on NetVault: SmartDisk refer to the NetVault:SmartDisk
Installation Guide and NetVault: SmartDisk Administrator's Guide.

4.2.2

Adding NVSD Devices
NVSD Devices must be added to the NVBU Server before they can be used for
backups and restores in an NVBU Domain. To add an NVSD Device, perform the
following steps:
Note: For instructions on installing and configuring an NVSD, refer to the NetVault:
SmartDisk Installation Guide and NetVault: SmartDisk Administration Guide.
1. Open the NVBU Device Management window.
2. On the Add menu, click Add NetVault SmartDisk.
3. In the Add NetVault SmartDisk window, configure the following parameters:
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Figure 4-1:
Add NetVault
SmartDisk
window



Host – Enter the DNS name or IP address of the host on which the NVSD
Device is installed. The NVBU Server must be able to resolve the
configured host name or the device will not be added. This parameter
must be configured even if the device is deployed on the NVBU Server.



Port – Do not change this parameter for a device that is listening on the
default port. For a device that is not using the default port, enter the port
number the device is configured to listen on.



Force Add – This option is useful if you have performed a disaster
recovery to rebuild a Server. Select the Force check box to forcefully add
NVSD Device to a Server when it is already added to another NVBU
Server with the same name.

4. Click Save Details on the toolbar. The device is added and listed on the
Devices tab. The status changes to online after device initialization.
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Administering NVSD Devices
This section provides information on managing the NVSD Devices added to the
NVBU Server. These tasks are performed from the NVBU Device Management
window. The information in this section is organized into the following topics:

4.2.3.a



Viewing NVSD Device Statistics



Configuring NVSD Device Group Label



Verifying NVSD Device Status



Removing an NVSD Device



Scanning an NVSD Device

Viewing NVSD Device Statistics
To view the device statistics, perform the following steps:
1. On the Devices tab right-click the target NVSD Device, and select Status.
2. The status window is organized as follows:


Activity – The Activity tab displays the following details:

Figure 4-2:
NVSD Device
activity
statistics



Name – Name of the NVSD Device which is automatically derived from
the host name and IP address.



Status – Status of the NVSD Device. AVAILABLE specifies that the
device is available for backups and restores, while OFFLINE specifies
that the device is unavailable and cannot be used for backups or
restores,



Stream Count – Current number of elements or NVBU segments that
are being streamed to the NVSD Device.



Jobs from this Server Using Device – Number of NVBU jobs which
are currently using the NVSD Device.

42

Chapter 4
Backup Device Management





Send (MB/sec) – Total megabytes per second (MBps) across all
streams being sent out from NVSD to NVBU (that is, when an NVBU
restore job is being performed).



Receive (MB/sec) – Total MBps across all streams being sent to
NVSD (that is, when an NVBU backup job is targeted to an NVSD
Device).



Items Deduplicating – Current number of elements or NVBU
segments that are being deduplicated.



Deduplication Queue Length – Current number of elements or NVBU
segments that are waiting to be deduplicated.



Garbage Collection State – Phase of Garbage Collection that is
currently occurring.

Storage – Click the Storage tab to view the following details:

Figure 4-3:
NVSD Device
storage
statistics



Data Protected – The total amount of data that is currently being
protected by the NVSD Device.



Data Deduplicated – The total amount of data that has been
submitted for deduplication.



Disk Used by Deduplicated Data – The amount of disk space used
by deduplicated data. It includes the space consumed by the Chunk
Store, Chunk Index, and Manifests.



Dedupe Ratio – The Deduplication Ratio of the data that has been
deduplicated by the NVSD Device. The Deduplication Ratio is
calculated as follows:
Data Deduplicated / Disk Used by Deduplicated Data =
Deduplication Ratio



Data in Staging – The amount of data this is currently stored in the
Staging Store.
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Space Available – The amount of disk space that is available in the
volumes that comprise the NVSD Device's Storage Pools. This
represents the amount of space that NVSD can consume on the
volumes.



License – The amount of protected capacity that is currently licensed
by the NVSD Device.

Device – Click Device tab to view the following details:

Figure 4-4:
NVSD Device
details



Name – Name of the NVSD Device which is automatically derived from
the host name and IP address.



Machine ID – Machine ID for the NVSD Instance that is required for
obtaining a permanent NVSD license key. For more information on
licensing NVSD, refer to the NetVault: SmartDisk Installation Guide.

3. Click OK to exit.

4.2.3.b

Configuring NVSD Device Group Label
To set the properties for an NVSD Device, perform the following steps:
1. On the Devices tab right-click the NVSD Device, and select Properties.
2. In the Storage Properties window, configure the following parameter:

Figure 4-5:
Storage
Properties
window



Group Label – In the Group Label box, enter the string.

3. Click OK.
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4.2.3.c

Verifying NVSD Device Status
To verify the status of an offline device, perform the following steps:
1. On the Devices tab right-click the NVSD Device, and select Check to check
the NVSD Device status on the host.
2. If the NVSD Device is running on the host, the device status changes to
AVAILABLE.

4.2.3.d

Removing an NVSD Device
Removing an NVSD Device does not delete the backups on it. You can re-add the
NVSD Device to an NVBU Server with the same NVBU Machine Name as the
NVBU Server from which it was removed. To remove an NVSD Device, perform
the following steps:
1. On the Devices tab right-click the NVSD Device, and select Remove.
2. In the confirmation window, click OK.
3. If the device fails to remove, select the Force Removal check box in the
confirmation window and click OK.
Note: Selecting Force Removal will force the removal of an NVSD Device that is
currently not in use. However, the NVSD Device may still try to communicate with
the NVBU Server.

4.2.3.e

Scanning an NVSD Device
Scanning an NVSD Device queries all the backups stored on the NVSD Device.
Backups which are not currently indexed in this NVBU Server’s NVDB will be
imported and made available for restores. An NVSD Device can only be scanned
into a NVBU Server that has the identical NVBU Machine Name as the original
NVBU Server which performed the backups. Scanning an NVSD Device may take
an extended period of time depending upon the number of backups that must be
imported and the size of the backup indexes. To scan an NVSD Device, perform
the following steps:
1. On the Devices tab right-click the NVSD Device, and select Scan.
2. In the confirmation window, click OK.
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NVBU Virtual Tape Libraries
NVBU VTL – An Overview
Virtual Tape Libraries (VTLs) are an emulation of tape libraries on disk, which
enable disk-to-disk backups. With VTLs, you have the flexibility to perform quick
backups to disks, and during off-peak hours migrate or duplicate the backup to
physical systems for off-site storage. The media manager does not distinguish
between a virtual and a physical tape, which simplifies the process of setting up
backup policies, including retention period and rotation schemes.
VTLs are represented as directories on the disk. Each VTL contains three
directories named drives, slots and media, which in turn contain numbered subdirectories. The virtual drives reside as files within the drives sub-directories.
These files contain links to the media files. The virtual tapes reside as media files
within the media directory. When a virtual tape is moved between slot and drive,
the media file itself stays in the media directory and the drives and slots files are
modified to emulate the moving of the media.
A VTL can handle any number of concurrent NVBU Client backups. As with a
physical library the number of drives contained in the VTL dictate how many
simultaneous operations can be performed. The number of slots must be the
same as or more than the number of drives configured. Different operating
systems may impose limits on the maximum file size, which can affect the
maximum VTL media size.
Important: VTLs are independent of file systems (e.g., NTFS, UFS, ext3, etc.)
and disk systems (e.g., IDE, SCSI, iSCSI, etc.). However, file systems residing on
removable drives are not supported.

4.3.2

Creating and Adding NVBU VTLs
Before starting this procedure, consider the following points:


Before creating a VTL, NVBU performs a disk space check to make sure that
the target disk has sufficient space to accommodate the new VTL. On normal
file systems you can use the disk space check feature to avoid errors during
VTL creation. However, when creating an NVBU VTL on a third-party
deduplication appliance or compressed file system, BakBone recommends
that you disable this feature. To disable disk space checks before VTL
creation, refer to the NetVault: Backup Configuration Guide.



During disk space checks the free space required on the disk is calculated as
follows:
Number of Slots * Media Capacity + <x>
<x> is the margin considered for the following:
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Disk space required to create the directory structure for the VTL. It varies
for different file systems.



Disk space required by other applications running on the system.

The margin is set to 20MB by default. To change this setting, refer to the
NetVault: Backup Configuration Guide.


If the target disk does not have sufficient space, NVBU terminates the device
emulation process with an error.

To create a VTL, perform the following steps:
1. Click Device Management on the toolbar or Large Buttons panel to open
the Device Management window. Alternatively, on the Administration
menu, click Device Management.
2. On the Add menu, click Add Library to open the Add Library window.
3. Under Choose Library on the Library Selection tab, right-click the target
machine and select Create Virtual Library.
4. In the Add New Virtual Library window, configure the following parameters:


Library Location – Enter the path for the VTL. This should be an existing
path. NVBU will not create any non-existing directories. For example,
enter C:\VirtualLibraries to create a VTL in the VirtualLibraries folder on
C drive.



Library Name – Enter a unique name for the VTL. NVBU assigns the
name NewLibrary by default.



Barcode Prefix – For each VTL, NVBU generates a barcode prefix that is
used for identification and assigned to the media used by the VTL. It can
be changed, if required. However, ensure that a unique code is assigned
to each VTL.



Number of Drives – Enter or select the number of drives for the VTL.

Figure 4-6:
Add New
Virtual Library
window
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Number of Slots – Enter or select the total number of slots that will hold
the media.



Media Capacity – Enter or select the size of the virtual tape. The media
size is specified in MB. The maximum size for a piece of media can be
800GB (i.e., 819,200MB). Each slot will contain a piece media of the given
size.

5. Select OK to initiate the creation of VTL. Depending upon the platform, the
number of slots and media size, this process will take some time to complete.
The entire VTL must be created before it can be targeted for backups. Large
VTLs can take considerable amounts of time to create. The NVSD Device
does not have the limitation that the entire disk-based capacity must be
provisioned before it can be used and should be considered as an alternative
to large VTLs when creation time is an issue.
Click OK to close the dialog.
6. The VTL is added to the NVBU Server in the same manner as a physical
library. To add the VTL, refer to Adding Devices Using the Automatic Device
Configuration Wizard on page 58 or Adding the Libraries Manually on page
60.

4.3.3

Configuring Software Compression Parameters
To configure software data compression parameters for NVBU VTL Drives,
perform the following steps:
1. Open the Configure Device window as described in the following steps:
a. New Drive
Click the Configure tab on the Add Library/Standalone Drive window.
Double-click the target drive.
b. Existing Drive
On the Devices tab, right-click the drive and select Configure.
2. Click the Software Compression tab.
3. Configure the following parameters:

Figure 4-7:
Software
Compression
tab



Perform Software Data Compression – Select this check box to enable
compression. The data will be compressed when it is transferred to this
device during backup.
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Compression Decision Switch – The value set for this parameter
determines the minimum level of compression which must be achieved
when data is compressed during a backup. For example, if you set the
value to 80%, NVBU will attempt to compress the data during backup and
perform one of the following:


If the end result of the compression produces data less than 80% of
the original data size, the data will be written to virtual media
compressed.



If the end result of the compression produces data more than 80% of
the original data size, NVBU will not compress the data and complete a
normal backup with the actual file size.

If you enter 80%, then a file size of a 100MB must be <= 80MB after
compression. If not, NVBU will backup the file uncompressed. The extent
that data can be compressed is dependant on the data contents.
Encrypted data will typically not compress. With some files, compression
may actually result in a file that is larger than the original uncompressed
file.


Number of Data Blocks per Compression Unit – Enter the number of
data blocks per compression unit. The default block size in 32KB which
can be changed via the Configuration tab. For details, refer to Configuring
General Parameters on page 66.

4. Click OK to save the settings.

4.3.3.a

Software Compression and NVDB Restores
When an NVDB backup is restored, the remaining space on virtual tapes that
contain compressed savesets is not reported correctly. As a work-around, you can
perform either of the following:


Clear the Software Compression check box and re-launch the job to scan
the media again.



Manually scan the target media. If the media is not displayed, perform the
following steps:
a. Click the Media Request tab.
b. Right-click the corresponding entry in this window and select Hold.
c. On the Devices tab, right -click the VTL and select Scan. The media will
be returned to the drive.
d. On the Media Request tab, right-click the entry and select Off Hold.
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Removing an NVBU VTL
When you remove an NVBU VTL, the used media information is still stored in the
NVDB. To remove an NVBU VTL completely, perform the following steps:
1. On the Devices tab right-click the VTL, and select Bulk Blank. This removes
all the job indexes associated with the data stored on the VTL.
2. Right-click the VTL and select Remove.
3. Stop the NVBU Service.
4. Open .../config/diskdevices.cfg file in a text editor (where ... represents the
NVBU installation directory)
5. Under the [libraries] and [drives] sections, delete all entries for the deleted
VTL.
6. Save and close the file.
7. Then, go to the VTL location on the hard disk, and delete the directory that
represents the removed VTL.
8. Start the NVBU Service.

4.4.0
4.4.1

Virtual Standalone Drives
Creating and Adding Virtual Standalone Drives
To create a virtual standalone drive, perform the following steps:
1. Click Device Management on the toolbar or Large Buttons panel to open
the Device Management window. Alternatively, on the Administration
menu, click Device Management.
2. On the Add menu, click Add Standalone Drive to open the Add Standalone
Drive window.
3. Under Choose Drives on the Drive Selection tab, right-click the target
machine and select Create Virtual Drive.
4. In the Add New Virtual Drive window, configure the following parameters:

Figure 4-8:
Add New
Virtual Drive
window
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Drive Location – Enter the path for the drive. This should be an existing
path. NVBU will not create any non-existing directories.



Drive Name – Enter a unique name for the standalone drive. NVBU
assigns the name NewDrive by default.



Barcode Prefix – For each standalone drive, NVBU generates a barcode
prefix that is used for identification and assigned to the media used by the
drive. It can be changed, if required. However, ensure that a unique code
is assigned to each drive.



Media Capacity – Enter or select the media size in MB. Ensure that
sufficient space is available on the disk to create the virtual media.

5. Select OK to initiate the creation of the standalone drive. Depending on the
media size, this process may take a few minutes to complete. A message is
displayed when the process completes. Click OK to close the dialog.
6. The virtual standalone drive is added to the NVBU Server in the same
manner as a physical drive. For details on adding the drive, refer to Adding
Devices Using the Automatic Device Configuration Wizard on page 58 or
Adding Standalone Drives Manually on page 63.

4.5.0
4.5.1

NVBU Shared Virtual Tape Libraries
NVBU SVTL – An Overview
NVBU SVTLs extend the VTL implementation and lets you share a VTL with
multiple NVBU machines for LAN-free backups. The interface can be Fibre
Channel, iSCSI or SCSI. On Linux and Solaris platforms, SCSI_FCP protocol is
also supported. The SVTLs are supported on the following platforms:


Windows



Linux (x86 and x86-64)



Solaris SPARC and Solaris x86-64

The disks can be of any size. However, operating system imposed limitations do
apply. The SVTL size can be changed on the fly using CLI utilities.

4.5.2

Planning for NVBU SVTLs
Before setting up an SVTL, consider the following:


The SVTL size will depend on your disk size. Therefore, select a disk that
meets your SVTL size requirements.



The disk must be physically connected to all Clients that will access the
SVTL. The number of virtual drives for the SVTL will depend on the number
of machines that will access the SVTL. However, it is not limited by the
number of machines currently connected to the disk. You can configure
additional drives for future use.
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Figure 4-9:
An illustration
depicting an
SVTL
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Select the machine that will control the virtual arm changer. Although the
SVTL drives can be shared or distributed among multiple Clients, only one
Client controls the virtual arm changer.

NVBU Windows
SmartClient
Virtual Arm
Changer

Virtual Drive 1
LAN

Virtual Drive 2

NVBU Linux
SmartClient
Virtual Drive 2

Virtual Media
Slots Housing
Virtual Media

NVBU Solaris
SmartClient
SVTL Disk Array

Direct Connection (e.g. SCSI, Fibre Channel, etc.)
Virtual Arm Changer Control Path

4.5.3

NVBU SVTL Prerequisites
Before creating an SVTL, refer to the following notes and complete the required
tasks:

4.5.3.a



General Prerequisites



Setting up Raw I/O on Linux



Setting up Raw I/O on RedHat Linux



Setting up Raw I/O on RedHat Enterprise Linux 5



Setting up Raw I/O on SUSE Linux

General Prerequisites


Connect the disk array to all the NVBU Clients that will share the SVTL. The
interface can be Fibre Channel, iSCSI or SCSI. On Linux and Solaris
platforms, SCSI_FCP protocol is also supported.



Only an unformatted disk that contains no mounted partitions/volumes can be
used as an SVTL. A partition on a hard disk cannot serve as an SVTL.
The disk must allow multiple interfaces.
On Windows any non-ejectable disk can serve as an SVTL
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NVBU does not support Multipath, Powerpath or software RAID technologies.


On Windows delete any existing volumes on a disk or LUN before using it to
create an SVTL.



On Windows 2008, Vista and 7 a new disk drive that is added must be first
placed Online within the Disk Management administrative utility. When
prompted to initialize the disk, select No. If you do not perform these steps,
NVBU will not be able to create an SVTL on the disk.



Linux has a pool of raw device nodes that must be bound to a block device
before raw I/O can be performed on it. There is a raw device controller that
acts as the central repository of raw to block device binding information.
Binding is performed using a utility named raw, which is normally supplied by
the Linux distributor.



If using a disk or RAID volume on a SAN, edit the file /kernel/drv/sd.conf on
Solaris Clients hosting the SVTL or sharing the drives. Enter the values for
SCSI ID and LUNS to scan the appropriate disks and volumes in the
following format:
name="sd" class="scsi" target=6 lun=5;

4.5.3.b



In the event that a machine running a Solaris O/S is to utilize an SVTL, the
hard disk that is to house it must be partitioned into a single, large “Backup”
partition. Utilize any relevant commands to set up the target hard disk so that
it contains a single partition.



Determine the Client that will control the virtual arm changer.

Setting up Raw I/O on Linux
To set up raw I/O on Linux, you require the following:


One or more free IDE or SCSI disk partitions



A raw device controller named /dev/rawctl or /dev/raw. If this is not present,
issue the following command to create a symbolic link:
# ln -s /dev/your_raw_dev_ctrl /dev/rawctl

To set up raw I/O, perform the following steps:
1. At the prompt issue the following command:
ls /dev/rawctl
or
ls /dev/raw/raw1
It displays information from the devices.txt file that usually resides in the /
usr/src/linux/Documentation/devices.txt directory
2. Logged in as root, issue the following command to create the device:
mknod /dev/rawctl c 162 0
3. Set the permissions to the following:
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crw-rw
If you also require /dev/raw/raw1 and /dev/raw/raw2, follow the same procedure
using the proper numbers listed in devices.txt and set the same permissions.

4.5.3.c

Setting up Raw I/O on RedHat Linux
The following example shows how to set up raw I/O on RedHat Linux. The raw
partition used is /dev/sda5.
1. Calculate the number of 4096-byte pages in this partition, as shown in the
following example:
# fdisk /dev/sda
Disk /dev/sda: 255 heads, 63 sectors, 1106 cylinders
Units = cylinders of 16065 * 512 bytes
num_pages = floor( ((1106-524+1)*16065*512)/4096 )
num_pages = 11170736
2. Bind an unused raw device node to this partition. This must be done each
time the machine is rebooted. You must be logged in as root to issue this
command:
# raw /dev/raw/raw1 /dev/sda5
3. For persistent binding, open the file
/etc/sysconfig/rawdevices and append the following line:
dev/raw/raw1 /dev/sda5
Reboot or issue the following command:
# /etc/rc.d/init.d/rawdevices start
4. Set appropriate read permissions on the raw device controller and the disk
partition. Set appropriate read and write permissions on the raw device.

4.5.3.d

Setting up Raw I/O on RedHat Enterprise Linux 5
The raw devices interface has been deprecated in Red Hat Enterprise Linux 5; the
raw device mapping is now performed via udev rules.To do this correctly, add the
appropriate entries to the file
/etc/udev/rules.d/60-raw.rules in the following formats:


For Device Names:
ACTION=="add", KERNEL=="<device name>", RUN+="/bin/raw /
dev/raw/rawX %N"



For Major/Minor Numbers:
ACTION=="add", ENV{MAJOR}=="A", ENV{MINOR}=="B", RUN+="/
bin/raw /dev/raw/rawX %M %m"
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Replace <device name> with the name of the device you need to bind (e.g., /dev/
sda1). A and B are the major / minor numbers of the device you need to bind, and
X is the raw device number that you want the system to use.
If you have a large, pre-existing /etc/sysconfig/rawdevices file, convert it with the
following script:
#!/bin/sh
grep -v "^ *#" /etc/sysconfig/rawdevices | grep -v "^$" |
while read dev major minor;
do
if [-z “$minor”]; then
echo “ACTION==\”add\”, KERNEL==\”${major##/dev/}\”,
RUN+=\\”/bin/raw $dev%N\"“
else
echo “ACTION==\”add\”, ENV{MAJOR}==\”$major\”,
ENV{MINOR}==\”$minor\”, RUN+=\\”/
bin/raw $dev%M%m\”$dev%M%m\””
fi
done

4.5.3.e

Setting up Raw I/O on SUSE Linux
On SUSE Linux, the raw disk partitions are administered in the /etc/raw file. This
is a plain text file containing comments and examples for possible configurations.
Once created, bind the raw devices. You do this by starting them with the script /
etc/init.d/raw. Use the chkconfig(8) utility to guarantee that the raw device
binding occurs during any restart

4.5.4

Creating NVBU SVTLs
To create an SVTL, perform the following steps:
1. Click Device Management on the toolbar or Large Buttons panel to open
the Device Management window. Alternatively, on the Administration
menu, click Device Management.
2. On the Add menu, click Add Library to open the Add Library window.
3. Under Choose Library on the Library Selection tab, right-click the target
machine and select Create SVTL.
4. In the Create New Shared Virtual Tape Library, configure the following
parameters:


Library Device – Select the target drive in the list. Depending on the
operating system, the available disks are listed as follows:
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Windows – PhysicalDrive1, PhysicalDrive2, etc.



Linux – /dev/raw/raw1, /dev/raw/raw2, etc.



Solaris – /dev/rdsk/c0t0d0s0, /dev/rdsk/c1t1d0s0, etc.
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Device Description – This parameter indicates the disk type.



Device Size – This parameter indicates the disk size.



Device Block Size – This parameter indicates the block size.



Previously Formatted as SVTL? – This parameter indicates whether the
selected disk was previously formatted as an SVTL.



Barcode Prefix – For each SVTL, NVBU generates a barcode prefix that
is used for identification and assigned to the media used by the SVTL. It
can be changed. However, ensure that a unique code is assigned to each
SVTL.



Number of Drives – Enter the number of drives for the SVTL. The
number of drives can be more than the number of NVBU Clients currently
connected to the disk. The additional drives can be used in future to
connect more Clients.



Number of Media Items – Enter the total number of slots that will hold the
media.



Media Capacity – Enter the media size in MB. When creating an SVTL,
NVBU stores some information about the SVTL on the disk, which
consumes a few megabytes of space. Take this into consideration when
you configure the media capacity.

Figure 4-10:
Create New
Shared Virtual
Tape Library
window
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5. To determine the required disk size for an SVTL with the given specifications,
click Calculate Size Required. If the required disk size is larger than the
actual disk size, reduce the number of Media Items and Media Capacity.
6. Select OK to initiate the creation of SVTL.
7. When the process completes, a Final Confirmation window is displayed.
Enter the following details to format the SVTL:


Password – Enter the NVBU password for the machine.



Confirmation Phrase – Enter the text FORMAT SVTL.

Click Format.
8. A message is displayed when formatting completes. Click OK to close the
dialog.

4.5.5

Adding a Library to SVTL Controller
To add the SVTL to the NVBU Client that will control the virtual arm changer,
perform the following steps:
1. Open the Device Management window.
2. On the Add menu, click Add Library to open the Add Library window.
3. Under Choose Library, open the SVTL Controller node (double-click the
node, or right-click it and select Open) to list the attached libraries in the
device tree.
4. Open the SVTL Robotic Libraries node to display the SVTL.
5. Double-click the SVTL or right-click and choose Select.
6. Perform the procedures described in the sections Distributing SVTL Drives
on page 56 or Sharing SVTL Drives on page 57 to distribute or share the
SVTL drives.

4.5.6

Distributing SVTL Drives
NVBU allows you to add an SVTL drive to a SmartClient for exclusive use. To
distribute the SVTL drives among multiple SmartClients, perform the following
steps:
1. Click the Drive Selection tab.
2. Open the Client to which you want to add the drive.
3. Open the SVTL Channel node. All the available SVTL drives are listed under
this node.
4. Enter 1 in the Select for Drive Bay box.
5. Under Choose Drives, double-click drive 1 or right-click it and choose
Select. The drive picture, type and details are displayed under Selected
Drives.
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6. Repeat steps 2–5 for the remaining shared drives that are to be added,
changing the Client, drive number and bay for each drive.
7. To configure the drive parameters, refer to Configuring Physical Tape Drives
on page 65.

4.5.7

Sharing SVTL Drives
To share the SVTL across SmartClient drives, perform the following steps:
Note: Each drive that is to be shared by more than one SmartClient requires a
Dynamically Shared Drive (DSD) licence.
1. Click the Drive Selection tab.
2. Open the SVTL Controller node.
3. Open the SVTL Channel node. All the available SVTL drives are listed under
this node.
4. Perform the following steps to share the drives:
a. Enter 1 in the Select for Drive Bay box.
b. Under Choose Drives, double-click drive 1 or right-click it and select Add
Shared. The drive picture, type and details are displayed under Selected
Drives.
c. Repeat steps a and b for the remaining drives that are to be shared,
changing the drive number and bay for each drive.
5. To add the shared drives to the Clients, perform the following steps:
a. On the Drive Selection tab, open the Client to which you want to add the
drive.
b. Open the SVTL Channel node. All the shared SVTL drives are listed
under this node.
c. Enter 1 in the Select for Drive Bay box.
d. Under Choose Drives, double-click drive 1 or right-click it and select Add
Shared. The drive picture, type and details are displayed under Selected
Drives.
e. Repeat steps a and b for the remaining shared drives that are to be
added, changing the drive number and bay for each drive.
6. Perform step 5 for each Client to which you want to add the shared drives.
7. To configure the drive parameters, refer to the section Configuring Physical
Tape Drives on page 65.
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4.6.0
4.6.1

Adding Tape-based Devices
Adding Devices Using the Automatic Device
Configuration Wizard
The Automatic Device Configuration wizard helps you to quickly add and configure
backup devices. This wizard can recognize devices manufactured by multiple
vendors, although not all are supported. NVBU automatically starts scanning for
new devices in the NVBU Domain when you start the Service.
Note: To disable automatic device scanning, refer to the NetVault: Backup
Configuration Guide.
To automatically configure a backup device, perform the following steps:
1. Click Device Management on the toolbar or Large Buttons panel to open
the NVBU Device Management window. Alternatively, on the
Administration menu, click Device Management.
2. The Automatic Device Configuration wizard starts automatically when a
qualified device is found. Follow the wizard as it guides you through the
configuration steps.
3. Verify the device details and click Yes to start the configuration procedure.
4. Configure the following parameters:

Figure 4-11:
Automatic
Device
Configuration
wizard



Name – NVBU assigns a default name to a backup device for
identification. To change it, enter the new name for the device in the
Name box.
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Configure Performance Options – To modify the default performance
settings, select the Configure Performance Options check box.



Scan Client for Remote/Shared Devices – This option is used for
sharing drives among multiple Clients. For details on sharing drives, refer
to Adding Shared Devices in an NVBU Domain on page 75. For devices
controlled by a single Client, clear the check box.

Click Next to proceed.
5. If the Configure Performance Options check box was selected in the
previous step, reconfigure the following parameters to improve performance:


Amount of Memory to Assign to Transfer Buffers – Enter the transfer
buffer size (or the shared memory size). By default, the transfer buffer is
set to 257KB. Generally, the following rule applies for the shared memory
size:
shared memory=x*block size + 1
For details on configuring this parameter, refer to Tuning Drive
Performance on page 68.



Media Block Size – Enter the media block size. The default block size is
32KB. For details on configuring this parameter, refer to Configuring
General Parameters on page 66.

Click Next to proceed.
6. NVBU adds the device and displays a message. Click Finish to complete the
procedure. The device is added and listed on the Devices tab.

4.6.1.a

Manually Starting the Device Configuration Wizard
If a qualified device is not detected automatically, perform the following steps to
start the wizard manually and complete the configuration procedure:
1. Click Device Management on the toolbar or Large Buttons panel to open
the Device Management window. Alternatively, on the Administration
menu, click Device Management.
2. On the Add menu, click Auto-Configure Device.
3. In the Automatic Device Configuration window, configure the following
parameters to begin scanning:
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Figure 4-12:
Automatic
Device
Configuration
Wizard started
manually



Select Device Type – Under Select Device Type, select the appropriate
option to search for Standalone Drives or Libraries.



Select Clients – Under Select Clients, select the check boxes
corresponding to the Clients that are to be scanned.



Re-scan for Devices – To force a re-scan instead of using the cached
information, select the Re-scan for Devices check box.

4. To scan for devices previously ignored using the Do Not Ask Again for This
Device option, right-click the machine to which the device is physically
connected, and then select Clear List of Ignored Devices.
5. Click Next to continue.
6. NVBU begins scanning the network for available devices and starts the
Automatic Device Configuration wizard when a qualified device is found.
To complete the configuration, continue from step 3 of Adding Devices Using
the Automatic Device Configuration Wizard on page 58.

4.6.2

Adding the Libraries Manually
To add a library manually, perform the following steps:
1. Click Device Management on the toolbar or Large Buttons panel to open
the NVBU Device Management window. Alternatively, on the
Administration menu, click Device Management.
2. On the Add menu, click Add Library to open the Add Library window.
3. Under Choose Library, locate the NVBU Server or SmartClient to which the
device is connected. Double-click the node, or right-click it and select Open.
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Figure 4-13:
Library
Selection tab

4. Depending on the library type, open the appropriate node to display the
available libraries.
5. Double-click the library, or right-click and choose Select to display the library
picture, type and details under Selected Library.
6. Click the Drive Selection tab.
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Figure 4-14:
Drive Selection
tab

7. Open the NVBU Server or SmartClient node to which the device is
connected.
8. Open the appropriate drive type to display the available drives.
9. Select the drive bays as described in the following steps:
a. Libraries with a Single Drive
1. Double-click the drive (or right-click it and choose Select) to display
the drive picture, type and details under Selected Drives
b. Libraries with Multiple Drives
1. Enter 1 in the Select for Drive Bay box.
2. Under Choose Drives, double-click drive 1 (or right-click it and choose
Select) to display the drive picture, type and details under Selected
Drives.
3. Repeat steps 1–2 for the remaining drives, changing the drive number
and bay for each drive.
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Note: While the drive number usually matches the bay number, depending on the
library and drive configuration a different assignment of drives to bays might be
necessary. If you experience failure during move or load/unload operations,
consider adding your drives in a different order to their bays.
10.To configure the library and drive parameters, refer to Configuring Physical
Tape Libraries on page 64 and Configuring Physical Tape Drives on page 65.
11. To identify a device, NVBU assigns a default name which is displayed in the
Library Name box at the top right corner of the window. You can save a
device with its default name, or assign it a new name. To change the library
name, enter the string in the Library Name box.
12.Click Save Details on the toolbar. The device is added and listed on the
Devices tab. The status changes to online after library initialization and
inventory verification.

4.6.3

Adding Standalone Drives Manually
To add a standalone drive, perform the following steps:
1. Click Device Management on the toolbar or Large Buttons panel to open
the NVBU Device Management window. Alternatively, on the
Administration menu, click Device Management.
2. On the Add menu, click Add Standalone Drive to open the Add Standalone
Drive window.
3. Under Choose Drives on the Drive Selection tab, open the Server or Client
node to which the device is connected (double-click the node, or right-click it
and select Open).
4. Open the SCSI Tape drive nodes to display the available drives under this
node.
5. Double-click the drive, or right-click it and choose Select to display the drive
picture, type and details under Selected Drives.
6. To configure the drive parameters, refer to Configuring Physical Tape Drives
on page 65.
7. To identify a device, NVBU assigns a default name which is displayed in the
Device Name box at the top right corner of the window. You can save the
device with its default name, or assign it a new name. To change the device
name, enter the string in the Device Name box.
8. Click Save Details on the toolbar. The device is added and listed on the
Devices tab. The status changes to online after device initialization.
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4.7.0

Configuring Physical Tape Libraries
The default properties for a library can be set while adding a device or modified
later from the Modify Library window. To set or change the library settings,
perform the following steps:
1. Open the Configure Device window as described in the following steps:
a. New Library
1. In the Add Library window, click the Configure tab.
2. Double-click the target library, or right-click and select Configure
b. Existing Library
1. On the Devices tab right-click the target library, and select Modify.
2. In the Modify Library window, click the Configure tab.
3. Double-click the target library, or right-click and select Configure
2. In the Configure Device window, click the Configuration tab.
3. Depending on the type of library you are using, the configuration settings may
vary. This section only outlines the generic parameters that apply to most
libraries. Contact BakBone Technical Support for any help to configure
specific parameters not covered in this section. The generic parameters
include the following:

Figure 4-15:
Configuration
tab for
Physical Tape
Library

Note: BakBone recommends that you do not change the default settings for the
following parameters, unless otherwise advised by a Technical Support
Representative.


Need Command to Open Entry/Exit Port



Do Not Issue Unload Commands to Drives



Must Unload Drive(s) to Open Door



Do Not Overlap Commands to Arm and Drive



Entry/Exit Port Locks Arm
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Return Inactive Media to Slot Delay – Enter the timeout value for media
inactivity. The media is returned back to the slot if no activity occurs within
the specified interval. The default value for this parameter is zero, which
implies that the media is retained in the drive indefinitely.



Mark Unknown Media Blank – When NVBU is not able to read a tape's
header, it marks the media as Unknown. Select the Mark Unknown
Media Blank check box to mark such media as Blank instead of
Unknown. However, you must still run the Blank command to actually
delete the data and use the media for backups.

4. To configure the drive cleaning parameters, refer to Configuring Slots and
Barcodes for Cleaning Media on page 71.
5. For mixed media settings refer to Adding and Configuring a Mixed Media
Library on page 81.
6. Click OK to save the settings.

4.8.0

Configuring Physical Tape Drives
To configure or modify the drive settings, perform the following steps:
1. Open the Configure Device window as described in the following steps:
a. New Drive
Click the Configure tab on the Add Library/Standalone Drive window.
Double-click the target drive.
b. Existing Drive
On the Devices tab, right-click the drive and select Configure.
2. Click the corresponding tab and configure the parameters as described in the
following sections:
Note: Depending on the drive type the configuration settings may vary. This
section outlines only the generic parameters that apply to most drives. Contact
BakBone Technical Support for any help with setting specific parameters not
covered in this section.


Configuring General Parameters on page 66



Configuring NDMP Parameters on page 68



Tuning Drive Performance on page 68



Collecting Drive Performance Statistics on page 70



Configuring Timeout for SCSI Commands on page 70

3. To configure the drive cleaning parameters, refer to Configuring Slots and
Barcodes for Cleaning Media on page 71.
4. Click OK to save the settings.

66

Chapter 4
Backup Device Management

4.8.1

Configuring General Parameters
The general parameters are provided on the Configuration tab, which include the
following:
Note: BakBone recommends that you do not change the default settings, unless
otherwise advised by a BakBone Technical Support Representative.


Device Serial Number – The device serial number is displayed in this box
and it cannot be changed.



Amount of Media Reserved at End of Tape – Enter the remaining space in
the media at which the end of media warnings are issued.



Cleaning Tapes Supported – This parameter informs you whether the
library has automatic cleaning tape support or not. Generally, the default
value is correct, unless certain library models have a different setting.



Time (in seconds) to Wait for Tape to Go Ready – Enter the timeout value
for media availability. This includes the time for the drive to load and spool
media, and transit from busy and becoming busy states to read a SCSI
command. NVBU raises a Media Request if all these do not occur in the
specified interval.



Time (in seconds) to Wait to Stop Reporting No Media Present – Enter
the time NVBU waits for a drive to stop indicating no media present
message and start showing media loaded.



Time (in seconds) to Wait for Cleaning Tape to Start Reporting Cleaning
Drive – Enter the time NVBU waits for the cleaning drive to load and spool
cleaning tapes and send the cleaning initiation message.

Figure 4-16:
Configuration
tab for
Physical Tape
Drive
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Time Between Polling Empty Drives – Enter the interval at which NVBU
polls the standalone drives for media change.



Media Block Size – Enter the block size for the data that is read and written
to the media. The default media block size is 32KB and can be increased in
increments of 1KB, although many devices will only accept a value in
multiples of 4KB or 32KB. The maximum media block size is limited by
several factors, including the operating system and SCSI adapter, the make,
model and type of drives.
Large media blocks enable reading and writing of larger blocks of data,
thereby reducing the overall number of times a backup needs to read data
and write it to media. However, this does not always imply an overall faster
backup.
On Linux/UNIX platforms, you can increase the media block size for optimum
performance.
To use block sizes larger than 64KB on Windows, you might have to change
the registry setting called MaximumSGList. Before changing this setting,
ensure that you are only using tape devices on your SCSI bus. If there are
other devices present, this registry change might prevent them from working.
If you want to apply these changes only to a specific channel on the HBA,
consult the hardware vendor. To change the registry setting, perform the
following steps:
a. Open the Registry Editor (on the Taskbar, click Start and select Run; in
the Open box, enter regedit).
b. Open the
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\<HB
A Vendor>\Parameters node where <HBA Name> is specific to your
SCSI card (e.g. QL2200 for a Qlogic 2200 card).
c. Create a Device key, if it is not present
d. Under Device key add DWORD (if not present). Set the DWORD to
MaximumSGList.
e. Calculate the hexadecimal value as described below:
32-Bit Systems:
MaximumSGList = ((Maximum Block Size) / 4KB) +1
For example, for 256KB block size, the value will be 256KB/4KB= 64.
Adding 1 gives a value of 65 (decimal) or 0x41 (hexadecimal). You can
configure any block size between 64KB and 1MB. The maximum value is
255 or 0xFF, for a 1MB block size
64-Bit systems:
On 64-Bit systems, the OS page size is 8KB by default. Therefore, the
maximum transfer size is 2MB.
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MaximumSGList = ((Maximum Block Size) / 8KB) +1
f. Reboot the system to apply the changes.

4.8.2



Time (in seconds) to Wait for Plugin to Connect – Enter the timeout value
for the plugin to connect to NVBU. The job is aborted if connection is not
established within the specified interval.



Support Short Reads – Select this check box to support short reads.



Compression – Select this check box to use the tape’s built-in compression
functionality. Not all drives support this function and the amount of
compression will vary depending on the type of data and the drive
compression algorithm. Consult the hardware documentation to determine
the compression rates for your drive. On some tapes, compression can be
configured in the hardware, which will override this setting.

Configuring NDMP Parameters
The NDMP parameters are provided on the NDMP Configuration tab. BakBone
recommends that you do not change the default settings for any parameter on this
tab unless otherwise advised by a Technical Support Representative.

4.8.3

Tuning Drive Performance
The performance tuning parameters are provided on the Performance tab, and
include the following:
Note: Any changes to the performance settings only apply to a blank media. If
you are reusing media, then blank it first for these changes to take effect.

Figure 4-17:
Performance
tab



Amount of Memory to Assign For Transfer Buffers – The transfer buffer or
the shared memory is allocated in blocks of 32KB. The default size for this
buffer is 257KB and can be increased for faster performance. The formula to
calculate a valid buffer size is given below:
(<Total number of buffers> x 32Kb) + 1 byte
On Linux/UNIX, you require sufficient RAM and large Shared Memory
segment. Before increasing the transfer buffer size, check the following
parameters on these platforms:


Maximum size of a shared memory segment (SHMMAX)
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Minimum size of shared memory segment (SHMMIN)



Maximum number of shared memory identifiers in the system (SHMMNI)



Maximum number of shared memory segments a user process can attach
(SHMSEG)



Maximum number of semaphore identifiers in the system (SEMMNI)



Maximum number of semaphores in a set (SEMMSL)



Maximum number of semaphores in the system (SEMMNS)



Maximum number of operations per semop call (SEMOPM)



Semaphore maximum value (SEMVMX)

The total allowed shared memory is determined by the formula SHMMAX *
SHMSEG. These values are often limited by the ulimit setting, and the
command ulimit -a can be used to view these system settings.
On Windows, you require at least 2GB RAM and large virtual memory. You
might also have to change the maximum SGlist parameter on the SCSI card.
Some examples of the optimal values that can be specified for some of the
drives are given below:
Drive Type

Optimal Transfer Buffer Value

Fast Modern Tape Drives
e.g., LTO (1, 2 or 3), SDLT or SAIT

65537 (64MB + 1KB)

Medium Speed Tape Drives
e.g., DLT8000, DLT7000 and AIT-3

32769 (32MB + 1KB)

Older Professional Tape Drives
e.g., DLT2000, DLT4000, AIT-2, etc.

16385 (16MB + 1KB)

Older Low Capacity Low-end Drives
e.g., EXB-8505, AIT-1, DAT, etc.

8193 (8MB + 1KB)



Number of Media Blocks to Write/Read at a Time – BakBone recommends
that you do not change the values for these two parameters. If you change
the value, record them as it will be necessary to re-apply them if the drive is
re-installed. Restores require the same values that were set at the time of
backup and will fail if the settings do not match.



Lock Transfer Buffer in Memory – This option locks the allocated transfer
buffer position in memory, increasing the potential performance and
preventing another process from using it when NVBU is running. BakBone
recommends that you leave this selected unless otherwise advised by a
Technical Support Representative.
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4.8.4

Collecting Drive Performance Statistics
The drive performance parameters are provided on the Statistics tab, and include
the following:
Note: NVBU collects statistics for complete data transfer between the Client and
device during a job execution. Although it records excessive soft read and write
errors for the drive, NVBU does not collect data for individual read and write
actions on the device.

Figure 4-18:
Statistics tab

4.8.5



Gather Statistics on Device Performance – Select this check box to log the
statistics for drive performance. You can view this information from the
Device Logs tab. Although this information facilitates troubleshooting, it also
increases the NVDB size.



Gather Statistics on Data Channel Performance – Select this check box to
log the statistics for the Data Channel. You can view this information from the
Device Logs tab. Although this information facilitates troubleshooting, it also
increases the NVDB size.



Record Drive Performance – Select this check box to record the drive
performance details with each job that uses the given drive. You can view
these logs from the Logs window.



Length of Time (in seconds) Between Sampling Drive Transfer Rates –
Enter the interval at which NVBU collects the Drive Transfer Rate statistics.

Configuring Timeout for SCSI Commands
On the SCSI Configuration tab, the default timeout value for the different types of
SCSI commands is set to zero, which correspond to the following intervals:


Fast SCSI Commands – 300 seconds



Slow SCSI Commands – 900 seconds



Very Slow SCSI Commands – 3 hours

An error is logged if a command execution does not complete within the specified
interval. BakBone recommends that you do not change the default timeout for any
of the SCSI commands unless otherwise advised by a Technical Support
Representative.
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Configuring Drive Cleaning Parameters for
Physical Tape Drives
In order to establish a cleaning routine for the drives or to perform manual
cleaning, you must complete the following configuration procedures.

4.9.1

Configuring Slots and Barcodes for Cleaning Media
Before loading a cleaning tape, you must configure the slots that will hold the
cleaning media and specify the barcodes for the cleaning media. To accomplish
this, perform the following steps:
1. On the Devices tab right-click the target library, and select Modify to open
the Modify Library window.
2. Click the Configure tab.
3. Double-click the library or right-click the library, and select Configure.
4. Click the Cleaning tab.
5. Configure the following parameters:

Figure 4-19:
Cleaning tab



Automatic Cleaning Supported – The Automatic Cleaning Supported
check box is selected by default for libraries that support automatic
cleaning.



Barcode Prefix(es) of Cleaning Media – Enter the barcode prefixes for
the cleaning media. For multiple cleaning tapes, use comma delimiter.



Cleaning Slots – Enter the slot number(s) that will hold the cleaning
media. For multiple slots, use comma delimiter.

Note: Both the barcode prefixes and the slot numbers must be configured for the
cleaning media so that the library can recognize and place the media in the
reserved slot. If the cleaning media is not placed in the designated cleaning slot,
you will not be able to set the life for the cleaning media.
6. Click OK.
7. Click Save Details on the toolbar. Alternatively, on File menu click Save.
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4.9.1.a

Configuring Generic Cleaning Properties
If the library requires generic cleaning, perform the following steps:
1. Double-click the drive in the Modify Library window. Alternatively, right-click
it and select Configure.
2. Click the Generic Cleaning tab.
3. Configure the following parameters:

Figure 4-20:
Generic
Cleaning tab



Length of Cleaning Cycle – The length of the cleaning cycle is set to 350
seconds by default. To change it, enter or select the duration in the
Length of Cleaning Cycle box. The duration is specified in seconds.



Issue a Load Command to Start Cleaning Cycle – Select this check
box if the drive requires a load command to initiate a cleaning cycle.



List of ASC/ASQ Codes that Indicate Cleaning has Completed – If
required, enter the ASC/ASCQ SCSI codes for cleaning in this box.



Use Generic Cleaning – Select the Use Generic Cleaning check box.

4. Click OK.
5. Click Save Details on the toolbar. Alternatively, on File menu click Save.

4.9.2

Configuring the Life of Cleaning Media
To set up the life for a cleaning media, perform the following steps:
1. On the Devices tab right-click the cleaning slot, and select Life.
2. Configure the following parameter:

Figure 4-21:
Cleaning
Media
Properties
window



Lives – In the Lives box, enter or select the number of times the cleaning
media can be used.

3. Click OK to save the property.
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Establishing Automatic Cleaning Routine
To establish automatic cleaning routine for a drive, perform the following steps:
1. On the Devices tab, right-click the target drive and select Clean Properties.
2. In the Cleaning Interval window, configure the following parameters:

Figure 4-22:
Cleaning
Interval
window



Days – To set the cleaning interval in number of days, select the Days
check box. In the box to the right, enter or select the number of days
between two cleaning cycles.



Data Transferred – To set the cleaning routine based on the amount for
data transferred, select the Data Transferred check box. In the box to the
right, enter or select the amount of data that can be read or written
between two cleaning cycles. The data transfer amount is specified in GB.



Hours of Use – To set the cleaning interval in number of hours used,
select the Hours of Use check box. In the box to the right, enter or select
the number of hours between two cleaning cycles.



Soft Read/Write Errors – To set the cleaning routine based on the
number of errors encountered, select the Soft Read/Write Errors check
box. In the box to the right, enter or select the read/write errors. This value
is specified in hundreds.

3. Click OK to establish the cleaning routine.

4.9.4

Cleaning a Drive Manually
For a drive that does not support automatic cleaning, perform the following steps
in order to clean it manually:
1. On the Devices tab right-click the target cleaning drive, and select Clean.
2. In the confirmation window click Yes. NVBU starts the cleaning routine and
on completion displays a message.
3. Click OK to close the dialog.
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4.9.5

Viewing the Drive Cleaning Status
To check the status of cleaning drives/slots, perform the following steps:
1. On the Devices tab right-click the target drive, and select Status.
2. Click the Cleaning tab on the Status window.

Figure 4-23:
Cleaning
status tab

It displays the following details for the drive:


Date Last Cleaned – The date on which the drive was cleaned last.



Time since Last Clean – Time elapsed since the last automatic or
manual cleaning operation.



Times Cleaned – The number of times the drive has been cleaned.



Data Transferred since Last Clean – The amount of data read or written
since the last cleaning operation.



Time in Use since Last Clean – The number of times the drive has been
used for read or write operations since the last cleaning operation.



Soft Errors Reported since Last Clean – The number of read or write
errors reported since the last cleaning operation.

3. Click OK to close the window.

NetVault: Backup
Administrator’ Guide

4.10.0

75

Adding Shared Devices in an NVBU Domain
Drive sharing requires an infrastructure where multiple machines can establish
direct paths to the devices, e.g., in a switched Fibre Channel environment. In such
environments, you can share the devices among multiple SmartClients for better
resource utilization through direct access. The shared drives can be controlled by
multiple machines (NVBU Server, Client or Filers), but the library arm changer
remains under the control of one NVBU Client. Each device that is to be shared by
more than one NVBU Client uses a Dynamically Shared Device (DSD) licence.
The following sections describe the procedure for adding shared devices in an
NVBU Domain. Before you proceed, make sure all the target NVBU Clients are
added to the NVBU Server.
Important: BakBone recommends that you do not execute any changes for a
drive while it is actively being used. All jobs that are in progress which use the
drive must be inactive before any changes are made.

4.10.1

Adding Shared Devices Automatically
To add dynamically shared devices using the Automatic Device Configuration
Wizard, perform the following steps:
1. Open the NVBU Device Management window. The Automatic Device
Configuration wizard should startup automatically when you open this
window. If this fails, start the Automatic Device Configuration wizard
manually. For details, refer to Manually Starting the Device Configuration
Wizard on page 59.
2. Click Yes to begin configuring the detected device and follow the wizard as it
takes you through the configuration steps.
3. In the Add Library window configure the following parameters:

76

Chapter 4
Backup Device Management

Figure 4-24:
Automatic
Device
Configuration
Wizard for
sharing drives



Name – This box displays the default name for the device. You can
change it and assign a new name for easy identification.



Configure Performance Options – To modify the default performance
settings, select the Configure Performance Options check box.



Scan Client for Remote/Shared Devices – Ensure this check box is
selected.


Re-scan Clients for Devices – Select this check box to force a rescan instead of using the cached information. This is normally done if
there have been changes in the I/O infrastructure that would require a
re-scan, such as a Fibre Channel SAN change.



Clients – Under Select Clients, select the Clients that are to be
scanned for shared drives. For NDMP Filer-attached devices, select
the NVBU Server.

4. If the Configure Performance Options check box was selected in the
previous step, reconfigure the following parameters to improve performance:
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Figure 4-25:
Automatic
Device
Configuration
Performance
Options



Amount of Memory to Assign to Transfer Buffers – Enter the transfer
buffer size (or the shared memory size). By default, the transfer buffer is
set to 257KB. Generally, the following rule applies for the shared memory
size:
shared memory=x*block size + 1
For details on configuring this parameter, refer to Tuning Drive
Performance on page 68.



Media Block Size – Enter the media block size. The default block size is
32KB. For details on configuring this parameter, refer to Configuring
General Parameters on page 66.

Click Next to proceed.
5. Click Next to proceed.
6. NVBU adds the shared drives to all the existing NVBU Clients. Click Finish to
complete the procedure.

4.10.2

Adding Shared Devices Using the Semi-Automatic
Method
The semi-automatic method involves adding the library and drives to one node
exclusively, and then performing an automatic detection of the drives on all the
NVBU Clients. This method will add the shared drives to all the NVBU Clients with
access to these drives. To add shared devices using the semi-automatic method,
perform the following steps:
1. Click Device Management on the toolbar or Large Buttons panel to open
the NVBU Device Management window. Alternatively, on the
Administration menu, click Device Management.
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2. On the Add menu, click Add Library to open the Add Library window.
3. Under Choose Library, locate the NVBU Server or SmartClient to which the
device is connected. Double-click the node, or right-click it and select Open.
4. Depending on the library type, open the appropriate node to display the
available libraries.
5. Double-click the library, or right-click and choose Select to display the library
picture, type and details under Selected Library.
6. Click the Drive Selection tab.
7. Open the NVBU Server or SmartClient node to which the device is
connected.
8. Open the appropriate drive type to display the available drives.
Important: When selecting the drives to be shared, be sure to match the drives
with the appropriate bay (data transfer element address). To obtain the proper bay
number for each device, refer to the relevant Library Operations or User’s Guide.
9. Right-click the drive to be shared, and select Add Shared.
10.Increase the bay number.
11. Repeat steps 9 and 10 for all drives that are to be shared.
12.Click the Configure tab.
13.Right-Click on the robotic arm and select Scan for Shared Drives.
Note: At this time NVBU will probe all NVBU Clients in the clients list for devices
that match the serial numbers of those that have already been added as a result of
steps 9 through 11.
14.Enter an appropriate name in the Library Name box.
15.Click Save Details on the toolbar. The library is added and listed on the
Devices tab. When the library initialization completes, the status changes to
online.

4.10.3

Adding Shared Devices Manually
The manual method of sharing devices gives more flexibility. However, this
method requires you to manually share and add each drive to the required NVBU
Clients. To add shared devices manually, perform the following steps:
1. Click Device Management on the toolbar or Large Buttons panel to open
the NVBU Device Management window. Alternatively, on the
Administration menu, click Device Management.
2. On the Add menu, click Add Library to open the Add Library window.
3. Under Choose Library, locate the NVBU Server or SmartClient to which the
device is connected. Double-click the node, or right-click it and select Open.
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4. Depending on the library type, open the appropriate node to display the
available libraries.
5. Double-click the library, or right-click and choose Select to display the library
picture, type and details under Selected Library.
6. Click the Drive Selection tab.
7. Open the NVBU Server or SmartClient node to which the device is
connected.
8. Open the appropriate drive type to display the available drives.
Note: When selecting the drives to be shared, be sure to match the drives with the
appropriate bay (data transfer element address). To obtain the proper bay number
for each device, refer to the relevant Library Operations or User’s Guide.
9. Right-click the drive to be shared, and select Add Shared.
Important: When selecting the drives to be shared, be sure to match the drives by
the Serial Number. To obtain the serial number, right-click the drive to be shared,
and select Configure. On the Configuration tab, the Serial Number is displayed.
10.Open the NVBU SmartClient which will share the drive.
11. Open appropriate drive type to display the available drives.
12.Right-click the corresponding drive which will be shared, and select Add
Shared.
13.Repeat Step 7 – 12 for each drive that will be shared.
14.Enter an appropriate name in the Library Name box.
15.Click Save Details on the toolbar. The library is added and listed on the
Devices tab. When the library initialization completes, the status changes to
online.

4.10.4

Modifying Existing Libraries
This section describes the semi-automatic and manual procedures for adding
shared drives to an existing non-shared library configuration.

4.10.4.a

Adding Shared Drives to Non-Shared Library Using the SemiAutomatic Method
1. Right-click the library, and select Modify.
2. Click the Configure tab.
3. Right-Click on the robotic arm and select Scan for Shared Drives.
Note: At this time NVBU will probe all NVBU Clients in the clients list for devices
that match the serial numbers of those that have already been added.
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4. Click Save Details on the toolbar. The library is added and listed on the
Devices tab. When the library initialization completes, the status changes to
online.

4.10.4.b

Adding Shared Drives to Non-Shared Library Manually
1. Right-click the library, and select Modify.
2. Click the Drive Selection tab.
3. Open the NVBU Server or SmartClient node to which the device is
connected.
4. Open the appropriate drive type to display the available drives.
Note: When selecting the drives to be shared, be sure to match the drives with the
appropriate bay (data transfer element address). To obtain the proper bay number
for each device, refer to the relevant Library Operations or User’s Guide.
5. Right-click the drive to be shared, and select Add Shared.
6. Increase or change the bay number.
7. Repeat Step 5 – 6 for each drive that will be shared.
8. Click Save Details on the toolbar. The library is added and listed on the
Devices tab. When the library initialization completes, the status changes to
online.

4.10.5

Sharing Standalone Drives
To add standalone drives as shared, perform the following steps:
1. On the Add menu, click Add Standalone Drive to open the Add Standalone
Drive window.
2. Under Choose Drives on the Drive Selection tab, open the NVBU Server or
SmartClient node to which the device is connected (double-click the node, or
right-click it and select Open).
3. Open the corresponding drive type node to display the available drives.
4. Right-click the drive and select Add Shared. The drive picture, type and
details are displayed under Selected Drives.
5. To configure the drive parameters, refer to Configuring Physical Tape Drives
on page 65.
6. Click Save Details on the toolbar. The drive is added and listed on the
Devices tab. When the drive initialization completes, the status changes to
online.
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Using Mixed Media Libraries
This section provides detailed information on adding and configuring mixed media
libraries.

4.11.1

Organizing Media in a Mixed Media Library
Before adding a mixed media library, you must organize the media within so that
like-types are grouped together in ranges of slots in the library. For example, for
two media types, group each type together and then place each group in a
consistent range of slots. Note the slot locations for each type. This information will
be required when configuring the library.

4.11.2

Adding and Configuring a Mixed Media Library
To add a mixed media library, perform the following steps:
1. Click Device Management on the toolbar or Large Buttons panel to open
the Device Management window. Alternatively, on the Administration
menu, click Device Management.
2. On the Add menu, click Add Library to open the Add Library window.
3. Under Choose Library on the Library Selection tab, open the Server/Client
node to which the device is connected (double-click the node, or right-click it
and select Open).
4. Depending on the library type, open the Robotic Libraries or NDMP
Robotic Libraries node. The attached libraries are listed under their type.
5. Double-click the library or right-click and choose Select. The library picture,
type and details are displayed under Selected Library.
6. Click the Drive Selection tab.
7. Open the Server or Client node to which the device is connected.
8. Open the corresponding drive type node. The available drives are listed
under this node.
9. Perform the following steps to assign the correct drive bay to each drive:
a. Enter 1 in the Select for Drive Bay box.
b. Under Choose Drives, double-click drive 1 or right-click it and choose
Select. The drive picture, type and details are displayed under Selected
Drives.
c. Repeat steps a and b for the remaining drives, changing the drive number
and bay for each drive.
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Note: While the drive number usually matches the bay number, depending on the
library and drive configuration a different assignment of drives to bays might be
necessary. If you experience failure during move or load/unload operations,
consider adding your drives in a different order to their bays.
10.Click the Configure tab, and double-click the target library in the device list.
11. In the Configure Device window, click the Mixed Media tab. Configure the
following parameters:

Figure 4-26:
Mixed Media
tab



Slot Types – The Slot Types list specifies the slot range(s) for each
media type. The slot range(s) for each media type would be determined
by how the media was organized in the library during initial setup (for
details, refer to Administering Physical Tape Libraries on page 84). To
create this list, assign a unique Slot Type Identifier for each media type
and specify the corresponding slot range for it. The format for creating this
list is given below:
<SlotTypeIdentifier>=<SlotRange>
More than one slot range can be configured for a media type. However,
each slot range or individual slot must be configured as a separate list
item. Comma-separated values are not supported. Use the same Slot
Type Identifier for configuring the additional slots or slot ranges. When
assigning a Slot Type Identifier, ensure that it allows you to easily identify
the media type contained in the slot. No spaces are allowed in the values.
Some examples are given below:
SDLTMedia=1-10
STKRMedia=11-30
LTO1Media=31-60
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LTO1Media=101


Drive Types – The Drive Types list specifies the types of drives that are
available on the library. To create this list, assign a unique Drive Type
Identifier for each media type and specify the corresponding drive number
for it. The format for creating this list is given below:
<DriveTypeIdentifier>=<DriveNumber>
For multiple drives of the same type, configure each individual drive as a
separate list item. Comma-separated values are not supported. Use the
same Drive Type Identifier for configuring multiple drives of the same type.
When assigning a Drive Type Identifier, ensure that it allows you to easily
identify the drive type. No spaces are allowed in the values. Some
examples are given below:
SDLT=1
STKR=2
STKR=3
LTO1=4



Drive Types/Media Type Compatibilities – This list specifies the
supported media type for each drive type. The format for creating this list
is given below:
<DriveTypeIdentifier>=<SlotTypeIdentifier>
Some examples using the above Drive Type and Slot Type Identifiers are
given below:
SDLT=SDLTMedia
STKR=STKRMedia
LTO1=LTO1Media
This configuration ensures that media is only obtained from the
corresponding slots when a particular type of drive is accessed.

12.Click Save Details on the toolbar. The library is added and listed on the
Devices tab. When the library initialization and inventory completes, the
status changes to online.

4.11.3

Adding Media to a Library with Entry/Exit Ports
To add media to a library that has an entry/exit port, perform the following steps:
1. Open the Device Management window.
2. On the Devices tab right-click the target library, and select Open Entry/Exit
Port.
3. Insert the media in the EE port.
4. On the Devices tab right-click the target library, and select Close Entry/Exit
Port.
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5. A Close Entry/Exit Port window will appear. In the Media Type list, select
the correct media type for the new media and click OK.
NVBU will automatically import the media and place it in a pre-configured slot
of the same type.
6. Repeat steps 2–5 for each additional media.
Note: Ensure that the media type for the new media is assigned correctly. An
incorrect media type association would result in future job failures. In addition, the
library may be physically damaged as the arm changer attempts to place a wrong
media into a drive.

4.11.4

Adding Media to a Library without Entry/Exit Ports
To add media to a library that has an entry/exit port, perform the following steps:
1. Open the Device Management window.
2. On the Devices tab right-click the target library, and select Open Door.
3. Place the media in an empty slot corresponding to the slot range assigned for
the media type.
4. Repeat step 3 for each additional media.
5. On the Devices tab right-click the target library, and select Open Door.
Note: Ensure that the media is inserted into a slot that corresponds to the slot
range configured for the given media type. Inserting the media into an incorrect
slot would result in future job failures. In addition, the library may be physically
damaged as the arm changer attempts to place a wrong media into a drive.

4.12.0

Administering Physical Tape Libraries
This section provides information on managing physical and virtual disk devices
added to the NVBU Server. The information in this section is organized into the
following topics:


Viewing Device Details



Modifying a Library



Changing the Device View



Opening and Closing a Library Door



Opening and Closing Entry/Exit Ports



Checking an Offline Drive



Taking a Drive Offline in NVBU



Loading and Unloading Media



Exporting Media to Entry/Exit Port
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Restarting ACSLS or NDMP Libraries

Viewing Device Details
To view the status and performance statistics for a device, perform the following
steps:
1. On the Devices tab right-click the target library, drive or slot, and select
Status.
2. The status window is organized as follows:


Library Details – The status window for a library contains the following
tab:




Details – This tab displays the device name, the controlling machine
name and the current status of the library.

Drive Status Window – The status window for a drive is divided into two
parts – Drive and Media:
Drive

Figure 4-27:
Drive Statistics
tab



Details – This tab displays the drive and media status



Drive Statistics – Click this tab to view the amount of data read and
written, the number of read/write errors, and the dates on which the
last read and write operations were performed.
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Library Info – Click this tab to view the physical and logical position of
the drive.



Cleaning – Click this tab to view the drive cleaning statistics.



Statistics – Click this tab to view the drive statistics.

Media





Details – This tab displays the barcode, label, group label, media type
and other details.



Statistics – Click this tab to view the amount of space used and left,
total number of segments, and the dates on which the last read and
write operations were performed.



History – Click this tab to view the reuse details, the amount of data
read and written, and the number of read/write errors.



Library Info – Click this tab to view the slot number and the library
name.

Slot Status Window – The status window for a slot is divided into two
parts – Slot and Media:
Slot


Library Info – The Library Info tab under Slot displays the physical
and logical position of the slot.

Media – It is similar to the Media section for the drives as detailed above.
3. Click OK to exit.

4.12.2

Modifying a Library
To modify the library configuration, perform the following steps:
1. On the Devices tab right-click the library, and select Modify.
2. The Modify Library window that appears is similar to the Add Library
window. To change the settings, refer to Adding the Libraries Manually on
page 60.
3. To save the new settings, click Save Details on the toolbar, or on File menu
click Save.

4.12.3

Changing the Device View
NVBU provides two ways to view the added devices:


Physical View – This is the default view. It displays the actual structure of the
library, including all drives, slots and entry/exit ports. Media is shown at its
current location in the library.
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Figure 4-28:
Physical View



Logical View – This view is centered around the actual media in a library.
The device tree contains two folders – Drives and Media. The libraries and
drives are grouped as Drives and the Media are grouped according to the
Group Label.

Figure 4-29:
Logical View

To change the view type, perform the following steps:
1. On the Devices tab right-click the target library, and select Change View.
2. The view changes from Physical to Logical or vice versa and a message is
displayed.
3. Click OK to close the dialog.

4.12.4

Opening and Closing a Library Door
Before opening the library door, you must issue the Open Door command from
the NVBU Device Management window. NVBU attempts to put a software lock on
the library door which prevents anyone from opening the door without issuing the
Open Door command. Moreover, if you do not issue this command, then NVBU
will not know when tapes are added, removed or rearranged, and may attempt to
load non-existent media. To open a library door from the NVBU Console, perform
the following steps:
1. On the Devices tab right-click the library, and select Open Door. The library
goes offline when you open the door
2. To bring it back online, right-click, and select Door Closed.
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4.12.5

Opening and Closing Entry/Exit Ports
To open or close the entry/exit ports, perform the following steps:
1. On the Devices tab right-click the library, and select Open Entry/Exit.
2. To close the port after placing the media, select Entry/Exit Closed. If you
have placed a cleaning media in the port, select Entry/Exit Closed with
Cleaning Media. NVBU moves the media to a cleaning slot in the library.

4.12.6

Checking an Offline Drive
To check an offline drive on which a piece of media is loaded, perform the
following steps:
1. On the Devices tab right-click the drive, and select Check to run a self-test.
2. The status changes to online if a piece of media is found during the self-test.

4.12.7

Taking a Drive Offline in NVBU
To take a drive offline and make it unavailable to NVBU, perform the following
steps:
1. On the Devices tab right-click the drive, and select Offline. This marks the
drive as offline and it is not available for use with NVBU. For shared drives,
you can either mark an individual drive or all paths as offline.
This process does not physically take the drives offline.
2. To bring a drive online and make it available to NVBU, right-click the drive
and select Online.
Note: A standalone physical drive cannot be brought online if the device contains
a piece of media. You must either restart the NVBU Service, or remove the media
before selecting the Online option.

4.12.8

Loading and Unloading Media
To load and unload media, perform the following steps:
1. On the Devices tab right-click the slot, and select Load.
2. This loads the media on to an available drive.
3. To unload a piece of media, right-click the drive and select Unload. In a
library the media is moved to an available slot, while in a standalone drive the
media is ejected.
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Exporting Media to Entry/Exit Port
To export a piece of media to an entry/exit port, perform the following steps:
1. On the Devices tab right-click the slot, and select Export.
2. This moves the media in the slot to an entry/exit port.

4.12.10

Restarting ACSLS or NDMP Libraries
If an ACSLS or an NDMP library encounters a network problem, use this
procedure to restart the library. It stops and restarts the changer and drive
processes. This has the effect of restarting the network/socket connections as the
existing ones are closed and new ones are created.
1. On the Devices tab right-click the library, and select Restart.
2. This restarts the network/socket connections by removing and adding the
library again.

4.13.0

Importing NetApp VTL’s Shadow Tape
NVBU extends support to NetApp VTL's shadow tape feature which allows you to
quickly import a tape from the shadow tape pool whenever possible instead of
obtaining the physical tape.
To use shadow tapes, configure the Enable Shadow Tapes on the filer and on the
library containing the virtual tape. For more information on enabling shadow tapes,
consult the relevant NetApp VTL documentation. Use the tape barcode as the
label for the virtual tape media. NVBU requires this method of labelling media to
be fully functional. (This can be configured by selecting the Use Barcodes as
Labels check box on the Media Manager tab of the Configurator.)
With shadow tapes enabled, whenever a virtual tape is exported to a physical
tape, the virtual tape is moved to the shadow tape pool. The shadow tape pool is
invisible to the backup application and is not listed as part of a virtual library.
However, it is available for quick access if the physical tape is later imported, and
is available for reading if the physical tape is stored offsite or otherwise
unavailable.
The NetApp VTL manages the space used by shadow tapes, and can delete a
shadow tape if more space is required for new backup data. The administrator can
set a preferred retention time for shadow tapes; if space is required, but the
retention period has not expired, the NetApp VTL sends a notification before
deleting the shadow tape.
To import a virtual tape, perform the following steps:
1. On the Devices tab, right-click the library containing the virtual tape and
select Import Media. The Select Shadow Tape Media Barcode for Import
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window appears, which provides a list of media barcodes for the tapes
available in the shadow tape pool.

Figure 4-30:
Select Shadow
Tape Media
Barcode for
Import window

2. In the Media Barcode list, select the barcode for the target media.
Alternatively, enter the barcode.
3. Click OK. The requested tape is imported into the medium changer from the
shadow tape pool, if present, or from the physical library. If both the shadow
tape and the physical tape are present, then the shadow tape is converted to
a (read only) virtual tape and imported to the EE port. If only the physical tape
is available, a virtual tape is created from the physical tape and the virtual
tape is imported to the EE port.
Note the following:


The media requests for shadow tapes can only be used for Restore or
Duplication tasks because the shadow tape is converted to a virtual tape
with the read-only attribute set.



All shadow media must be exported from a library before NVBU is shutdown
and restarted; otherwise the media loses its shadow media attribute and is
only recognized as read-only. This happens because the NVDB does not hold
a permanent record of the shadow tape media. The database holds only the
details of the actual media. The shadow tape attribute is associated with the
media when it is imported as shadow tape into the library. For the same
reason, shadow tape media should be exported before the library door is
opened.



Error messages are displayed if you try to import media when no media is
available in the shadow tape pool, or when the shadow tapes feature is not
supported on the device.
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Removing a Physical Tape Library
To remove a library, perform the following steps:
1. On the Devices tab right-click the library, and select Remove.
2. In the confirmation window, click OK. NVBU removes the library and deletes
all the related data from the NVDB.
Note: Removing a library does not remove the media information from the NVDB.
You can still use the media on any other library that supports the given media type.
No scanning of media is required as long as the Controlling Server remains the
same. On a different NVBU Domain, you must scan the media.

4.15.0

Device Status Indicators
The devices added to the NVBU Server are displayed on the Devices tab of the
NVBU Device Management window. NVBU uses the following status indicators to
indicate the availability of the devices:

Figure 4-31:
Devices tab



Green Light – This icon indicates that the device is online and available for
use.



Yellow Light – This icon indicates that a backup or restore job is currently
using this device.



Red Light – This icon indicates that the device is currently offline. NVBU can
detect the device but it cannot be accessed for backup or restore jobs.
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Red Cross – This icon indicates that the device is unavailable (e.g., the SCSI
cable is disconnected, the device is removed, etc.). NVBU cannot detect the
device.

For a consolidated view of Client, Device and Job status, click Status on the
toolbar or Large Buttons panel. Alternatively, on the Operations menu, click
Status.
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BACKUP
This chapter describes how to use NVBU to backup your data. The information in
this chapter is organized into the following topics:


Backup – An Overview



Designing a Backup and Recovery Strategy



Backing up Data with NVBU Plugins



Creating a Backup Job



Configuring Target Device and Media Options





Selecting Target Device



Configuring Backup Media Options

Configuring Advanced Backup Options


Configuring the Retention Policy for a Backup



Enabling Job-level Encryption



Disabling Job-level Deduplication



Enabling Backup Verification



Enabling Network Compression



Creating Secondary Copies



Using Pre and Post Backup Scripts



Setting up a User-Defined Notification Event



Viewing and Modifying a Backup Job



Archiving Data



Managing Backup Indexes


Deleting Online Indexes



Compressing Online Indexes
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5.1.0

Backup – An Overview
A backup is a copy of data which can be used to restore and recover the original
data object after a data loss event. NVBU provides a number of plugins which
interface with the native APIs to backup the application-specific data. The backup
methods and options provided by these plugins vary depending on the application
type.

5.2.0

Designing a Backup and Recovery Strategy
The primary objective of backing up data is to recover from the damages caused
by a data loss event and resume normal operations quickly. This requires a
well-designed backup and restore strategy that maximizes data protection and
minimizes data loss, while considering your business requirements and balancing
your needs with costs, resources and other factors.
The key to formulating an efficient strategy is to envision the possible failure
modes, like media failure, data corruption, user error or complete loss of a data
centre, match the plugin features that can be used to recover from these scenarios
and then include the necessary backup methods in your plan.
Typically, your backup plan should include the backup methods you will use, the
frequency of backups, the retention period for backups and the media rotation
policies, and how you will store the backup media. Answering the following
questions will help you choose the suitable methods and define the schedule.


What is the amount of data to be backed up?



Does it comprise mainly of large files or smaller ones?



What is the frequency of updates and changes?



Which time during the day and/or week can be considered off-peak period for
full backups?



Are some files updated more frequently than others?



Are the changes confined to a small or large number of files?



Are there situations that demand ad-hoc backups independent of the regular
backup schedule?



How much space is available for storing backups and what are the future
expansion plans?
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Backing up Data with NVBU Plugins
Backups are performed from the NVBU Backup window. You can use the Console
running on the NVBU Server or any Client to define and submit the backup jobs. A
backup job definition generally consists of the following components:


Selection list



Plugin specific backup options



Job schedule



Source device options which specify where the source media is located (Data
Copy Plugin and Consolidate Incremental Backups Plugin)



Target device and media options



Advanced backup options

Each component contains a set of attributes which can be configured using the
following methods:


For each new job, you can set the attributes manually and save them in the
job definition. This method is better suited for ad-hoc jobs that are seldom
performed, or jobs that mainly use the default options.



Alternatively, you can use selection sets to store the job attributes and use
them to define the subsequent jobs without manually defining each job. This
method is recommended for repeating jobs. With selection sets, you can
easily change any one component and automatically apply them to all jobs
using that set. For example, you can change the target device for all jobs by
changing the device configuration in the Target set. For details on selection
sets, refer to Selection Sets on page 127.

Each job has a Job ID and a title. The Job ID is a sequential number which is autogenerated. The job title is user-defined and allows you to easily identify the job
when monitoring its progress, viewing the job logs or selecting the saveset to
restore data. The backup data is stored in a Saveset on the media. For each
saveset, NVBU generates an index that is written to the NVDB and the backup
media. The index contains the header information which is required for restoring
data. The maximum index size for a saveset can be 4GB.
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5.4.0

Creating a Backup Job
To create a backup job, perform the following steps:
1. Click Backup on the toolbar or Large Buttons panel to open the NVBU
Backup window. Alternatively, on the Operations menu, click Backup.

Figure 5-1:
NVBU Backup
window

2. On the Selections tab, open the target Client node. To open any node on the
Selections tab, you can do either of the following:


Double-click the node



Right-click the node and select Open

3. Select the plugin you want to use.
4. Select the data you want to backup. The selection tree varies for different
plugins. Refer to the relevant APM/Plugin User's Guide for more information
on selecting data for a backup.
5. Click the Backup Options tab and configure the backup method, backup
type and other plugin-specific backup options. Refer to the relevant APM/
Plugin User's Guide for more information on specific backup options.
6. Click the Schedule tab and configure the scheduling options. You can define
a daily, weekly, monthly or any other custom schedule. For details, refer to
Job Scheduling on page 113. You can omit this step if you want to run the job
immediately, which is the default schedule for all NVBU jobs.
7. Click the Target tab and configure the backup device and media options. For
details, refer to Configuring Target Device and Media Options on page 97.
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8. Click the Advanced Options tab and configure the advanced backup
options, such as the backup retention period, deduplication, job-level
encryption and secondary copy options. For details, refer to Configuring
Advanced Backup Options on page 100. You can omit this step if you do not
want to set any advanced options for the job.
9. Enter a title for the job in the Job Title box at the top right corner of the
Backup window.
10.Choose one of the following methods to save and/or schedule the job.
a. Save the Definition without Scheduling the Job – To save the job
definition without scheduling it, click Save on the toolbar. Alternatively, on
the File menu, click Save.
A saved job does not appear on the Status tab of the Jobs window and
does not run unless you submit it (or use the Triggered scheduling
option). You can load a saved job again in the Backup window, or open it
for editing from the Jobs tab of the Jobs window. For details on editing a
job definition, refer to Viewing and Modifying a Backup Job on page 109.
b. Schedule the Job – To submit the job for scheduling click Submit on the
toolbar. Alternatively, on the Accept menu, click Submit Backup.

5.5.0

Configuring Target Device and Media Options
This section describes how to configure the target device and media options for a
backup job. The information in this section is organized into the following topics:


Selecting Target Device



Configuring Backup Media Options
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Figure 5-2:
Target tab

5.5.1

Selecting Target Device
By default, NVBU uses any available device to perform backups. To override this
setting, perform the following steps:
1. In the NVBU Backup window, click the Target tab.
2. To select the target device configure the following options under Device
Options:
Important: An NVSD Device is considered a network-attached device or a nonlocal device.


Local Drives Only – Select this check box to use only locally attached
devices.



Any Device – Leave this option selected if you want NVBU to handle the
device selection.
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Specify Device – Select this option to use particular device(s). In the box
below, all the devices added to the NVBU Server are listed. Since NVBU
is configured to automatically select a backup device, all the devices in the
list are selected by default. To exclude devices, perform the following:


To exclude a particular library, clear the check box for it. All the drives
associated with the device are automatically removed when you
remove the library.



To exclude a particular drive, clear the check box for it.



To exclude a particular NVSD Device, clear the check box for it.

Configuring Backup Media Options
To configure the backup media options, perform the following steps:
Note: The backups targeted to NVSD Devices are stream-oriented. For such jobs,
you can configure the Group Label option in order to target an NVSD Device that
belongs to the selected media group without specifying a particular device. The
remaining Media Options described in this section do not apply to an NVSD
Device, and are ignored for jobs targeting an NVSD Device.
1. In the NVBU Backup window, click the Target tab.
2. To select the target media, configure the following options under Media
Options:


Any Not in a Group – Select this option to use media that are not
associated with any group. This is the default media setting for a backup
job.



Any – Select this option to use any media regardless of its group.



MID – Select this option to use a particular media. Then, select the media
label in the list next to the option.



Group Label – Select this option to use media associated with a
particular media group. Then, select the group label in the list next to the
option.

3. To re-use media, select one of the following media re-use options:


Any – Select this option to target any media marked as re-usable.



With Same Group Label as Target Media – Select this option to target
media associated with the group selected in the previous step.

Important: NVBU automatically marks media for re-use when the last saveset on
the media expires. You can also manually mark media as re-usable. For details on
manually marking media as re-usable, refer to Marking Media for Re-use on page
163.
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4. To label a blank media, select Automatically Label Blank Media under
Media Options. The media label is generated by combining the NVBU
Server Name and Date. You can also configure NVBU to generate labels
using the media barcodes. To assign the media barcodes as labels, refer to
the NetVault: Backup Configuration Guide.
5. If you want to use only those media which have at least <n> MB of free space
available before backup, select Specify Minimum Space Required on
Media Before Backup under General Options. In the M Bytes box, enter or
select the minimum free space required on the media.
6. To write-protect the media after backup, select Protect Media from Further
Writes After Backup under General Options. To do this anytime later, refer
to Write-protecting Media on page 161.
7. To store the saveset at the start for a tape, select Ensure this Backup is the
First on the Media under General Options. The data can be restored
quickly if the saveset is located at the start of a physical tape. The saveset is
only written to new or blank media if you select this check box.
8. To set a timeout interval for the availability of a suitable backup media, select
the Media Request Timeout check box under General Options. In the
boxes next to this option, enter the timeout interval. The job is aborted if the
backup tapes are not available within the specified interval. If you set this
parameter to zero, the job will wait indefinitely for the media.

5.6.0

Configuring Advanced Backup Options
This sections describes how to configure the advanced options for a backup job.
The information in this section is organized into the following topics:


Configuring the Retention Policy for a Backup



Enabling Job-level Encryption



Disabling Job-level Deduplication



Enabling Backup Verification



Enabling Network Compression



Creating Secondary Copies



Using Pre and Post Backup Scripts



Setting up a User-Defined Notification Event
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Figure 5-3:
Advanced
Options tab

5.6.1

Configuring the Retention Policy for a Backup
The retention policy for a backup defines how long the information about the
saveset is kept in the NVDB. The retention policy can be generation-based or
time-based.


Generation-based Backup Retention – In a generation-based retention
policy, you specify the number of Full Backups for the same set of data you
want to retain. This method can only be used for Full Backup type.



Time-based Backup Retention – In a time-based retention policy, you
specify the number of days, months or years you want to retain a backup.
The time-based retention policy can be set for all backup types – Full,
Incremental and Differential.
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When the retention period elapses, NVBU retires the saveset and deletes
information about the saveset from the NVDB. The information about the savesets
for Incremental/Differential backups is automatically discarded when the base Full
Backup retires.
To configure the retention period for a saveset, perform the following steps:
1. In the NVBU Backup window, click the Advanced Options tab.
2. To set generation-based retention period, perform the following:
a. Under Backup Life, select Discard After (x Full Backups).
b. In the box, enter the retention period in number of Full Backups to keep
this saveset. For example, to retain four (4) Full Backups on an NVSD
Device, enter 4.
3. To set time-based retention period, perform the following:
a. Under Backup Life, select Discard After (x Days/Weeks/Years).
b. In the box, enter the retention period in number of days, weeks or years.
c. Select Days, Weeks or Years option next to the box.
Note: To set or change the retention period for an existing saveset, refer to
Retiring Backup Savesets on page 162.

5.6.2

Enabling Job-level Encryption
The NetVault: Backup Encryption Plugin (Encryption Plugin) provides CAST-128,
AES-256 and CAST-256 algorithms to meet regulatory requirements without
sacrificing backup windows or deduplication performance. When installed on the
NVBU Server or Heterogeneous Clients, the Encryption Plugin encrypts and
transfers data across the network to the backup device, where it remains
encrypted until restored to the NVBU Server or the Heterogeneous Client.
Once the Encryption Plugin is installed, you can enable encryption for all backups
for the NVBU Server or Heterogeneous Clients where the plugin is installed.
Alternatively, you can enable encryption only for specific jobs. Encryption can also
be enabled only for the primary backup or just the secondary backups. This
enables users to take advantage of both encryption and deduplication by
deduplicating the primary backup and encrypting the secondary copy. For details
on creating secondary copies, refer to Creating Secondary Copies on page 105.
Job-level encryption for primary backups is beneficial in the following situations:


Not all the NVBU Plugins installed on the NVBU Server or Heterogeneous
Client are compatible with the Encryption Plugin



Not all backups from the same NVBU Server or Heterogeneous Client require
encryption
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Primary backups do not require encryption while secondary backups for
offsite protection do require encryption



Primary backups are targeted to NVSD Devices for deduplication

For details on defining an encryption strategy, installing and configuring the
Encryption Plugin, refer to the NetVault: Backup Encryption Plugin Guide.
To enable encryption for a primary backup, perform the following steps:
1. In the NVBU Backup window, click the Advanced Options tab.
2. Under Additional Options, select the Enable Encryption check box.
Important: To ensure that a primary backup selected for encryption is not
deduplicated when targeted to NVSD Devices with the Deduplication Option, the
Enable Deduplication option will automatically be disabled when the Enable
Encryption option is selected. You can enable encryption for secondary copies
that are stored offsite for disaster recovery. For details, refer to Creating
Secondary Copies on page 105.

5.6.3

Disabling Job-level Deduplication
NVBU provides seamless integration with NVSD, BakBone's next generation diskbased backup and deduplication product. While NetVault: Backup provides
seamless integration with NVSD to provide disk-based backup and optional
deduplication, NVSD is a separate product which is installed and licensed
separately from NVBU. Job-Level Deduplication is enabled by default and must be
disabled for the following backup jobs:


Encrypted primary backups targeting NVSD Devices with the Deduplication
Option licensed. Encrypted backups do not deduplicate well and should not
be deduplicated.



Incremental Backups that will be consolidated with the Consolidated
Incremental Backup Plugin to NVSD. This will eliminate unnecessary
overhead of rehydrating the deduplicated Incremental Backups during the
consolidation process but still enable the resulting Consolidated Full backup
to be deduplicated.

To disable deduplication for a backup job, perform the following steps:
1. In the NVBU Backup window, click the Advanced Options tab.
2. Under Additional Options, click to clear the check box for Enable
Deduplication.
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5.6.4

Enabling Backup Verification
NVBU includes a built-in Verify Plugin, which can be enabled to check the
correctness and completeness of a backup at the end of data transfer. It verifies
the stream length written to the media and makes sure that no blocks were
dropped during backup. The actual backup runs as phase 1, while backup
verification runs as phase 2 of the backup job. By default, the verification phase
runs on the NVBU Server. To run the verification phase locally or to configure
another default Client, refer to the NetVault: Backup Configuration Guide. An error
is logged if any dropped blocks are detected and the verification fails. You must
run the job again if the backup verification fails. To enable backup verification for a
job, perform the following steps.
1. In the NVBU Backup window, click the Advanced Options tab.
2. Under Additional Options, select the Verify After Backup check box.
Note: Backup verification does not verify the integrity of the data; only that the
backup was actually written to the media.

5.6.5

Enabling Network Compression
While transferring data over the network, you can compress the data to reduce the
bandwidth usage. The data is first compressed on the target NVBU Client before it
is transferred over the network. On the NVBU Client to which the target device is
attached, the data is decompressed before it is written to the media. Note that
network compression does not work for the following types of jobs:


Backups targeted to NVSD Devices.



Backups to devices attached to NAS Filers.



Jobs using the NDMP Plugin, NetWare Thin Client Plugin or NetVault:
Backup Bare Metal Recovery.

To enable network compression for the supported backup jobs, perform the
following steps:
1. In the NVBU Backup window, click the Advanced Options tab.
2. Under Additional Options, select the Enable Network Compression check
box.
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Creating Secondary Copies
With a backup job, you can choose to run a phase 2 job to create a secondary
copy of the backup. NVBU supports the following methods for creating secondary
copies:


Duplicate – This method creates an exact secondary copy which is linked to
the original primary backup. During duplication, the copy is broken into
segments and stored on the secondary backup device. During restore,
segments from the primary copy and the secondary copy are
interchangeable. This makes it impossible to unencrypt the primary backup
and encrypt the secondary copy because it is not possible to mix unencrypted
segments with encrypted segments during restore. Therefore, you cannot
enable or disable encryption for a secondary copy created with the duplicate
method.
If the original saveset is encrypted, the Duplicate method will create an
encrypted secondary copy. If you have not encryption for the primary backup,
the secondary copy will also be unencrypted.



Data Copy – This method is recommended when you want to create a
secondary copy for offsite storage. The Data Copy method breaks the backup
into segments and copies the segments onto the targeted backup device.
During restore, NVBU only restores the primary copy or the secondary copy.
Backup segments from the primary and the secondary are not
interchangeable. This enables the ability to encrypt the Data Copy, or
secondary copy, while the primary copy remains unencrypted such as with
deduplicated primary backups.

To create a secondary copy of a backup, perform the following steps:
1. In the Backup window, click the Advanced Options tab.
2. Under Secondary Copy, select the Create Secondary Copy check box.
Figure 5-4:
Secondary
Copy options
on Advanced
Options tab
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3. Select one of the following copy methods:


Duplicate – This method can be used for any backup type.



Data Copy – This method can only be used for Full Backups.

4. By default, the secondary job always runs on the NVBU Server. To run the job
on a particular NVBU Client, select the Client in the Run Secondary Copy
On list. This option can be used to perform local backups to SmartClient with
a locally attached physical or virtual tape device.
Important: Ensure that the NVBU Server or Client selected to run the Secondary
Copy is running NVBU v8.5 or later.
5. In the Using Schedule Set list, select the set that defines the scheduling
options for the secondary job. Select Immediate if you want to run the
instance immediately after the original job completes. You cannot use the
Repeating or Triggered schedule types for the secondary job. If a schedule
set is not available, click Manage. Configure the scheduling options on the
NVBU Schedule Management window and click Save As to create the
schedule set. For details on schedule sets, refer to Selection Sets on page
127.
6. In the Using Target Set list, select the set that defines the target device and
media options for the secondary copy. The original saveset and the copy
cannot be stored in the same media. If a target set is not available, click
Manage. Select the scheduling options in the NVBU Backup Target
Management window and click Save As to create the schedule set. For
details on target sets, refer to Selection Sets on page 127.
Note: BakBone recommends that you designate specific drives for secondary jobs
to prevent deadlocks. For example, if you have a library with 4 drives, you can
select drives 1 and 2 for actual backups, whereas drives 3 and 4 for secondary
copies targeted to tape devices.
7. To encrypt a secondary copy, select the Encrypt Secondary Copy Only
check box. This option is only available for the Data Copy method. If the
primary copy is encrypted, Data Copy will automatically create an encrypted
saveset whether the Encrypt Secondary Copy Only check box is selected
or not. Therefore, this option is only useful when you want to create an
encrypted secondary copy of an unencrypted primary copy.
Important: Encrypted primary copies will not be encrypted again if the Encrypt
Secondary Copy Only check box is selected for a copy. For restoring data from
such secondary copies, you must use the primary copy’s Encryption Key.
8. To migrate data, select the Migrate check box. After migrating the data,
NVBU deletes the index for the original backup.
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Note: With the File System Plugin, the Migrate option is only supported for Full
Backups that do not have associated Incremental or Differential Backups. If the
Migrate option is selected for a Full Backup which has an associated Incremental
or Differential, the secondary copy will be created successfully. However, the index
for the primary or original backup will not be deleted. An alternative would be to
create a secondary copy with the Duplicate or Data Copy option, and manually
retire the primary or original backup from the NVBU Media Management window.
9. Select the Allow Streams to Share Media check box to convert multiple data
streams into a sequential data stream and write it to the same media. This
reduces the number of media items required for the copy.
10.Configure the retention period for the copy as described below:

5.6.7



To use the original saveset’s retention period, select Use Originals Life.



To set a different retention period for the duplicate, select Discard After.
In the box provided, enter the retention period in number of days, weeks
or years. Select Days, Weeks or Years option next to the box. You can
only set a time-based retention policy for the duplicate saveset.

Using Pre and Post Backup Scripts
NVBU allows you to run your own scripts at the start and/or completion of a
backup job. These scripts can be used to perform tasks, such as dismounting or
shutting down a database before starting the job, or mounting/starting the
database after the job completes. Consider the following points when using pre
and post backup scripts:


The script must be an executable file, for example, .bat on Windows, or .sh
on Linux/UNIX.



The scripts can contain run-time parameters. Use the NVBU environment
variable NV_USER_ARG to access the values for these parameters in the
script.



You can also use other NVBU environment variables in the script. For a list of
available environment variables, refer to
NVBU Environment Variables on page 269.



After creating the script, copy it to the …\scripts folder on the target Client.
You can also create sub-folders to organize the scripts.



If a pre script fails, the backup job fails.



If the pre script completes successfully while the backup job fails, the post
script is still executed; the job status is reported as Backup Failed.



If the pre script and the backup complete successfully while the post script
fails, a script error is logged; the job status is reported as completed with
warnings.

108

Chapter 5
Backup


By default, NVBU provides the following two scripts that can be run as post
backup scripts:


psmail – This script emails the job completion status to the addresses
passed as user parameter.



psmail_logs – This script emails the job completion status and the job
logs to the addresses passed as user parameter.

To run pre and post scripts for a backup job, perform the following steps:
1. In the NVBU Backup window, click the Advanced Options tab.
2. Under Pre and Post Scripts, select the following options:
a. To run a script before the job starts, select Use Pre Script.
b. To run a script after the job completes, select Use Post Script.
3. Enter the script file name in the box next to the selected check box. If the
script resides in the …\scripts folder, just enter the file name. Whereas, if it
resides in a sub-folder within the …\scripts folder, enter the relative path
(e.g., if the script file myscript.bat resides in the folder ...\scripts\tst, enter
\tst\myscript.bat in the box).
4. To pass run-time parameters, enter the value in the User Parameter box.
The value must be valid and conform to its usage in the script. NVBU does
not perform any validity checks on the user parameter.

5.6.8

Setting up a User-Defined Notification Event
An event is an action or a condition that indicates an error, a problem or change in
the component status. NVBU provides a set of pre-defined events for which you
can set up a notification method to alert you when they occur and/or take a
remedial action. For details on event types and notification methods, refer to Event
Notification on page 187. In addition to the default events, NVBU supports the
following custom events for a backup job:


Backup completes successfully



Backup completes with warnings



Backup fails

The custom events defined for a job are added to the Jobs – User Defined event
category in the Global Notification window, and can be raised for any backup job
within the Domain.
To raise a user-defined notification event for a backup job, perform the following
steps:
1. In the Backup window, click the Advanced Options tab.
2. Under Events, select the following option(s):
a. To raise an event when the job completes successfully, select the Raise
Event if Job is Successful check box.
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b. To raise an event when the job completes with warnings, select the Raise
Event if Job has Warnings check box.
c. To raise an event when the job fails, select the Raise Event if Job Fails
check box.
3. In the list next to the selected check box, select the custom event. If no
custom events are defined, the list will be empty. To define a new event, enter
the event name in the box.
4. For a new custom event, perform the following steps:
a. Click Save on toolbar. Alternatively, on the File menu, click Save.
b. Set up the notification method(s) for the event. For details on setting up
global notification methods, refer to Setting up a Global Notification
Method on page 189. For details on setting up user-specific notification
methods, refer to Setting a User Notification Profile on page 200.
c. Load the job again and complete the remaining job definition steps.

5.7.0

Viewing and Modifying a Backup Job
You can use the following procedure to modify an existing job or create a new job
from an existing job definition:
1. Use one of the following methods to load a backup job definition:
a. Load the Job Definition from the Backup Window – This method can
be used for both saved and scheduled jobs.
1. Open the NVBU Backup window.
2. Click Load on toolbar. Alternatively, on the File menu, click Load.
3. In the Load Backup Job window, select the job and then click OK.
b. Load the Job Definition from the Jobs Tab of the NVBU Jobs
Window – This method can be used for both saved and scheduled jobs.
1. Click Job Management on the toolbar or Large Buttons panel.
Alternatively, click Job Management on the Operations menu.
2. Click the Jobs tab.
3. Right-click the job and select Edit/View Job.
c. Load the Job Definition from the Status Tab of the NVBU Jobs
Window – This method can only be used for the scheduled jobs.
1. Click Job Management on the toolbar or Large Buttons panel.
Alternatively, on the Operations menu, click Job Management.
2. On the Status tab, right-click the job and select Edit/View Job. This
loads the job definition in the Backup window.
2. Click the tab that contains the settings you want to change.
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3. On Windows, select the Modify check box at the bottom. Ignore this step on
Linux/UNIX.
4. Re-configure the options, as required. For information on any setting, refer to
the relevant section in this guide or the APM/Plugin User’s Guide. To modify
or customize a selection set, refer to Selection Sets on page 127.
5. Choose one of the following methods to save and/or schedule the job.
a. Save the Definition without Scheduling the Job – To save the job
definition without scheduling it, click Save on the toolbar. Alternatively, on
the File menu, click Save.
b. Schedule the Job – To submit the job for scheduling click Submit on the
toolbar. Alternatively, on the Accept menu, click Submit Backup.

5.8.0

Archiving Data
Archiving is similar to backing up data, however, archives are standalone backups.
Archives cannot be used as base for Incremental or Differential backups. You
must select the Full Backup type with this option; data archived using Incremental
or Differential Backup types cannot be restored. Only time-base retention period
can be set for archives. You can choose the archive option when performing adhoc backups outside the regular backup schedule.
To archive data, perform the following steps:
1. Open the Backup window. Select the data and configure other options. For
details, refer to Creating a Backup Job on page 96.
2. Click the Advanced Options tab and under Backup Life, select Archive.
3. Complete the job definition and save or submit the job.

5.9.0

Managing Backup Indexes
For a backup job, NVBU writes the backup index to both the media and the NVDB.
The backup indexes in the NVDB are called Online Indexes. Online indexes allow
you to quickly scan through the contents of a saveset without loading the media.
However, these indexes increase the disk space consumed by the NVDB. In order
to reduce the space used by the backup indexes, NVBU allows you to compress
the online indexes or delete them.


Deleting Online Indexes – While creating a backup job, you can set an
expiry date for the online indexes and delete them after a certain period. The
data can still be restored by loading the indexes on the backup media. The
savesets for which the online indexes have been deleted are represented by
cross mark icons. To browse or restore a saveset with offline indexes, you
must manually load the index. For details on loading a backup index from the
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backup media, refer to Restoring from a Saveset with Offline Indexes on
page 153


Compressing Online Indexes – The backup indexes can be compressed
manually from the NVBU Restore window, or automatically using an index
compression policy. For more information on automatically compressing the
indexes, refer to the NetVault: Backup Configuration Guide. The savesets for
which the indexes have been compressed are represented by an orange light
icon. NVBU automatically de-compresses the index to a temporary location
when you try to browse or restore such savesets. The temporary directory is
deleted when the operation completes. An index can also be de-compressed
manually. For details, refer to Restoring from a Saveset with Compressed
Indexes on page 153.

Figure 5-5:
Savesets with
offline and
compressed
indexes

The procedures for compressing and deleting online indexes are described in the
following sections.

5.9.1

Deleting Online Indexes
To set an expiry date for a backup index, perform the following steps:.
Note: Deleting a backup index is not the same as setting the retention period for a
saveset. When the retention period expires for a saveset, NVBU discards all
information about it from the NVDB. Although you can scan the media containing
an expired saveset, NVDB will load this index as a new backup index. Whereas,
when you delete the online indexes, NVBU still retains some information about the
saveset which allows it to quickly reload the saveset index from the backup media.
1. When defining a backup job, click the Advanced Options tab.
2. Under Backup Life, select Offline Index After.
3. In the box provided, enter the number of days, weeks or years you want to
retain the index in NVDB.
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4. Select Days, Weeks or Years option, next to the box.

5.9.2

Compressing Online Indexes
To manually compress the backup indexes, perform the following steps:
1. Open the Restore window (click Restore on the toolbar or Large Buttons
panel, or click Restore on the Operations menu).
2. On the Selections tab, open the Client that was the backup target.
3. Locate the plugin used to backup the data and perform one of the following
steps:
a. Compress all Savesets Generated with the Plugin – To compress all
savesets generated with the plugin, right-click the plugin node and select
Compress.
b. Compress Individual Saveset Generated with the Plugin – To
compress particular saveset(s) generated with the plugin, open the plugin
node (double-click this node, or right-click and select Open). Then, rightclick the target saveset node and select Compress.
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Chapter 6:

JOB SCHEDULING
This chapter describes how to set up a job schedule. The information in this
chapter is organized into the following topics:


Job Scheduling – An Overview



Scheduling a Job to Run Immediately



Scheduling a Job to Run on a Specific Date



Scheduling Repeating Jobs



6.1.0



Scheduling a Job to Run Every n Hour(s)



Scheduling a Job to Run at the Same Time Every Day



Scheduling a Job to Run Every n Day(s), Week(s) or Month(s)



Scheduling a Job to Run on Specific Days of Week



Scheduling a Job to Run on Specific Days of Month

Scheduling Non-Repeating Jobs


Scheduling a Non-Repeating Job to Run on Any Day



Scheduling a Non-Repeating Job to Run on Specific Days of Week



Scheduling a Non-Repeating Job to Run on Specific Days of Month



Triggering a Job from an External Script



Scheduling Number of Job Retries



Setting the Job Priority

Job Scheduling – An Overview
A job schedule defines when and at what intervals a job runs. The job scheduling
options are present on the Schedule tab of the Backup, Restore and Reporting
Job Editor windows. You can use these options to accomplish the following:


Run a job immediately



Run a job on a specific date



Establish a routine for repeating jobs



Establish a routine for non-repeating jobs



Trigger a job using an external script

The job scheduling details are stored in the Scheduler database and managed by
the Schedule Manager process. For details on the Schedule Manager process,
refer to the NetVault: Backup Configuration Guide.
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6.2.0

Scheduling a Job to Run Immediately
To run a job immediately, perform the following steps:
1. Click the Schedule tab on the corresponding window.
2. Configure the following parameter:


Scheduling Type – Select the Immediate scheduling type. NVBU
automatically selects this option for a new job unless you change the
default settings. The job will run immediately after you submit the job
definition.

Note: You can also use the Run Now feature to run an existing job immediately.
For details, refer to Running a Job Immediately on page 174.

6.3.0

Scheduling a Job to Run on a Specific Date
To schedule a job to run on a particular date, perform the following steps:
1. Click the Schedule tab on the corresponding window.
2. Configure the following parameters:

Figure 6-1:
Scheduling
options for
Specific Date
scheduling
type



Scheduling Type – Select the Once scheduling type.



Scheduling Options – Under Scheduling Options, configure the
following parameters:


Run At – In the Run At box, enter or select the start time for the job.



Method – Under Method, select Specified Date.



Options – In the Options box, enter or select the date on which you
want to run the job.
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Scheduling Repeating Jobs
Jobs which are performed on a regular basis at the specified date, day or time are
called repeating jobs. For example, a Full or Incremental Backup scheduled to run
daily at 10 P.M. You can establish a repeating job schedule for such jobs, and run
them automatically at the following intervals:


Every <n> hour(s)



Same time every day



Every <n> day(s), week(s) or month(s)



Same day every week



Specific days every week



Specific days on specific weeks



Same day every month



Specific days every month

NVBU schedules the first instance when you submit the job definition. The next
instance is scheduled when the current instance becomes active, and this
procedure is repeated for each subsequent instance. The scheduled job instances
are displayed on the Status tab of the NVBU Jobs window. By default, NVBU
uses a blue background to highlight scheduled jobs.

6.4.1

Scheduling a Job to Run Every n Hour(s)
To run a job every n hour(s), perform the following steps:
1. Click the Schedule tab on the corresponding window.
2. Configure the following parameters:

Figure 6-2:
Scheduling
options for
Every n
Hour(s)
recurrence
interval



Scheduling Type – Select the Repeating schedule type.



Scheduling Options – Under Scheduling Options, configure the
following parameters:
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Run At – In the Run At box, enter or select the start time for the job.



From – In the From box, enter or select the start date for the schedule.



Method – Under Method, select Every.



Options – In the Every box under Options, enter or select the
interval. For example, to run the job every 4 hours, enter 4 in the box.
Select Hour(s) in the frequency options.

Important:
The job will run immediately if the scheduled start time has already passed.
When you edit a job with Every n Hour(s) schedule, you must reconfigure the
start time according to the current time. If the schedule is not updated, an instance
will run immediately when you submit the job definition.

6.4.2

Scheduling a Job to Run at the Same Time Every Day
To set up a daily schedule for a job, perform the following steps:
1. Click the Schedule tab on the corresponding window.
2. Configure the following parameters:

Figure 6-3:
Scheduling
options for
Every Day
recurrence
interval



Scheduling Type – Select the Repeating scheduling type.



Scheduling Options – Under Scheduling Options, configure the
following parameters:


Run At – In the Run At box, enter or select the start time for the job.



From – In the From box, enter or select the start date for the schedule.



Method – Under Method, select Every Day.
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Scheduling a Job to Run Every n Day(s), Week(s) or
Month(s)
To run a job at the same time every n day(s), week(s) or month(s), perform the
following steps:
1. Click the Schedule tab on the corresponding window.
2. Configure the following parameters:

Figure 6-4:
Scheduling
options for
Every n
Day(s),
Week(s) or
Month(s)
recurrence
interval



Scheduling Type – Select the Repeating scheduling type.



Scheduling Options – Under Scheduling Options, configure the
following parameters:


Run At – In the Run At box, enter or select the start time for the job.



From – In the From box, enter or select the start date for the schedule.



Method – Under Method, select Every.



Options – In the Every box under Options, enter the interval. Select
Day(s), Week(s) or Month(s) in the frequency options.
For example,


To run a job on alternate days, enter 2 in the Every box and select
Day(s) in the frequency options.



To run a job every week, enter 1 in the Every box and select
Week(s) in the frequency options.



To run a job once in three months, enter 3 in the Every box and
select Month(s) in the frequency options.

Important: When you edit a job with Every n Day(s), Week(s) or Month(s)
schedule, you must reconfigure the start date according to the current date. If the
schedule is not updated, an instance will run immediately when you submit the job
definition
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6.4.4

Scheduling a Job to Run on Specific Days of Week
You can use this procedure to define the following types of schedules:


Run a job on every Wednesday



Run a job on every Wednesday and Friday



Run a job on second and fourth Wednesday



Run a job on second and fourth Wednesday and Friday

To establish a Days of Week recurrence pattern, perform the following steps:
1. Click the Schedule tab on the corresponding window.
2. Configure the following parameters:
Figure 6-5:
Scheduling
options for
based on the
days of week
recurrence
pattern



Scheduling Type – Select the Repeating scheduling type.



Scheduling Type – Under Scheduling Options, configure the following
parameters:


Run At – In the Run At box, enter or select the start time for the job.



From – In the From box, enter or select the start date for the schedule.



Method – Under Method, select Days of Week.



Options – Under Options, select the check boxes corresponding to
the day(s) on which you want to run the job.



Weeks in Month – Under Weeks in Month, select All to run the job
on any week. To run the job on nth week, choose Selected and clear
the check boxes for the weeks on which you do not want to run the job.
For example,


To run a job on every Wednesday, select Wednesday under
Options and All under Weeks in Month.



To run a job on every Wednesday and Friday, select Wednesday
and Friday under Options and select All under Weeks in Month.

NetVault: Backup
Administrator’ Guide


119

To run a job on the second and fourth Wednesday, select
Wednesday and Friday under Options and clear First, Third and
Last check boxes.

The first instance of the job is scheduled to run on the nth Wednesday
or Friday, whichever occurs first after you submit the job. The
subsequent instance will be scheduled when the current instance
becomes active.

6.4.5

Scheduling a Job to Run on Specific Days of Month
You can use this procedure to define the following types of schedules:


Run a job on the fifth of every month



Run a job on the first, tenth and twentieth of every month



Run a job on the last day of every month

To establish a Days of Month recurrence pattern, perform the following steps:
1. Click the Schedule tab on the corresponding window.
2. Configure the following parameters:
Figure 6-6:
Scheduling
options based
on days of
month
recurrence
pattern



Scheduling Type – Select the Repeating scheduling type.



Scheduling Options – Under Scheduling Options, configure the
following parameters:


Run At – In the Run At box, enter or select the start time for the job.



From – In the From box, enter or select the start date for the schedule.




Method – Under Method, select Days of Month.
Options – Under Options, select the check boxes corresponding to
the day(s) on which you want to run the job. To run the job on the last
day of every month, select the Last check box.
For example,


To run a job on the fifth of every month, select 5.
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To run a job on first, tenth and twentieth of every month, select 1, 10
and 20.



To run a job on the last day of every month, select the Last check
box.

The first instance of the job runs on the nth day of the month after the
schedule becomes effective. The subsequent instance will be
scheduled when the current instance becomes active.

6.5.0

Scheduling Non-Repeating Jobs
Jobs which are performed infrequently or at irregular intervals are called nonrepeating jobs. Although it is difficult to establish a definite repeating schedule for
these jobs, you may need to run them more than once. For the non-repeating jobs,
you can either create a new job definition each time, or use one of the following
types of non-repeating schedules:


Any day



Particular day(s) of week



Particular day(s) of month

NVBU automatically schedules the first instance when you submit the job
definition. However, the subsequent instances must be scheduled manually. This
can be done by creating an instance using an existing instance or job definition.
For details, refer to Submitting a New Instance for Non-Repeating Jobs on page
174.

6.5.1

Scheduling a Non-Repeating Job to Run on Any Day
To schedule non-repeating jobs to run on any day, perform the following steps:
1. Click the Schedule tab on the corresponding window.
2. Configure the following parameters:

Figure 6-7:
Scheduling
options for Any
Day nonrepeating
schedule



Scheduling Type – Select the Once scheduling type.
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Scheduling Options – Under Scheduling Options, configure the
following parameters:


Run At – In the Run At box, enter or select the start time for the job.



From – In the box next to Run At box, enter or select the start date for
the schedule.



Method – Under Method, select Any Day.

NVBU automatically schedules the first instance when you submit the job
definition. To run the job again, you must create an instance manually. For
details, refer to Submitting a New Instance for Non-Repeating Jobs on
page 174.

6.5.2

Scheduling a Non-Repeating Job to Run on Specific
Days of Week
You can use this procedure to define the following types of schedules:


Run a job on Wednesday (any week)



Run a job on Wednesday and/or Friday (any week)



Run a job on second or fourth Wednesday



Run a job on second or fourth Wednesday and/or Friday

To schedule non-repeating jobs to run on specific days of week, perform the
following steps:
1. Click the Schedule tab on the corresponding window.
2. Configure the following parameters:
Figure 6-8:
Scheduling
options for
Days of Week
non-repeating
schedule



Scheduling Type – Select the Once scheduling type.



Scheduling Type – Under Scheduling Options, configure the following
parameters:


Run At – In the Run At box, enter or select the start time for the job.



From – In the box next to Run At box, enter or select the start date for
the schedule.
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Method – Under Method, select Days of Week.



Options – Under Options, select the check boxes corresponding to
the day(s) on which you want to run the job.



Weeks in Month – Under Weeks in Month, select All to run the job
on any week. To run the job on nth week, choose Selected and clear
the check boxes for the weeks on which you do not want to run the job.
For example,


To run a job on Wednesday (any week), select Wednesday under
Options and All under Weeks in Month.



To run a job on a Wednesday and/or Friday (any week), select
Wednesday and Friday under Options and select All under
Weeks in Month.



To run a job on the second and/or fourth Wednesday, select
Wednesday under Options and clear First, Third and Last check
boxes.

NVBU automatically schedules the first instance to run on the nth
Wednesday or Friday after the schedule becomes effective. To run the
job again, you must create an instance manually. For details, refer to
Submitting a New Instance for Non-Repeating Jobs on page 174.

6.5.3

Scheduling a Non-Repeating Job to Run on Specific
Days of Month
You can use this procedure to define the following types of schedules:


Run a job on the fifth



Run a job on first, tenth and/or twentieth



Run a job on the last day of a month

To schedule non-repeating jobs to run on specific days of month, perform the
following steps:
1. Click the Schedule tab on the corresponding window.
2. Configure the following parameters:

NetVault: Backup
Administrator’ Guide

123

Figure 6-9:
Scheduling
options for
Days of Month
non-repeating
schedule



Scheduling Type – Select the Once scheduling type.



Scheduling Options – Under Scheduling Options, configure the
following parameters:


Run At – In the Run At box, enter or select the start time for the job.



From – In the From box, enter or select the start date for the schedule.




Method – Under Method, select Days of Month.
Options – Under Options, select the check boxes corresponding to
the day(s) on which you want to run the job. To run the job on the last
day of every month, select the Last check box.
For example,


To run a job on the fifth, select 5.



To run a job on first, tenth and/or twentieth, select 1, 10 and 20.



To run a job on the last day of a month, select the Last check box.

NVBU automatically schedules the first instance to run on the nth day
of the month after the schedule becomes effective. To run the job
again, you must create an instance manually. For details, refer to
Submitting a New Instance for Non-Repeating Jobs on page 174

6.6.0

Triggering a Job from an External Script
NVBU allows you to schedule a job by executing a script which defines the
conditions for the task. The most common use of creating a triggered job is to be
able to execute it independently of the NVBU Scheduler, such as via a 3rd-party
scheduler or an automation interface. You can run the script from the command
line. The job is not scheduled to run when you submit the job. Instead, it is
scheduled when the nvtrigger command runs during the script execution. To
schedule a job when the script runs, include the following line in the script:
nvtrigger <trigger_name>
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nvtrigger is a CLI command that resides in the .../bin directory (where ...
represents the NVBU installation directory). If this path in not configured in the
path variable, use the complete file path for the nvtrigger command, or include
commands to change to the appropriate directory in the script.
Alternatively, the script can be executed using the Pre and Post Scripts options
on the Advanced Options tab of the NVBU Backup window.
To trigger a job from an external script, perform the following steps:
1. Click the Schedule tab on the corresponding window.
2. Configure the following parameters:

Figure 6-10:
The option for
Triggered
scheduling
type



Scheduling Type – Select the Triggered scheduling type.



Scheduling Options – In the Trigger Name box under Scheduling
Options, enter trigger name that was used with the nvtrigger command
in the script file.

Note: If the trigger name is already in use by another job, a warning “The Trigger
Name is Already in Use. Redefine this Job if this was not Intended” will
appear when you try to save or submit the job. This is for information only and will
not stop you from saving or submitting the job.

6.7.0

Scheduling Number of Job Retries
NVBU allows you to configure the retry options for a job, which specify how many
attempts to make and at what intervals when an initial attempt to run the job fails.
Each retry attempt runs with the original Job ID and instance number. To schedule
the retry attempts for a job, perform the following steps:
1. Click the Schedule tab on the corresponding window.
2. Configure the following parameters:
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Figure 6-11:
The Job
Options on the
Schedule tab

6.8.0



Job Retries – Under Job Options, select the Job Retries check box.



Number of Retries – In the box next to the Job Retries check box, enter
or select the number of retries. You can set a maximum of 10 tries for a
job.



Retry After – In the Retry After boxes, enter or select the interval
between two retry attempts. By default, NVBU tries to run the job again
immediately after a previous attempt fails.

Setting the Job Priority
The Schedule Manager assigns a priority level for each job type, which is applied
globally to all backup, restore and report jobs. This parameter helps prioritize
resource allocation when two or more jobs are scheduled to run at the same time.
The default priority level for each job type is given below:
Job Type

Priority Level

Restore

20

Backup

30

Report

50

You can globally change the priority level settings for all backup, restore or report
jobs, or override these settings for an individual job. The global changes are
performed using the Schedule Manager tab on the NVBU Configurator. For
details on global priority settings, refer to the NetVault: Backup Configuration
Guide. To override the priority settings for an individual job, perform the following
steps:
1. Click the Schedule tab on the corresponding window.
2. Configure the following parameter:


Job Priority – In the Job Priority box under Job Options, enter or select
the priority level for the job. The priority level ranges from 1 (highest
priority) to 100 (lowest priority). A priority level of zero sets a job to run as
a background task.
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Chapter 7:

SELECTION SETS
This chapter explains how to create and use selection sets. The information in this
chapter is organized into the following topics:


Selection Sets – An Overview


7.1.0

Types of Selection Sets



Creating a Selection Set



Loading a Selection Set



Modifying a Selection Set



Copying a Selection Set



Deleting a Selection Set

Selection Sets – An Overview
Selection sets provide an efficient way to create job definitions. They store the job
properties which can be quickly and easily applied to multiple jobs, and changed
with minimum effort. Selection sets reduce the manual steps, allowing you to
create a new job or modify existing jobs in fewer steps. For example, you can save
the data selections for a Full Backup in a Backup Selection Set, and use this set
for creating an Incremental or a Differential Backup job. This eliminates the need
to select each item manually for a new job. At the same time, it also ensures that
the same set of files is backed up each time and no file is accidentally omitted.
Similarly, you can change the day, date or time in a Schedule Set to automatically
change the job schedule for multiple jobs, or target a new device for backups by
changing the Target Set.
Note: A policy-based backup can only be created using selection sets.

7.1.1

Types of Selection Sets
NVBU supports the following types of selection sets:
Selection Set Type

Description

Backup Selection Set

Saves a backup selection list. It can be created from the
Selections tab on the following windows:


NVBU Backup



NVBU Policy Editor
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Selection Set Type

Description

Backup Options Set

Saves the backup options. It can be created from the Backup
Options tab on the following windows:

Schedule Set

Source Set

Target Set

Advanced Options Set

Restore Selection Set



NVBU Backup



NVBU Policy Editor

Saves the scheduling options for a backup, restore or report
job. It can be created from the Schedule tab on the following
windows:


NVBU Backup



NVBU Policy Editor



NVBU Restore



NVBU Reporting Job Editor

Saves the source drive options, which specify where the
source media for a Data Copy, Consolidate Incremental
Backups or Restore job is located. It can be created from the
Source tab on the following windows:


NVBU Backup (Data Copy and Consolidate Incremental
Backups plugins)



NVBU Policy Editor



NVBU Restore

Saves the target drive and media options for a backup job,
which specify the device and media to use to store a backup.
It can be created from the Target tab on the following
windows:


NVBU Backup



NVBU Policy Editor

Saves the advanced options for a backup or restore job. It can
be created from the Advanced Options tab on the following
windows:


NVBU Backup



NVBU Policy Editor



NVBU Restore

Save a restore selection list. It can be created from the
Selections tab on the following window:


NVBU Restore
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Creating a Selection Set
To create a selection set, perform the following steps:
1. Depending on your task, open the corresponding NVBU window:
a. Regular Backups
1. Click Backup on the toolbar or Large Buttons panel. Alternatively, on
the Operations menu, click Backup.

Figure 7-1:
Backup
Selection Set
options
displayed at
the bottom of
NVBU Backup
window

b. Policy Backups
1. Click Policy Management on the toolbar or Large Buttons panel to
open the NVBU Policy Management window. Alternatively, on the
Administration menu, click Policy Management.
2. Click New Policy on the toolbar. Alternatively, on the File menu, click
New Policy.
3. In the NVBU Policy Editor window, click Manage Sets to open the
NVBU Set Management window.
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Figure 7-2:
NVBU Set
Management
window

c. Restore Jobs
1. Click Restore on the toolbar or Large Buttons panel. Alternatively, on
the Operations menu, click Restore.
d. Report Jobs
1. Click Reports Management on the toolbar or Large Buttons panel to
open the NVBU Reports Management window. Alternatively, on the
Operations menu, click Reports.
2. Click Report Job on the toolbar. Alternatively, on the Reports menu,
click Report Job.
2. Click the corresponding tab.
3. Select the required data, or configure the required options. For details on data
selection and job options, refer to the relevant section in this guide or the
APM/Plugin User’s Guide.
For example, to create a backup selection set, click the Selections tab on the
NVBU Backup window, and select the data for backup. To create a schedule
set, configure the scheduling options on the Schedule tab.
4. Click Save As under <Set Type> Set at the bottom of the tab.
5. In the Save <Set Type> Set window, enter a unique name for the set in the
box provided.
6. Click OK.
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Loading a Selection Set
To load a selection set, perform the following steps:
1. Open the NVBU Backup, NVBU Restore or NVBU Set Management
window. For details, refer to step 1 in the section Creating a Selection Set on
page 129.
2. Click the corresponding tab.
3. Click Load under <Set Type> Set at the bottom of the tab.

Figure 7-3:
Load Backup
Selection Set
window

4. Select the required set in the Load Backup Selection Set list.
5. Click OK to apply the selections to the current job.
If you modify the selection set any time later, the new settings are applied
automatically to all jobs that use the set.

7.4.0

Modifying a Selection Set
To modify a selection set, perform the following steps:
1. Open the NVBU Backup, NVBU Restore or NVBU Set Management
window. For details, refer to step 1 in the section Creating a Selection Set on
page 129.
2. Click the corresponding tab.
3. Click Load under <Set Type> Set at the bottom of the tab.
4. Select the required set in the Load <Set Type> Set list.
5. Click OK. This will load the saved settings.
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6. Click Modify under <Set Type> Set at the bottom of the tab.
7. In the NetVault Warning window, click Modify.
8. Update the settings as required.
9. Click Save As under <Set Type> Set at the bottom of the tab.

Figure 7-4:
Save Backup
Selection Set
window

10.To overwrite the loaded set, click OK in the Save <Set Type> Set window. To
save the selections to a new set, enter a name in the box and click OK.

7.5.0

Copying a Selection Set
To copy the selections to a new set, perform the following steps:
1. Open the NVBU Backup, NVBU Restore or NVBU Set Management
window. For details, refer to step 1 in the section Creating a Selection Set on
page 129.
2. Click the corresponding tab.
3. Click Load under <Set Type> Set at the bottom of the tab.
4. Select the required set in the Load <Set Type> Set list.
5. Click OK. This will load the saved settings.
6. Click Modify under <Set Type> Set at the bottom of the tab.
7. In the NetVault Warning window, click Copy.
8. Change the settings, if required.
9. Click Save As under <Set Type> Set at the bottom of the tab.
10.In the Save <Set Type> Set window, enter a new name for the set in the box
provided.

NetVault: Backup
Administrator’ Guide

133

11. Click OK.

7.6.0

Deleting a Selection Set
To delete a selection set, perform the following steps:
1. Open the NVBU Backup, NVBU Restore or NVBU Set Management
window. For details, refer to step 1 in the section Creating a Selection Set on
page 129.
2. Click the corresponding tab.
3. Click Load under <Set Type> Set at the bottom of the tab.
4. Select the required set in the Load <Set Type> Set list.
5. Click OK. This will load the saved settings.
6. Click Modify under <Set Type> Set at the bottom of the tab.
7. In the NetVault Warning window, click Modify.
8. Click Delete under <Set Type> Set at the bottom of the tab.
9. In the confirmation window, click Yes.
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Chapter 8:

POLICY MANAGEMENT
This chapter describes how to create and manage backup policies. The
information in this chapter is organized into the following topics:






8.1.0

Backup Policies – An Overview


Examples



Supported Plugins

Creating a Backup Policy


Creating Selection Sets for a Policy Backup



Defining Jobs for a Policy Backup



Adding Clients or Client Groups for a Policy Backup



Finalizing and Submitting a Policy

Available Policy Views


Changing the Policy View



Policy Status Indicators



Setting up User-Defined Notification Events for a Policy Job



Editing an Inactive Policy



Editing an Active Policy



Modifying Individual Policy Jobs



Modifying Policy Client List



Acknowledging Errors/Warnings



Deleting a Policy

Backup Policies – An Overview
Policies provide a convenient method for implementing backup strategies and
managing backup jobs. A policy contains one or more job definitions. The job
definitions are created using selection sets which specify what data is to be
backed up, the target device and media, job schedule and other job attributes. You
can apply these definitions to multiple Clients or Client Groups.
You can use policies in numerous scenarios, such as the following:


Implement a Full and Incremental/Differential backup strategy



Rotate media



Backup multiple Clients in a single job
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Perform Incremental backups and Consolidate Incremental Backups



Run Data Copy jobs on multiple Clients

Policies are managed from the NVBU Policy Management window on the
Console.

8.1.1

Examples
The following examples outline the procedure for creating some basic policy
backups:
Example 1 – Procedure for creating a policy to backup the C drive on multiple
Windows Clients
1. Create a Client Group and add the target Clients as group members.
2. Create selection sets for Backup Selection, Backup Options, Schedule,
Target and Advanced Options.
3. Create a policy and add a job using these selection sets.
4. Add the Client Group to the job.
NVBU automatically creates and schedules a job to run on each Member
Client.
Example 2 – Procedure for implementing a media rotation policy for daily
Incremental Backups, and weekly and monthly Full Backups:
1. Create a Backup Selection Set.
2. Create Backup Options Sets for Full and Incremental backups.
3. Create Schedule Sets for Full and Incremental backups.
4. Create Target Sets depending on your media rotation strategies.
5. Create Advanced Options Sets defining the backup retention period (and
other advanced backup options).
6. Create a policy and define jobs for daily, weekly and monthly backups using
these selection sets.

8.1.2

Supported Plugins
The following NVBU plugins support policy-based backups:


File System Plugin



Consolidate Incremental Backups Plugin



Data Copy Plugin



NetVault Databases Plugin
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Creating a Backup Policy
The procedure for creating a backup policy can be broadly divided into the
following steps:

8.2.1



Creating Selection Sets for a Policy Backup



Defining Jobs for a Policy Backup



Adding Clients or Client Groups for a Policy Backup



Finalizing and Submitting a Policy

Creating Selection Sets for a Policy Backup
Backup Policies are created using Selection Sets. You can use the existing
selection sets or create new sets from the NVBU Set Management window. For
details on creating a new selection set, refer to Creating a Selection Set on page
129.

8.2.2

Defining Jobs for a Policy Backup
A policy can contain one or more jobs. To create these job definitions, perform the
following steps:
1. If the NVBU Policy Editor window is not open, perform the following steps:
a. Click Policy Management on the toolbar or Large Buttons panel to open
the NVBU Policy Management window. Alternatively, on the
Administration menu, click Policy Management.
b. Click New Policy on the toolbar. Alternatively, on the File menu, click
New Policy.
2. In the Policy box, enter a name for the policy.
3. In the Job Name box, enter a title for the job.
4. To display only the selection sets created for the File System Plugin, select
File System in the Selection Set Filter. By default, NVBU displays all
selection sets.
5. In the Selections list, select the Backup Selections Set for the job.
6. In the Selection Options list, select the Backup Options Set for the job.
7. In the Target list, select the Target Set for the job.
8. In the Source list, select the Source Set for the job. A source set can only be
used for Data Copy, Consolidated Incremental Backups and Restore jobs.
9. In the Schedule list, select the Schedule Set for the job.
10.In the Advanced Options list, select the Advanced Options Set for the job. If
the Advanced Options set contains pre and/or post script options, copy the
script files to the …/scripts directory on each Client included in the policy
backup.
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Figure 8-1:
NVBU Policy
Editor window

11. To schedule the job when you save the policy, leave the Job Active check
box selected. To save the policy without scheduling the job, clear the Job
Active check box.
12.To add another job, click Next Job. Otherwise, go to step 15.
13.In the NetVault - Information window, click Yes.
14.Perform steps 3–11.
15.Add the Clients and/or Client Groups as described in the following section.

8.2.3

Adding Clients or Client Groups for a Policy Backup
Before starting this step, create the necessary Client Groups in order to implement
the policy on multiple Clients. For details on creating a Client Group, refer to
Creating Client Groups on page 32. To add Clients/Client Groups for policy
backups, perform the following steps:
1. In the NVBU Policy Editor window, click Add Clients on the toolbar to open
the NVBU Policy Clients Manager window.
Alternatively, on the Policy menu, click Add/Remove Clients.
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Figure 8-2:
NVBU Policy
Clients
Manager
window

2. Under Available, you will find a list of NVBU Clients and Client Groups. To
add a Client or Client Group, click the corresponding check box, and then
click the Left Arrow. The selected Clients and Client Groups will now be listed
under Selected.
3. To remove an added Client or Client Group, click the check box for it under
Selected, and then click the Right Arrow.
4. Click OK to complete the step.

8.2.4

Finalizing and Submitting a Policy
To complete and submit the policy definition, perform the following steps:
1. To raise any events for failed jobs or jobs completed with warnings, refer to
Setting up User-Defined Notification Events for a Policy Job on page 141.
2. To save the policy, click Save Policy on the toolbar. Alternatively, click Save
Policy on the File menu.
When you save a policy, all jobs that have the Job Active check box selected are
scheduled to run on the selected Clients/Client Groups.

8.3.0

Available Policy Views
NVBU provides the following Policy Views to view policy jobs:


Domain View
This is the default view type. The Domain View organizes the policies
according to the Client Groups or Individual Clients targeted by an individual
policy. The Domain Controller node is displayed at the top.
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Figure 8-3:
Domain View



Policy View
The Policy View lists the target clients and the job definitions beneath the
policy nodes.

Figure 8-4:
Policy View



Client View
The Client View displays the policies defined for individual clients.

Figure 8-5:
Client View

Each view allows you to perform similar functions. However, certain functions like
deleting a schedule or quiescing a policy can only be performed from the Policy
View. To view the policy details navigate through the Policy Tree under Policies.
To open any node in this tree, double-click it, or right-click and select Open. To the
left of each node, a status indicator displays the status of policy jobs. The nodes
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with active jobs are displayed in blue text, with the parent node displaying the
count for active jobs (e.g., 2 Active Jobs). The list of completed, scheduled and
active jobs is displayed under Details.

8.3.1

Changing the Policy View
The default view type is Domain View. To change the view, select the view type in
the View list.

8.3.2

Policy Status Indicators
Each node under Policies is accompanied by a status indicator, which displays
the status of a policy, client or individual jobs. The policy tree includes the following
status indicators:
A Green icon indicates that the corresponding job has completed
successfully. For the Policy and Client nodes, it indicates that all the jobs
for the policy or client have completed successfully.
An Orange icon indicates that the corresponding job has completed with
warnings. For the Policy and Client nodes, it indicates that some of the
jobs for the policy or client have completed with warnings.
A Red icon indicates that the corresponding job has failed. For the Policy
and Client nodes, it indicates that some of the jobs for the policy or client
have failed.
The purpose of status indicators is to help administrators identify a failed job or a
job completed with warnings, and take corrective action. Therefore, a red icon
accompanies the parent node to indicate a problem even if one job fails while all
others complete successfully.

8.4.0

Setting up User-Defined Notification Events for
a Policy Job
To raise a user-defined notification event when a policy job fails or completes with
warnings, perform the following steps:
1. Open the Policy Events window as described in the following steps:
a. For a new job, click Setup Events on the toolbar for the NVBU Policy
Editor window. Alternatively, click Events on the Policy menu.
b. For an existing policy, perform the following steps:
1. Open the NVBU Policy Management window.
2. Choose any view.
3. Open the nodes further to display the target policy node.
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4. Right-click this node and select Policy Events.
2. In the Policy Events window, configure the following parameters:

Figure 8-6:
Policy Events
window



Raise Event if Policy has Warnings – To raise an event when a job
completes with warnings, select the Raise Event if Policy has Warnings
check box.



Raise Event if Policy Fails – To raise an event when a job fails, select
the Raise Event if Policy Fails check box.



Event Name – In the list next to the selected check box, select the custom
event. If no custom events are defined, the list will be empty. To define a
new event, enter the event name in the box.

3. To set the notification method for a new event, first save the policy. Click
Save Policy on toolbar, or on the File menu, click Save Policy. For details
on setting a global notification method, refer to Setting up a Global
Notification Method on page 189, and for details on setting a user-specific
notification method, refer to Setting a User Notification Profile on page 200.

8.5.0

Editing an Inactive Policy
A policy for which no jobs are currently active is termed as an Inactive Policy. To
edit an inactive policy, perform the following steps:
1. Load the policy definition in the NVBU Policy Editor window using one of the
following methods:
a. Method 1
1. Open the Policy Management window.
2. On the Edit menu, click Edit Policy
3. In the Load Policy window, select the target policy and click OK.
b. Method 2
1. Open the Policy Management window.
2. Choose any view.
3. Open the nodes further to display the target policy node.
4. Right-click this node and select Edit.
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2. For details on adding a new job, refer to Defining Jobs for a Policy Backup on
page 137.
3. To delete a job, perform the following steps:
a. Load the job definition in the NVBU Policy Editor window. Use the Next/
Previous buttons to navigate.
b. Click Delete Job on the toolbar. Alternatively, on Policy menu, click
Delete Job.
4. To edit a job definition, perform the following steps:
a. Load the job definition in the NVBU Policy Editor window. Use the Next/
Previous buttons to navigate.
b. Click Manage Sets on the toolbar to modify the selection set. For details
on modifying a selection, refer to Modifying a Selection Set on page 131.
To apply a different selection set, choose the set in the Selection Set list.
5. For details on adding or removing a Client/Client Group, refer to Adding
Clients or Client Groups for a Policy Backup on page 138.
6. For details on setting up user-defined notification events, refer to Setting up
User-Defined Notification Events for a Policy Job on page 141.
7. To commit the changes, click Save Policy on the toolbar. Alternatively, click
Save Policy on the File menu.
To create a copy of the policy, enter a new name for the policy in the Policy
box, and on the File menu, click Save Policy As.

8.6.0

Editing an Active Policy
A policy for which the jobs are currently running is termed as an Active Policy. To
edit an active policy you must first quiesce the policy. A quiesced state is a
temporary inactive/disabled state. To quiesce a policy, run the Quiesce command.
While quiescing is in progress, NVBU performs the following tasks:


Deletes all the scheduled instances for the policy jobs



Completes the job(s) that are in progress



Completes phase 2 (e.g., a Secondary Copy job) for the job(s) in progress

Although cloning is supported during this operation, the actual policy can be
modified only when the operation completes and the policy is in a quiesced state.
To modify an active policy, perform the following steps:
1. Open the NVBU Policy Management window.
2. In the View list, select Policy View.
3. Open the nodes further to display the target policy node.
4. Right-click the node and select Quiesce. While the operation is in progress,
the text Quiescing is displayed beside the policy name.
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5. NVBU deletes the scheduled instances, and completes the phase 1 and
phase 2 for the active job(s). When these tasks complete, NVBU places the
policy in a quiesced state. This state is indicated by the text Quiesce
Complete next to the policy name. When the quiescing is completed, you
can right-click the policy and select Edit.
6. To modify the policy, perform steps 2–7 described in the section Editing an
Inactive Policy on page 142.

8.7.0

Modifying Individual Policy Jobs
NVBU provides another simpler method to modify a policy job that is currently not
active. To accomplish this task, perform the following steps:
1. Open the NVBU Policy Management window.
2. In the View list, select Policy View.
3. Open the nodes further to display the target policy node.
4. Open the policy node. Then, open the Job Definition node and the target
job. The selection sets used to define the job are displayed under this node.
5. To edit a selection set, right-click the set name and select Manage Sets.
6. This opens the NVBU Set Management window. Make the required changes
and save the set. For details on modifying a selection set, refer to Modifying a
Selection Set on page 131.
The scheduled instance for the job is modified when you save the set.

8.8.0

Modifying Policy Client List
To add or remove Clients/Client Groups for a policy, you can also use the following
method.
1. Open the NVBU Policy Management window.
2. In the View list, select Policy View.
3. Open the nodes further to display the target policy node.
4. Right-click the node and select Implement on Clients. This opens the NVBU
Policy Clients Manager window.
5. To add a Client or Client Group, click the check box for it, and then click the
Left Arrow. The selected Clients and Client Groups are now listed under
Selected.
6. To remove an added Client or Client Group, click the check box for it under
Selected, and then click the Right Arrow.
7. To save the changes, click OK.
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Acknowledging Errors/Warnings
The purpose of the status indicators is to help administrators identify a failed job or
a job completed with warnings, and take corrective action. When this is
accomplished you can acknowledge the error/warning to clear them. To clear the
errors/warnings, perform the following steps:
1. Right-click the corresponding policy node and select Acknowledge Errors/
Acknowledge Warnings. To acknowledge errors within multiple policies,
right-click the parent node. For example, right-click the Policies node in the
Policy View and select Acknowledge Errors/Acknowledge Warnings.
2. NVBU clears the errors/warnings and replaces the red/orange status
indicator with a green status indicator.

8.10.0

Deleting a Policy
You can use the procedure in this section only if the policy has no active jobs or
the policy is in a quiesced state. For details on quiescing a policy, refer Editing an
Active Policy on page 143. To delete a policy, perform the following steps:
1. Open the NVBU Policy Management window.
2. In the View list, select Policy View.
3. Open the nodes further to display the target policy node.
4. Right-click the node and select Delete.
5. In the confirmation window, click Yes.
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Chapter 9:

RESTORE
This chapter describes how to use NVBU to restore and recover your data. The
information in this chapter is organized into the following topics:


Restore – An Overview



Restoring Data with NVBU Plugins



Creating a Restore Job



Configuring Source Device for Restore



Configuring the Advanced Restore Options


Using Pre and Post Restore Scripts



Enabling Network Compression



Restoring Data to an Alternate NVBU Client



Restoring from a Saveset with Offline Indexes



Restoring from a Saveset with Compressed Indexes



Restoring an Encrypted Saveset



Additional Features Available on the Selections Tab





Sorting the Savesets



Filtering the Savesets



Searching for Data Items



Viewing Media List for a Saveset

Additional Considerations


9.1.0

Restores on Itanium Platforms

Restore – An Overview
Restore refers to reconstructing all or part of a system from a backup. A restore
can be performed for the following reasons:


To recover lost data (e.g., a file that was accidentally deleted)



To recover database/files which have been corrupted



To copy or move data to another database/directory



To recover to a previous point-in-time, if some operation goes wrong



To migrate data when upgrading to a new system



To copy or move data to a test/production server



To recover from media failure, O/S corruption, loss of physical system
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The NVBU plugins interface with the native APIs to restore and recover
application-specific data from the backup savesets. The restore methods and
options provided by these plugins vary depending on the application type. In
general, NVBU offers the following restore features:

9.2.0



Complete or granular restores



Disaster recovery



Restores to alternate location



Restores to alternate server

Restoring Data with NVBU Plugins
Restores are performed from the Restore window. You can use the Console
running on the NVBU Server or any Client to define and submit the restore job.
A restore job definition generally consists of the following components:


Selection list



Plugin-specific restore options



Source device options which specify where the source media is located



Target Client name, when restoring to an alternate server



Job schedule



Advanced restore options

Each component contains a set of attributes which can be configured manually or
using a selection set. For details on selection sets, refer to Selection Sets on page
127.
Each job has a Job ID and a title. The Job ID is a sequential number which is autogenerated. The job title is user-defined and allows you to easily identify the job
when monitoring its progress or viewing the job logs.

9.3.0

Creating a Restore Job
To create a restore job, perform the following steps:
1. Click Restore on the toolbar or Large Buttons panel to open the NVBU
Restore window. Alternatively, on the Operations menu, click Restore.
2. On the Selections tab, open the Client that was the source of the backup. To
open any node in the Selections tab, you can do either of the following:


Double-click the node



Right-click the node and select Open
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Figure 9-1:
NVBU
Restore
window

3. Select the plugin that was used to backup the data.
4. Open the target saveset and then select the data you want to restore. The
selection tree varies for different plugins. Refer to the relevant APM/Plugin
User's Guide for more information on selecting data for a restore.
5. Click the Restore Options tab and configure the run-time parameters for the
job. These options are plugin-specific. Refer to the relevant APM/Plugin
User's Guide for more information on specific restore options.
6. Click the Source tab and configure the source device options. For details,
refer to Configuring Source Device for Restore on page 150. You can omit
this step if you want NVBU to automatically handle the device selection.
7. Click the Schedule tab and configure the scheduling options. For details,
refer to Job Scheduling on page 113. You can omit this step if you want to run
the job immediately, which is the default schedule for all NVBU jobs.
8. Click the Advanced Options tab and configure the advanced options for the
job. For details, refer to Configuring the Advanced Restore Options on page
151. You can omit this step if you do not want to set any advanced options.
9. Enter a title for the job in the Job Title box at the top right corner of the
Restore window.
10.Click Submit on the toolbar. Alternatively, on the Accept menu, click Submit
Restore.
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9.4.0

Configuring Source Device for Restore
NVBU allows you to select the source device where the backup is stored. You can
use this option to enforce local data transfers on a SmartClient. This option is also
useful if a backup was performed to an NVSD Device or a VTL, and then copied to
a tape. It can be used to restore the data from the NVSD or VTL to speed up the
restore or if the tape has already been moved off-site. To specify the source device
for a restore, perform the following steps:
1. In the NVBU Restore window, click the Source tab.
2. To use only locally attached devices, select the Local Drives Only under
Device Options.
3. To use any device added to the NVBU Server, select Any Device under
Device Options.
4. To use particular device(s), select Specify Device under Device Options.
In the box below, all the devices added to the NVBU Server are listed. Since
NVBU is configured to automatically select a backup device, all the devices in
the list are selected by default. To exclude devices, perform the following:

Figure 9-2:
Source tab on
NVBU Restore
window



To exclude a particular library, clear the check box for it. All the drives
associated with the device are automatically removed when you remove
the library.



To exclude a particular drive, clear the check box for it.
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Configuring the Advanced Restore Options
This section describes how to configure the advanced options for a restore job.
The information in this section is organized into the following topics:


Enabling Network Compression



Using Pre and Post Restore Scripts

Figure 9-3:
Advanced
Options tab on
NVBU Restore

9.5.1

Enabling Network Compression
While transferring data over the network, you can compress the data to reduce the
bandwidth usage. Data is first compressed on the NVBU Server or SmartClient to
which the source device is attached before it is transferred over the network. On
the target NVBU Client, the data is de-compressed before it is restored. Note that
network compression does not work for the following types of jobs:


Restores from NVSD Devices.



Restores from devices attached to NAS Filers.



Jobs using the NDMP Plugin, NetWare Thin Client Plugin or the NetVault:
Backup Bare Metal Recovery.

To enable network compression for a restore job, perform the following steps:
1. In the NVBU Restore window, click the Advanced Options tab.
2. Under Compression, select the Network Compression check box.
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9.5.2

Using Pre and Post Restore Scripts
NVBU provides the pre and post restore scripts feature, which allows you to run
your own scripts at the start and/or completion of a restore job. These scripts can
be used to perform tasks, such as shutting down a database before starting the
job, or starting the database after the job completes. Consider the following points
when using the pre and post restore scripts feature:


The script must be an executable file, for example, .bat on Windows, or .sh
on Linux/UNIX.



The scripts can contain run-time parameters. Use the NVBU environment
variable NV_USER_ARG to access the values for these parameters in the
script.



You can also use other NVBU environment variables in the script. For details
on environment variables, refer to NVBU Environment Variables on page
269.



After creating the script, copy it to the …\scripts folder on the target Client.
You can also create sub-folders to organize the scripts.



If a pre script fails, the restore job fails.



If the pre script completes successfully while the restore job fails, the post
script is still executed; the job status is reported as Restore Failed.



If the pre script and the restore complete successfully while the post script
fails, a script error is logged; the job status is reported as completed with
warnings.



By default, NVBU provides the following two scripts that can be run as post
restore scripts:


psmail – This scripts emails the job completion status to the addresses
passed as user parameter.



psmail_logs – This script emails the job completion status and the job
logs to the addresses passed as user parameter.

To run pre and post scripts for a restore job, perform the following steps:
1. In the NVBU Restore window, click the Advanced Options tab.
2. Under Pre and Post Scripts, select the following options:
a. To run a script before the job starts, select Use Pre Script.
b. To run a script after the job completes, select Use Post Script.
3. Enter the script file name in the box next to the selected check box. If the
script resides in the …\scripts folder, just enter the file name. Whereas, if it
resides in a sub-folder within the …\NVBU\scripts folder, enter the relative
path (e.g., if the script file myscript.bat resides in the folder ...\scripts\tst,
enter \tst\myscript.bat in the box).
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4. To pass run-time parameters, enter the value in the User Parameter box.
The value must be valid and conform to its usage in the script. NVBU does
not perform any validity checks on the user parameter.

9.6.0

Restoring Data to an Alternate NVBU Client
Restoration to an alternate NVBU Client is typically required in disaster recovery
scenarios or when copying data to a production or test server. The target NVBU
Client selection is done on the Target Client tab of the NVBU Restore window.
Although all NVBU plugins support this feature, the actual implementation varies
for each. Refer to the relevant APM/Plugin User's Guide for the complete
procedure.

9.7.0

Restoring from a Saveset with Offline Indexes
To browse or restore from a saveset with offline indexes, you must first re-load the
indexes temporarily. To accomplish this, perform the following steps:
1. Open the NVBU Restore window.
2. On the Selections tab, open the Client that was the source of the backup.
3. Open the plugin that was used to create the saveset.
4. Right-click the target saveset and select Load Index.
5. In the Days to Keep Index box, enter the number of days you want to retain
the index in the NVDB.

Figure 9-4:
Days to Keep
Index window

6. Click OK.

9.8.0

Restoring from a Saveset with Compressed
Indexes
NVBU automatically de-compresses the index when you open a saveset with
compressed indexes. The index is copied to a temporary directory which is
automatically deleted when the operation completes. You can also de-compress
the indexes manually. To de-compress an index manually, perform the following
steps:
1. Open the NVBU Restore window.
2. On the Selections tab, open the Client that was the source of the backup.
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3. Open the plugin that was used to create the saveset.
4. Right-click the target saveset and select Uncompress.

9.9.0

Restoring an Encrypted Saveset
No additional steps are required to restore an encrypted backup. However, before
you start the restore procedure, ensure that the Encryption Plugin is installed and
configured on the target Client. For detail on installing and configuring the
Encryption Plugin, refer to NetVault: Backup Encryption Plugin Guide.

9.10.0

Additional Features Available on the Selections
Tab
This section provides a brief description of the additional features present on the
Selections tab of the NVBU Restore window. These features are common to all
NVBU plugins.

9.10.1

Sorting the Savesets
By default, the savesets on the Selections tab are sorted by the Plugin used to
generate them. To change the sort order for the savesets, perform the following
steps:
1. Click the Selections tab.
2. In the Selection Method list, select the sort criteria:

9.10.2



Backup Set – To sort the savesets by the Selection Set used for the
backup, select Backup Set.



Job – To sort the savesets by the Job Title, select Job in the Selection
Method list.



Plugin – To change the sort order back to Plugin, select Plugin in the
Selection Method list

Filtering the Savesets
To filter the savesets displayed on the NVBU Restore tab, perform the following
steps:
1. Click the Selections tab.
2. Under Filter Options, set the filter criteria as described below:


By Date Range – Select the By Date Range check box, and enter or
select the From and To dates in the boxes provided to list the savesets
generated during the specified period.



Show On-line Status – Select the Show On-line Status check box to list
the savesets stored on the currently online media.
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3. Click Apply Filter to set the filter.

9.10.3

Searching for Data Items
The Search feature on the NVBU Restore window allows you to find a particular
file or data item inside a saveset without opening it or browsing through contents.
You can use either the entity name or a regular expression to find the entities.
Typically, you can perform a search at the plugin level to find which saveset
contains the entity, or at the saveset level to determine whether the entity is
included in a particular saveset. However, NVBU allows you to use this feature at
any level in the restore selections tree.
To use the Search feature, perform the following steps:
1. On the Selections tab, right-click the Client and select Search. If you want to
perform a search at the plugin level or saveset level, open the nodes further.
Right-click the plugin node or the target saveset node, and select Search.
This opens the Restore Search window.

Figure 9-5:
Restore
Search
window

2. Enter the search string in the box provided.
3. To search for entities using regular expression, select the Regular
Expression Search check box.
4. To match case during search, select Case Sensitive check box.
5. Click Search to begin the search and display the matching records.

9.10.4

Viewing Media List for a Saveset
To view the media list for a saveset, perform the following steps:
1. On the Selections tab, open the Client that was the source of the backup.
2. Open the plugin that was used to backup the data.
3. Right-click the target saveset and select Media List.
4. In the <Job Title> (Saveset #) window the following details are displayed:
the total backup size, the list of media used to backup data, the total bytes
written to the media, the media status, details of the media containing the
backup index.
5. Click OK to close the window.
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9.11.0

Additional Considerations
Refer to the following notes when restoring data with NVBU.

9.11.1

Restores on Itanium Platforms
Attempting to restore an index larger than 2GB may result in a failed restore on
Itanium platforms. If a restore fails with the error message Failed when sorting
items to restore, you will need to manually increase the stack size by using one
of the following methods:


On standard Unix platforms, this can be resolved by editing the ulimit (-s
option) in the CLI Terminal to increase the stack size. Open a CLI Terminal
and utilize the following commands:


ulimit -a provides all the settings for the environment



ulimit -s provides the current stack size setting



ulimit -s unlimited sets an unlimited stack size



ulimit -s n (where n is the desired value) sets stack size to n.



man ulimit provides for more details on the ulimit command

After modification, issue the ulimit -a command to ensure that the setting has
been changed.


On a HP-UX Itanium platform the bash command kmtune or kctune
(depending on the operating system) can be used to access to the kernel
stack size information. The stack vars are maxssiz for 32-bit applications and
maxssiz_64bit for 64-bit applications. Open a CLI Terminal and utilize the
following commands


kmtune -l -q maxssiz provides the verbose setting information for a 32-bit
application



kmtune -l -q maxssiz_64bit provides the verbose setting information for
a 64-bit application



kmtune -u -s maxssiz=n (where n is the desired value) sets the new
stack size to n for a 32-bit application



kmtune -u -s maxssiz_64bit =n (where n is the desired value) sets the
new stack size to n for a 64-bit application



kmtune -u -s maxssiz+n (where n is the desired value) increases the
stack size by n for a 32-bit application



kmtune -u -s maxssiz_64bit +n (where n is the desired value) increases
the stack size by n for a 64-bit application

Note that all instances of kmtune should be replaced by kctune depending
on the operating system. Issue the man command in a CLI terminal for
details.
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Chapter 10:

MEDIA MANAGEMENT
This chapter describes how to perform the media administration tasks. The
information in this chapter is organized into the following topics:

10.1.0



Backup Media – An Overview



Labeling and Grouping Media



Performing Bulk Media Labeling and Grouping



Viewing Media Status



Write-protecting Media



Retiring Backup Savesets



Marking Media for Re-use



Scanning Foreign Media



Tracking Offsite Location



Marking Media as Unusable



Removing a Backup Index from the NVDB



Blanking Media



Performing Bulk Media Blanking

Backup Media – An Overview
Backup media store the backup savesets. Each piece of media, whether a tape
cartridge or a VTL, must have an on-tape label for identification. NVBU supports
the following types of labels for a piece of media:


Media barcode



A system-generated string consisting of the NVBU Server Name, Date and a
Seed Number



A user defined string

Important: Backups to NVSD Devices are stream-oriented. The media concept
does not apply to an NVSD Device.
NVBU provides the following ways to label a blank piece of media:


Automatically label a blank piece of media during backup



Label an individual piece of media before it is used



Label all media items in a library in bulk



Set barcode as media labels by default
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While labeling a piece of media during a backup, NVBU uses the systemgenerated string as the default label. You can configure NVBU to use the media
barcodes as the default labels, instead. For details on this configuration
procedure, refer to NetVault: Backup Configuration Guide. To target the same set
of tapes for backup, you can create media groups. The media groups can be used
in conjunction with the re-use feature to rotate the media for Full and Incremental
backups according to your media rotation policy. Additionally, you can use NVBU’s
media management tools to write-protect media, eliminate unusable media, and
track the off-site location of a piece of media.

10.2.0

Labeling and Grouping Media
To label a piece of media and add it to a media group, perform the following steps:
Note: Only the Group Label parameter is available NVSD Devices.
1. Open the NVBU Device Management window.
2. On the Devices tab right-click the drive/slot that contains the media, and
select Properties.
3. Configure the following parameters in the Media Properties window:

Figure 10-1:
Media
Properties
window



Media Label – NVBU provides two default labels for media – the Media
Barcode, and a system-generated string of NVBU Server Name, Date and
a Seed Number. To assign one of these as the media label, select it in the
Media Label list. To assign a user defined label, enter the string in the box



Group Label – To add the piece of media to a group, select the group
label in the Group Label list. To create a new group and add the piece of
media to it, enter the group label in the box.



Tape Format – To set a non-default tape format, select MTF (on
Windows) or CPIO (on Linux/UNIX) in the Tape Format list.

4. Click OK.
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Performing Bulk Media Labeling and Grouping
To bulk label and/or group the media items in a library, perform the following steps:
Note: Bulk media labeling and grouping does not apply to an NVSD Device.
1. Open the NVBU Device Management window.
2. On the Devices tab, right-click the target library, and select Bulk Label to
open the Bulk Label Media window.

Figure 10-2:
Bulk Label
Media window

3. Under Type of Media to Label, select the media type from the following
categories:


Blank – Select this check box to label any blank, non-labeled piece of
media in a device that is currently accessible to the NVBU Server.



Other – Select this check box to bulk label media types that do not belong
to any category listed here.



NetVault 5 – Select this check box to label any piece of media that was
used to backup data with NVBU v5.x.



Reusable – Select this check box to label a piece of media marked as
reusable.

4. Under Type of Label, select one of the following:


Barcode – Select this option to use the barcode as media label.



Machine and Date – Select this option to use NVBU Server name and
date as the label.
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User – For a user-defined label, select User and enter the following
details:


Label – Enter the string to be used as media label. NVBU does not
support a % character in the string.



Seed – In addition to the string, a sequential number is also added to
the media label for unique identification. Enter the starting number for
the sequence in the Seed box. The number will be incremented for
each media. If the box is left blank, NVBU will start numbering the
media from 1. The Seed does not apply to VTL media.

5. To add the media items to a group, select the group label in the Group Label
list or enter the name for a new group in the box.
6. Select the media items for labeling. Use Shift+Click/Ctrl+Click to select
multiple media in the list. To label all media in the list, select the All Media in
List check box.
7. In the Enter ‘LABEL’ to Confirm Request box, enter LABEL (case
insensitive) to confirm bulk labeling.
8. Click OK.

10.4.0

Viewing Media Status
To view the media status, perform the following steps:
1. Open the NVBU Media Management window.
2. The currently online media are listed under Media. The online status for the
media is indicated with a green light icon. To view the details, double-click the
media, or right-click and select Open.

Figure 10-3:
NVBU Media
Management
window
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3. Under Details, click the corresponding tab to view the following information:


The Details tab displays the media label, group label, off-site location for
the media, space used, media type, barcode and the retirement date.



The Statistics tab displays the space left, size of the data stored, total
segments, and the last read and write dates for the media.



The History tab displays the re-use statistics, read and write errors, and
the total amount of data read and written. In case of any read/write errors,
investigate the cause. If the media is damaged, mark it as unusable to
prevent further writes.



The Library tab displays the library name, the current media location (the
drive/slot number), and the original home location (drive/slot) for the
media.

4. To view the details of a saveset contained in the media, double-click it, or
right-click and select Status.
5. Under Details, click the corresponding tab to view the following information:

10.5.0



The Backup tab displays the job title, NVBU Server and Client names,
plugin name, backup selection set, date, is an Incremental saveset, is an
archive, and the number of generations left for the saveset expiration.



The Segment n tab displays the length of the segment, offset, segment
position, block size, total time required to complete the backup, total time
required to transfer the data to segment n, user ID, and the backup
retirement date.



The Index tab provides the on-tape index information. The details include,
the index size, the slot/drive on which the media resides, the user ID, and
the retirement date.

Write-protecting Media
To prevent further writes on a piece of media, perform the following steps:
Note: The media write-protection feature does not apply to an NVSD Device.
1. Open the NVBU Device Management window. On the Devices tab, rightclick the drive/slot that contains the media, and select Properties.
Alternatively, open the NVBU Media Management window. Under Media,
right-click the target media and select Properties.
2. In the Media Properties window, select the Read Only check box.
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Figure 10-4:
Media
Properties
window

3. Click OK.
You can also select the Protect Media from Further Writes after Backup check
box on the Target tab on the Backup window when defining a backup job to writeprotect the media.
Note: NVBU may mark a piece of media as Read Only if a SCSI error occurs
during a write operation in order to stop further writes. If this is the case, check for
hardware errors. If no tape or media error is found, clear the check box for the
Read Only property.

10.6.0

Retiring Backup Savesets
NVBU supports generation-based and time-based retirement period for a saveset,
which can be set from the Advanced Options tab on the NVBU Backup window
while creating a job. For existing savesets, you can set or change the retirement
period from the NVBU Media Management window. The information about the
saveset is deleted from the NVDB when the period elapses. To set or change the
retirement date for existing savesets, perform the following steps:
1. Open the NVBU Media Management window.
2. Under Media, open the media that contains the target saveset (double-click
the media, or right-click and select Open).
3. Right-click the saveset, and select Change Expiry. This opens the Backup
Expiry window.
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Figure 10-5:
Backup Expiry
window

4. To set a time-based retirement date, perform the following steps.
a. Select Change Retirement Date.
b. Select On.
c. Enter the date in the boxes provided.
Select Never to retain the backup indefinitely.
5. To set a generation-based retirement period, perform the following steps:
a. Select Change Generations.
b. Select Discard After.
c. Enter the number of generations in the Full Backups box.
Select Never to retain the backup indefinitely.
6. Click OK.
Note: NVBU automatically marks a piece of media for re-use for tape devices
when the last saveset on the media expires.

10.7.0

Marking Media for Re-use
To manually mark a piece of media for re-use, perform the following steps. This
will retain the media label and any group association.
Note: The media re-use feature is not meant for an NVSD Device. The NVSD
Device uses a process known as the Garbage Collection to find chunks that are no
longer used by any backup. The orphaned chunks are removed from the chunk
store and the space is automatically reclaimed for newer backups.
1. Open the NVBU Device Management window. On the Devices tab, rightclick the drive/slot that contains the target media, and select Re-use.
2. In the confirmation window click OK.
To use this media for a backup, you must set the Reuse Media option on the
Backup Target tab to either Any or With Same Group Label as Target Media.
NVBU will overwrite the existing data when the media is re-used.
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10.8.0

Scanning Foreign Media
NVBU cannot process data on a piece of media for which the media information is
not present in the NVDB until the media, the backups and the on-tape indices
stored on that media have been successfully scanned into the NVDB. Such media
is marked as Foreign. Typically, media that is swapped between libraries,
removed, or for which no job details are available are marked as Foreign. To scan
a foreign media, perform the following steps:
Note: For details on scanning an NVSD Device, refer to Scanning an NVSD
Device on page 44.
1. Open the NVBU Device Management window. On the Devices tab, rightclick the library or the drive or slot that contains the target media, and select
Scan.
2. NVBU will scan the header and add it to the NVDB. Scanning retrieves the
header information from the tape and also the on-tape indices (backup
saveset index files) that are then added to the NVDB. Foreign tapes then
become known to NVBU. The scanning process does not read data on the
tape. Instead it skips between the beginning and end of backups looking for
the on-tape index for each backup saveset.

10.9.0

Tracking Offsite Location
To track the offsite location for a piece of media, perform the following steps:
Note: The offsite media location property does not apply to an NVSD Device.
1. Open the NVBU Device Management window. On the Devices tab, rightclick the drive/slot that contains the media, and select Properties to open the
Media Properties window.
Alternatively, open the NVBU Media Management window. Under Media,
right-click the target media and select Properties.
2. In the Offsite Location list, select the media location or enter the new
location in the box.
3. Click OK.
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Marking Media as Unusable
To mark a damaged media as unusable and prevent its further use, or to mark a
piece of media unusable until a later date, perform the following steps:
Note: This feature does not apply to an NVSD Device.
1. Open the NVBU Device Management window. On the Devices tab, rightclick the drive/slot that contains the media, and select Properties.
Alternatively, open the NVBU Media Management window. Under Media,
right-click the target media and select Properties.
2. In the Media Properties window, select the Unusable check box.
3. Click OK.

10.11.0

Removing a Backup Index from the NVDB
To delete a backup index from the NVDB, perform the following steps:
1. Open the NVBU Media Management window.
2. Under Media, open the media that contains the target saveset (double-click
the media, or right-click and select Open).
3. Right-click the saveset, and select Remove.
4. In the confirmation window, click OK. The backup index will be removed from
the NVDB. To use the saveset again, you must scan the media or recover a
previous NVDB backup which contained the saveset information.

10.12.0

Blanking Media
In NVBU terms, blanking a piece of media removes the NVBU header information
from the media. It also delete the media label and remove any group association.
This makes the media available to NVBU for storing future backups. The backup
data residing on the media is not deleted or erased; it can still be recovered from
tape using OS tools or data recovery service. If it is desired to purposely destroy
the data that is stored on the media, the media should be blanked by NVBU and
have its data securely removed by tools that are designed for such purposes.
To erase all data on a piece of media, perform the following steps:
Note: Media Blanking feature does not apply to an NVSD Device.
1. Open the NVBU Device Management window. On the Devices tab, rightclick the drive/slot that contains the target media, and select Blank.
2. In the confirmation window, click OK.
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10.13.0

Performing Bulk Media Blanking
To erase data on all media or a set of media in a library, perform the following
steps. This will also delete the media labels and remove any group association.
Note: Bulk media blanking not apply to an NVSD Device.
1. Open the NVBU Device Management window. On the Devices tab rightclick the library that contains the target media, and select Bulk Blank. This
opens the Bulk Blank Media window.
2. Use Shift+Click or Ctrl+Click to select multiple media in the list. To blank all
media in the library, select the All Media in List check box.
3. In the Password box, enter the password for the NVBU Server.
4. In the Enter ‘BLANK’ to Confirm Request box, enter BLANK (case
insensitive) to confirm bulk blanking.
5. Click OK.
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Chapter 11:

JOB MANAGEMENT
This chapter describes how to manage NVBU Jobs from the Console. The
information in this chapter is organized into the following topics:

11.1.0



NVBU Job Management – An Overview



Viewing Job Status and Definitions



Monitoring Job Progress



Customizing the Column Show/Hide Settings



Filtering Records on the Status Tab



Filtering Records on the Jobs Tab



Running a Job Immediately



Submitting a New Instance for Non-Repeating Jobs



Holding and Resuming a Job



Aborting a Job



Viewing Media Request Details



Changing Media Request Priority for a Job



Determining the Cause of “Waiting for Media” Status



Deleting a Job Schedule



Deleting a Job Definition

NVBU Job Management – An Overview
NVBU jobs are managed by the Job Manager process, which coordinates with the
the Data Plugin, Media Manager and other NVBU processes to complete the job
execution. The job details are stored in the Scheduler database. The NVBU Jobs
window provides an interface to access the information in the Scheduler database.
This window provides a consolidated view of all NVBU jobs on the following tabs:


Status Tab – The Status tab displays all submitted jobs, including the
scheduled, running and completed jobs.



Jobs Tab – The Jobs tab displays the job definitions of both the submitted
and the saved jobs.

You can use the NVBU Jobs window to view the job status, monitor the job
progress, access the job logs, start and stop jobs, and perform other job
management tasks from the Console.
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11.2.0

Viewing Job Status and Definitions
To view the job status and definition, perform the following steps:
1. Click Job Management on the toolbar or Large Buttons panel to open the
NVBU Jobs window. Alternatively, on the Operations menu, click Job
Management.

Figure 11-1:
Status tab on
NVBU Jobs
window

2. On the Status tab you can view all scheduled, running and completed jobs,
which are differentiated using the following background colors:
Job Status

Background Color

Running Jobs

Yellow

Scheduled Jobs

Blue

Completed Jobs

White (Normal)

These color codes are configurable and can be changed using the
Configurator. For details, refer to NetVault: Backup Configuration Guide. The
Status tab provides the following details:


Date and Timestamp



Job Title



Job ID



Instance



Phase



Client



Selection Set



Run Status
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3. To view the job definitions of the saved and submitted jobs, click the Jobs
tab.
Figure 11-2:
Jobs tab on
NVBU Jobs
window

These color codes are configurable and can be changed using the
Configurator. For details, refer to NetVault: Backup Configuration Guide. The
Status tab provides the following details:


Job Title



Job Type



Job ID



Plugin



Client



Selection Set



Selection Options



Next Run Time

4. To view the job logs, double-click a job on the Jobs or Status tab.
Alternatively, right-click the job and select View Log. For details on job logs,
refer to NVBU System Logs – An Overview on page 179.

11.3.0

Monitoring Job Progress
To monitor the job progress while a backup or restore job is running, perform the
following steps:
1. Open the NVBU Jobs window.
2. On the Status tab, double-click an active job to open the Job Monitor
window. Alternatively, right-click the job and select Monitor Progress.
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3. The Job Monitor window varies for different plugins, and provides pluginspecific details in addition to the following information:

Figure 11-3:
Job Monitor
window for File
System Plugin



Data Transfer Rate



Volume of Data Transferred



Elapsed Time



Items Completed



Current Object

4. Click OK to close the window.

11.4.0

Customizing the Column Show/Hide Settings
NVBU allows you to customize the NVBU Jobs window and hide the columns that
you do not want to view on the Jobs or Status tabs. To show or hide columns on
the Jobs or Status tabs, perform the following steps.
Note: The Jobs tab must contain at least one entry in order to customize the
column show/hide settings.
1. Open the NVBU Jobs window.
2. On the Jobs or Status tab, right-click the header row.
3. To hide the columns, clear the check marks for the columns.
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4. To display the columns again, right-click the header row and select the
columns.

11.5.0

Filtering Records on the Status Tab
To filter the jobs displayed on the Status tab, perform the following steps:
1. Access the Status tab on the NVBU Jobs window.
2. Click Set Filter on the toolbar. Alternatively, on the View menu, click Set
Filter.

Figure 11-4:
Status Filter
Options

3. Set the filter(s) as described below:




Date and Time Filters – Under From and To, configure the following
parameters:


First Job – Select the First Job option to start display from the first job
definition. For a time-based filter, enter the start time in the Specify
Time box.



Last Job – Select the Last Job option to view all logs from the start
point until the last job definition. For a time-based filter, enter the end
time in the Specify Time box.

Job Status Filters – Under Job Status, configure the following
parameters:
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Scheduled Jobs – To view the scheduled jobs, select the Scheduled
Jobs check box. Then, select All to view all scheduled jobs, or select
Run Within to view jobs scheduled to run within next n hours/days.
For the Run Within option, enter the number of hours or days in the
box to the right and select Hours or Days.



Running Jobs – To view the active jobs, select Running Jobs.



Completed Jobs – To view jobs that have completed successfully or
with warnings/errors, select Completed Jobs. Then, select All,
Completed with Warnings or Errors, or Completed with Errors.

Job Attribute Filters – Configure the following parameters:


Job Title – For a filter based on the job title, select this check box.
Enter the job title in the box.



Type – For a filter based on the job type, select this check box. Enter
Backup, Restore or Report in the box.



Instance – For a filter based on the job instance, select this check box.
Enter or select the instance number in the From and To list.



Client – For a filter based on target client, select this check box. Enter
the NVBU Client name in the box.



Selection Set – For a filter based on the backup selection set, select
this check box. Enter the set name in the box.



Schedule Set – For a filter based on the schedule set, select this
check box. Enter the set name in the box.



Advanced Options – For a filter based on the advanced options set,
select this check box. Enter the set name in the box.



Policy – For a filter based on backup policies, select this check box.
Enter the policy name in the box.



ID – For a filter based on the Job ID, select this check box. Enter or
select the Job ID in the From and To list.



Phase – For a filter based on the job phase, select this check box.
Enter or select the phase number in the From and To list.



Owner – For a filter based on the job owner, select this check box.
Enter the user name in the box.



Selection Options – For a filter based on the backup or restore
options set, select this check box. Enter the set name in the box.



Target Set – For a filter based on the target set, select this check box.
Enter the set name in the box.



Run Status – For a filter based on job status, select this check box.
Enter the status (e.g., Backup Completed) in the box.
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4. By default, the filter settings are only applied to the current session. If you
close the window, the settings will be discarded. Select Set as Default Filter
to save the filter settings and use them as the default filter.
5. Click Apply to apply the filter condition(s). Then click OK to close the window.

11.6.0

Filtering Records on the Jobs Tab
To filter the jobs displayed on the Jobs tab, perform the following steps:
1. Access the Jobs tab on the NVBU Jobs window.
2. Click Set Filter on the toolbar. Alternatively, on the View menu, click Set
Filter.

Figure 11-5:
Job Filter
Options

3. Configure the following parameters:


Job Title – For a filter based on the job title, select this check box. Enter
the job title in the box.



Type – For a filter based on the job type, select this check box. Enter
Backup, Restore or Report in the box.



Plugin – For a filter based on the plugin used for the job, select this check
box. Enter the plugin name in the box.



Owner – For a filter based on the job owner, select this check box. Enter
the user name in the box.



Selection Options – For a filter based on the backup options set, select
this check box. Enter the set name in the box.



Target Set – For a filter based on the target set, select this check box.
Enter the set name in the box.



Next Run Time – For a filter based on the next run time, select this check
box. Enter the date and time in the box.
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Policy – For a filter based on backup policies, select this check box. Enter
the policy name in the box.



ID – For a filter based on the Job ID, select this check box. Enter or select
the Job ID in the From and To list.



Client – For a filter based on target client, select this check box. Enter the
NVBU Client name in the box.



Selection Set – For a filter based on the backup selection set, select this
check box. Enter the set name in the box.



Schedule Set – For a filter based on the schedule set, select this check
box. Enter the set name in the box.



Advanced Options – For a filter based on the advanced options set,
select this check box. Enter the set name in the box.

4. By default, the filter settings are only applied to the current session. If you
close the window, the settings will be discarded. Select Set as Default Filter
to save the filter settings and use them as the default filter.
5. Click Apply to apply the filter condition(s). Then click OK to close the window.

11.7.0

Running a Job Immediately
To run a job immediately, perform the following steps:
1. Open the NVBU Jobs window.
2. On the Status or Jobs tab, right-click the job and select Run Now. You can
use the Shift+Click or Ctrl+Click methods to select multiple jobs.
Note: The Run Now feature cannot be used to run multiple backup jobs which
include a Secondary Copy phase.

11.8.0

Submitting a New Instance for Non-Repeating
Jobs
For non-repeating jobs, you can use an existing job instance or job defintion to
submit a new instance without re-creating the job. To submit a new instance for an
existing job instance or job definition, perform the following steps:
1. Open the NVBU Jobs window.
2. On the Status or Jobs tab, right-click the backup job and select Edit/View
Job.
3. In the Backup window, click Submit on the toolbar. Alternatively, click
Submit on the Accept menu.
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Holding and Resuming a Job
To put a job on hold, perform the following steps:
1. Open the NVBU Jobs window.
2. On the Status tab, right-click the job and select Hold.
3. To resume the job, right-click it and select Resume.
Note: Holding a job will disable its schedule until the job is resumed.

11.10.0

Aborting a Job
To abort a job, perform the following steps:
1. Open the NVBU Jobs window.
2. On the Status tab, right-click the job and select Abort.
3. In the confirmation window, click Yes.

11.11.0

Viewing Media Request Details
To view the media requests details while a backup job is in progress, perform the
following steps:
1. While a backup job is in progress, open the NVBU Media Management
window.
2. Under Media, double-click the media, or right-click and select Open.
3. Under Details, click the Media Request tab to view the following details:


Request ID



Job ID



Request Type



Job Status



NVBU Client on which the job is running



Drive on which the media resides



Media and group label; if no specific media is targeted, Any is displayed



Amount of space required on the media to complete the current request



Whether Ensure This Backup is First on the Media check box is
selected



Whether Mark Media Read-Only is selected



Whether Label Blank Media Automatically is selected



Media format



Whether media inactivity timeout is set
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11.12.0



Whether Local Drives Only option is selected



Whether Network Compression is enabled

Changing Media Request Priority for a Job
To change the media request priority for an active job, perform the following steps:
1. While a job is in progress, open the NVBU Device Management window.
2. On the Media Requests tab, right-click the job and select Set Priority.
3. In the Set Request Priority window, configure the following parameter:

Figure 11-6:
Set Request
Priority window



Priority – To change the request priority, enter or select the priority level
in the Priority box. The default priority of different request types are given
below:
Request Type

Priority Level

Backup Job

30

Restore Job

20

Continuation Request

5

Note that the priority level ranges from 1 (highest priority) to 100 (lowest
priority). A priority level of zero sets a request to run as a background task.
A continuation request occurs when an active backup or restore job
requires additional media for completion. NVBU assigns the lowest priority
level to such requests so that they are not preempted by other media
requests, and the active job completes without any interruption.
4. Click OK.

11.13.0

Determining the Cause of “Waiting for Media”
Status
When a job is in Waiting for Media status, it implies that the job is unable to
initiate data transfer as the target drive or media is unavailable. This may be
caused by any of the following reasons:


The target media or device is in use by another job



The target device is offline



The target media is not loaded
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The Reuse Media option was not selected for a job. Therefore, the job is
waiting for new media.



No blank or reusable media is available for the job

To determine the exact reason for the Waiting for Media status, perform the
following steps:
1. Open the NVBU Jobs window.
2. Right-click the job with Waiting for Media status, and select Diagnose Job.
3. The Diagnose Media Requests for Job window displays the target device
and media options with a list of available devices and media, and the reasons
why they cannot be used.
Figure 11-7:
Diagnose
Media
Requests for
Job window

Important: BakBone recommends that you perform the steps above and take a
binary log dump when logging a case with Technical Support.
4. Click OK to close the window.
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11.14.0

Deleting a Job Schedule
To delete a job schedule, perform the following steps:
1. Open the NVBU Jobs window.
2. On the Status tab, right-click the job and select Delete Schedule.
3. In the confirmation window, click Yes.

11.15.0

Deleting a Job Definition
To delete a job definition, perform the following steps:
1. Open the NVBU Jobs window.
2. On the Jobs tab, right-click the job and select Delete.
3. In the confirmation window, click Yes.
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Chapter 12:

SYSTEM LOG MANAGEMENT
This chapter describes how to view and manage the NVBU system logs. The
information in this chapter is organized into the following topics:


NVBU System Logs – An Overview



Viewing System Logs



Customizing the Columns Show/Hide Settings



Filtering Logs



Dumping Logs to a File



Viewing Dumped Logs



Deleting Logs Manually



Raising a Custom Log Event


12.1.0

Removing a Custom Log Event

NVBU System Logs – An Overview
Various NVBU process send messages to the Server to notify about the
operations taking, and report any problems or errors encountered during these
operations. NVBU uses a log daemon to manage these system logs, and write
them to log files. The Log Daemon starts with the NVBU Service, and runs on the
NVBU Server. The system logs reside in the ...\Logs directory on the NVBU
Server (where ... represents the NVBU installation directory). This directory can be
relocated using the NVBU Configurator. For details, refer to the NetVault: Backup
Configuration Guide.
The log files are stored in binary format and named log-0, log-1, log-2, etc. The
Log Daemon always reserves space for logs by creating a blank file. For example,
when log-0 becomes full, it creates log-2 before opening log-1 for recording
events. Log-0 and log-1 are created during NVBU installation. To make sure that
the system logs do not continue to accumulate and consume disk space, the Log
Daemon automatically deletes them after 30 days.
System Logs are useful for tracking activities and troubleshooting problems. You
can view the system logs from the NVBU Logs window. The device logs and job
logs can also be viewed from the NVBU Device Management and NVBU Jobs
windows, respectively.
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12.2.0

Viewing System Logs
To view the logs generated during an operation, perform the following steps:
1. Click Logs on the toolbar or Large Buttons panel. Alternatively, on the
Operations menu, click Logs.


To view device specific logs, click the Device Logs tab on the NVBU
Device Management window.



To view logs for a particular job, double-click the job in the Status or Jobs
tabs on the NVBU Jobs window.

2. NVBU provides the following information about the log entries:
Figure 12-1:
NVBU Logs
window



Warning Level – Depending on their severity, the messages are
classified into different categories. Different color codes, called the
Warning Level Indicators, are used to distinguish the log categories. An
icon with an exclamation mark is used to represent messages that can be
opened further to view the details or log contexts. The NVBU log
categories include the following:


Background Messages – The general messages are classified as
Background logs and represented with a green warning level indicator.



Information Messages – The messages related to media, scheduler,
and system activities are classified as Information logs and
represented with a blue warning level indicator.



Job Message Messages – The job activities are classified as Job
Messages and represented with a purple warning level indicator. By
default, only Job Messages and the higher categories are displayed.
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Warning Messages – Problems during process execution which do
not cause a job to fail are classified as Warnings and represented with
a yellow warning level indicator.



Error Messages – Problems encountered during execution which
might have caused a job to fail are classified as Error Logs and
represented with a red warning level indicator.



Severe Error Messages – Critical problems encountered during
execution which might have caused a job to fail are classified as
Severe Error Logs and represented with a red warning level indicator.



Date/Time – The time stamp for the log in Year/Month/Date
Hour:Minute:Second format.



Job ID – The Job ID for a backup, restore or a report job.



Class – The type of operation that generated the log. For example, media
activity logs are classified as Media, messages sent by the plugin are
classified as Data Plugin, and job messages are classified as Job.



Client – The name of the Client on which the process that generated the
log is running.



Log Message – The detailed log message/description.

3. Double-click a message with an exclamation mark to open one of the
following windows:


Additional Information Window – If the log contains information about
data transfer or other such information, a window containing this
information is displayed.



View Job Context – The log context typically contains the execution
scripts or output generated by the plugin.

4. To save a log context, click Save to File. In the Save Log Context window,
enter the file name and click OK. The file is saved to ...\Logs directory (where
... represents the NVBU installation directory).

12.3.0

Customizing the Columns Show/Hide Settings
NVBU allows you to customize the Logs window and hide the columns that you do
not want to view. To hide or show the columns, perform the following steps:
Note: The NVBU Logs window must contain at least one entry in order to
customize the column show/hide settings
1. In the NVBU Logs window, right-click the header row.
2. To hide the columns, clear the check marks for the column names.
3. To display the columns again, right-click the header row and select the
columns.
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12.4.0

Filtering Logs
To filter the logs appearing in the NVBU Logs window, perform the following steps:
1. Click Set Filter on the toolbar, or on the View menu, click Set Filter.

Figure 12-2:
Filter Options
window

2. Set filter(s) as described below:




Date and Time – For date and time filters, configure the following
parameters under From and To:


Start Point – Select the First Event option if you want to view logs
beginning with the first recorded event. For a time-based filter, enter
the start time in the Specify Time box.



End Point – Select the Last Event option to view all logs from the start
point until the most recent recorded event. For a time-based filter,
enter the end time in the Specify Time box.

Clients – To hide messages related to particular NVBU Client(s), clear the
corresponding check boxes under Clients.


Select All – To include all the listed NVBU Clients, click Select All.
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Clear All – To remove all the listed NVBU Clients, click Remove All.
This will normally result in no logs being displayed. However if the log
source is a log dump, then the Clear All option behaves differently
because the Clients list may or may not contain the NVBU Clients
present in the logs. Although, the Client list will be cleared, this will be
interpreted as “Do not Filter on NVBU Clients” and all the logs will
be displayed regardless of the Client list.



Classes – To hide certain classes of messages, clear the check boxes for
them under Classes.



Warning Levels – To filter logs based on their severity, select the
minimum severity level under Warning Levels. The warning levels are
listed in the ascending order of severity. When you select a category, all
logs belonging to the selected category and higher categories are
displayed. For example, if you select Job Messages, then all logs
classified as Job Messages, Warnings, Errors, and Severe Errors are
displayed in the NVBU Logs window. All displays messages belonging to
all log categories



Jobs – To view only logs for a particular job, select the Filter on Job
check box under Jobs and enter the Job ID



Text – To set a filter string, select the Filter on Text check box under Text
and enter the filter string in the box beneath

3. Click Apply to apply the filter condition(s). Then click OK to close the window.

12.5.0

Dumping Logs to a File
NVBU allows you to create a copy of the current logs and save them into a binary
or text file before purging them from the NVDB. For selective dumping, first set a
time-based filter criterion. For example, to dump all logs generated during last
month, set a filter to display only those logs and then run this option.
To dump logs into a binary or text file, perform the following steps:
1. Open the NVBU Logs window.
2. Click Dump Logs to File on the toolbar. Alternatively, click Dump Logs to
File on the Options menu.
3. In the Dump Log Entries to File window, configure the following options:
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Figure 12-3:
Dump Log
Entries to File
window



Dump Log File Name – Enter a file name for the log dump. If you do not
enter the complete path, the dump file is saved to ...\log\dumps\<text> or
<binary> folder. In this path ... represents the installation directory for
NVBU and <text> or <binary> represent the name of the final folder
based on the selected dump Format.



Format – The logs can be dumped into one of following two formats:


Text – Select this option to dump the logs into a text file.



Binary – Select this option to dump the logs to a binary file (.nlg)
which can be loaded to NVBU temporarily, if required. The binary
format is required when sending the logs to BakBone Technical
Support.

4. Click OK to save the logs.

12.6.0

Viewing Dumped Logs
To view the logs dumped as .nlg files, perform the following steps:
1. Open the NVBU Logs window.
2. Click Select Log Source on Options menu.
3. The dump files present in the ...\logs\dumps\binary folder are listed in the
box beneath. To load a file in this folder, select it in the list.
4. To load a dump file residing in a different location, enter the complete file path
in the box.
5. Click OK to view the dumped logs.
6. To reset the view to current logs, select the Use Default Log source option.

12.7.0

Deleting Logs Manually
The logs are automatically deleted after 120 days. You can change the Log
Daemon properties and set a new purge period for the logs via the Configurator.
For details, refer to the NetVault: Backup Configuration Guide. To manually delete
the unnecessary logs, perform the following steps:
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1. Open the NVBU Logs window.
2. Click Purge Logs on the Options menu.
3. In the Purge Log Entries To box, enter the date up to which you want to
delete the logs.
4. Click OK.

12.8.0

Raising a Custom Log Event
You can raise a custom log event when a particular message is logged, and use
any of the global or user-specific notification methods to alert you when this
occurs. The custom log events are added to the Log Daemon class in the NVBU
Global Notification window. To raise a custom log event, perform the following
steps:
1. Open the NVBU Logs window.
2. Right-click a message and select Set Event to open.
3. Configure the following parameters in the Set Event Log window:

Figure 12-4:
Set Log Event
window



Event Name – In the Event Name box, enter the event name



Description – In the Description box, enter a detailed description for the
event.

4. Click OK to save the event definition.
5. Set up a notification method for the event. For details on global notification
methods, refer to Setting up a Global Notification Method on page 189, and
for details on user-specific notification methods, refer to Setting a User
Notification Profile on page 200.
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12.8.1

Removing a Custom Log Event
To remove a custom log event, perform the following steps:
1. In the NVBU Logs window, right-click the message for which the event was
set.
2. In the Set Event Log window, click Remove.
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Chapter 13:

EVENT NOTIFICATION
This chapter describes how to set up notification methods for the NVBU events.
The information in this chapter is organized into the following topics.


Events and Notification – An Overview


13.1.0

Methods for Setting up an Event Notification



Events Notified By Default



Setting up a Global Notification Method



Viewing Operator Messages



Removing a User-Defined Notification Event

Events and Notification – An Overview
An event can be described as any significant occurrence within the NVBU system
that you want to be notified about. It can be a user action, a system event or a
state change event. The events can indicate an error or a problem, or just
completion of a task.
NVBU events can be predefined or user-defined. The predefined events are
organized into the following Event Classes – Audit, BakBone Time, Device, Job,
Licensing, Log Daemon, Machines, Media, Media Database, Policy, Scheduler
Database and Stats Collection. For details on event types in each class, refer
Predefined Events on page 249. The user-defined events can be created for
system and job logs.
NVBU provides the following notification methods to receive a notification when a
predefined or user-defined event is raised:


Sysop Email – Send an email to the Sysop (Administrator) when an event is
raised. This method requires the Email Server address and the Sysop email
ID, which can be configured from the Notification tab on the Configurator.
For details, refer to the NetVault: Backup Configuration Guide.



Sysop Operator Message – Log an operator message when an event is
raised. You can view these logs from the NVBU Status window.



Print Report – Print a report when an event is raised.



Run a Job – Run another job when an event is raised.
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13.1.1

Methods for Setting up an Event Notification
NVBU provides three methods to generate notification:


Generate Notification for Predefined Events Globally – You can set up
one or more notification methods for an event in the Global Notification
window to generate a notification whenever the event occurs within the
NVBU Domain. Global notification methods can only be set for predefined
events. You can choose the Sysop E-mail, Sysop Operator Message or
Print a Report notification methods for a predefined event.



Generate Notification for Individual Users – Notification methods can also
be set up for individual users (e.g., NVBU Administrator). This allows a
particular user to receive emails and/or Windows pop-up messages
whenever the event occurs within the NVBU Domain. This is done by setting
up a notification profile for the user in the NVBU User Properties window.
For details on setting up a user notification profile, refer to Setting a User
Notification Profile on page 200. The notification will be generated each time
the event occurs within the Domain.



Generate Notification for User-defined Events – NVBU allows you to
create a user-defined event for a particular instance of a system log or job log
generated during NVBU operations.
To create a user-defined job or log event, refer to the following sections:


Setting up a User-Defined Notification Event on page 108



Setting up User-Defined Notification Events for a Policy Job on page 141



Setting up a User-Defined Notification Event on page 210



Raising a Custom Log Event on page 185

You can choose the Sysop E-mail, Sysop Operator Message, Print a
Report or Run a Report notification methods for a user-defined event. A
notification is generated only for the job log or system log for which it is
configured.

13.2.0

Events Notified By Default
For certain significant events, NVBU sets up the SysOp Operator Message
notification method by default. These include the following events:


Event Class: BakBone Time, Event Type: Server Time Unknown – This
event is raised when the Time Server is not able to fetch BakBone Time from
the Source.



Event Class: Device, Event Type: No Suitable Drive – This event is raised
when NVBU is not able to find a suitable drive to run a backup or restore job.



Event Class: Licensing, Event Type: License Exceeded – This event is
raised when usage exceeds the available licenses.
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Event Class: Licensing, Event Type: License Expiring – This event is
raised when the NVBU evaluation license is nearing expiry or has expired. It
is raised when the validity period for an NVBU evaluation license is less than
or equal to 7 days.



Event Class: Log Daemon, Event Type: Home Drive Becoming Full –
This event is raised when the disk space usage reaches warning or critical
threshold.



Event Class: Media, Event Type: No Suitable Media – This event is raised
when NVBU is not able to find a suitable media to complete the backup job.

You can also set another notification method if required.

13.3.0

Setting up a Global Notification Method
To set a global notification method for a predefined or user-defined event, perform
the following steps:
1. On the Administration menu, click Global Notification to open the Global
Notification window. On the Global Notification Profile tab, you will find the
list of event classes.
2. Double-click an event class node, or right-click it and select Show Event
Types. The list of available event types in a class is displayed under this
node.
3. Double-click an event type node, or right-click it and select Show
Notification Methods.
4. Set up one or more notification methods as described below:
a. Sysop E-mail – Select this method to receive an email notification when
the event is raised. To use this method, you must configure the email
server address and the Sysop mail ID from the Notification tab on the
Configurator. For details on these configuration procedures, refer to the
NetVault: Backup Configuration Guide.
b. Sysop Operator Message – Select this method to log an operator
message when the event is raised. These logs can be viewed from the
NVBU Status window. For details on accessing the operator log
messages, refer to Viewing Operator Messages on page 192.
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Figure 13-1:
NVBU Global
Notifications
window

c. Print Report – Select this method to print a report when the event is
raised. This method can only be used for Report Job event types. To use
this method on Windows, you must either configure a default printer or set
a printer for an individual event. For details on configuring a default printer
for event notification, refer to the NetVault: Backup Configuration Guide. If
a default printer is not configured or you want to use another printer for a
particular event, perform the following steps:
1. Double-click Print Report node, or right-click it and select About
Extra Variables.
2. In the Notification Method Information window, configure the
following parameter:


Setting Variable – In the Setting Variables box, configure the
NVPRINTER variable:
NVPRINTER=<Printer URL>
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Figure 13-2:
Notification
Method
Information
window to
configure
NVPRINTER

3. Click OK to save the settings.
d. Run a Job – Select this method to run another job when the event is
raised. For example, you can use this notification method to run a report
job when the backup fails to determine the cause. To use this method, first
create the job you want to run when the event is raised. Then, specify the
job using its Job ID as described in the following steps:
1. Double-click Run a Job node, or right-click it and select About Extra
Variables.
2. In the Notification Method Information window, configure the
following parameter:
Figure 13-3:
Notification
Method
Information
window to
configure
JOB ID



Setting Variable – In the Setting Variables box, configure the
JOBID variable:
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JOBID=<Job ID for the job to run when the event is
raised>
3. Click OK to save the settings.
5. Click Save Global Notification Profile on the toolbar, or on the File menu,
click Save.

13.4.0

Viewing Operator Messages
To view the operator messages logged for NVBU events, perform the following
steps:
1. Click Status on the toolbar or Large Buttons panel to open the NVBU
Server Status window. Alternatively, on the Operations menu, click Status.
2. The sysop operator messages for the events are listed under Operator
Messages.

Figure 13-4:
Operator
Messages on
NVBU Server
Status window

3. You can set the Flag property for a message if it requires any action. To flag a
message, right-click it and select Flag. To clear the flag, right-click and select
Unflag.
4. To acknowledge a message, right-click it and select Acknowledge.
5. To delete a particular message, right-click it and select Delete.
6. To clear all logs, right-click any message and select Delete All.

13.5.0

Removing a User-Defined Notification Event
To remove a user-defined notification event, perform the following steps:
1. Open the NVBU Global Notifications windows.
2. On the Global Notification Profile tab, locate the event class for the userdefined event.
3. Right-click the user-defined event and select Remove Event.
4. In the confirmation window, click Yes.
5. In the Definitions Raising Event window, click Force Remove.

NetVault: Backup
Administrator’ Guide

193

Chapter 14:

ACCESS CONTROL
This chapter describes how to implement NVBU’s access control mechanisms.
This section is primarily intended for the NVBU Administrator who is responsible
for managing the NVBU system. The information in this chapter is organized into
the following topics:

14.1.0



Access Control – An Overview



Creating User Accounts



Modifying a User Profile



Updating User Details



Assigning Client Access Privileges



Granting Privileges for NVBU Operations



Assigning Media Group Memberships



Setting Media Usage Quota



Setting Job Quota



Setting a User Notification Profile



Setting User Account Password



Setting Global Password Expiration Policy



Deleting a User Account

Access Control – An Overview
NVBU provides user-level access control mechanisms which can be implemented
to accomplish the following:


Prevent unauthorized access to your backup system



Grant privileges based on the user role/functions

For example, you can create a user for the DBA role and grant privileges to
perform backup and restore jobs for the database system, or you can create an
account for the network administrator and grant privileges to add and remove
backup devices. For the list of NVBU user privileges, refer to User Privileges on
page 265.
NVBU creates two user accounts during installation:


default – This is a normal user account. NVBU uses this user account to
automatically logon to the system when no access control mechanisms are in
place. This user has full access to the NVBU system. By default, no password
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is set for this account, which enables automatic logon. Although setting a
password for this account will disable automatic logon, it will prevent
unauthorized access to your NVBU system.
BakBone recommends that you create separate user accounts for individual
users or user groups. The user accounts can be based on individual users,
roles or groups/department.


admin – This is the Administrator account for the NVBU system. By default,
no password is set for this account. To prevent unauthorized access, you
BakBone recommends that you set up a password for the admin account.

The access control mechanisms are controlled by the Auditor Daemon (nvavp),
which runs on the NVBU Server. This process tracks and controls user activities. It
validates each user request, and depending on the user privileges, grants or
denies the request. The Auditor records these events in the audit log, which is also
known as the Audit Trail. The audit log is named audit.bin and resides in the
.../db directory (where ... represents the NVBU installation directory). You can view
these logs via NVBU Audit Trail report. The Auditor automatically deletes the logs
that are older than 31 days. You can change this property using the NVBU
Configurator. For details, refer to the NetVault: Backup Configuration Guide.

14.2.0

Creating User Accounts
To create a new user account, perform the following steps:
1. Click User-Level Access on the toolbar or Large Buttons panel to open the
NVBU Access Control window. Alternatively, on the Administration menu,
click Access Control.
2. On the Users tab, click Add User. NVBU creates a new account and adds it
to the user list. The user is named New User by default.
3. To rename the user account, right-click New User on the Users tab and
select User Properties.
4. In the NVBU User Properties window, click the User Details tab.
5. In the Account box under Identification, enter the name by which the
user/group account will be identified. BakBone recommends that you change
the default name and assign a unique name based on the user group, role or
actual name.
6. In the Real Name box, enter the actual name of the user/group. This
information is not mandatory.
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Figure 14-1:
NVBU User
Properties
window

7. Click the Group Memberships tab, and assign the access privileges to
Clients. For details, refer to Assigning Client Access Privileges on page 197.
8. Click the Privileges tab, and assign the privileges to perform NVBU
operations. For details, refer to Granting Privileges for NVBU Operations on
page 197.
9. The remaining attributes are optional. Refer to the following sections for
instructions on configuring these attributes:


Updating User Details on page 196



Assigning Media Group Memberships on page 199



Setting Media Usage Quota on page 199



Setting Job Quota on page 199



Setting a User Notification Profile on page 200

10.For details on setting a password for the user account, refer to Setting User
Account Password on page 200.
11. Click Save User Details on the toolbar. Alternatively, on the File menu, click
Save User.
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14.3.0

Modifying a User Profile
To modify a user account profile, perform the following steps:
1. Open the NVBU Access Control window.
2. In the user list, right-click the user, and select User Properties.
3. Refer to the following sections to modify the user profile:


Updating User Details on page 196



Assigning Media Group Memberships on page 199



Setting Media Usage Quota on page 199



Setting Job Quota on page 199



Setting a User Notification Profile on page 200

4. For details on changing user password, refer to Setting User Account
Password on page 200.
5. Click Save User Details on the toolbar. Alternatively, on the File menu, click
Save User.

14.4.0

Updating User Details
To change the user name and/or update general details for an account, perform
the following steps:
1. In the NVBU User Properties window, click the User Details tab.
2. To change the user name, enter the new name in the Account box under
Identification.
3. Enter the actual name in the Real Name box.
4. Under E-mail, configure the email addresses for the user/group. Enter the
address in the E-mail 1 box if you want to set up an email notification method
for pre-defined or custom events. For details on event notification, refer to
Setting a User Notification Profile on page 200. The other details are not
required.
5. Under Contact, enter the phone numbers and other details in the
corresponding boxes. These details are not required.
6. Under Details, enter the workstation name, location and the user/group
description in the corresponding boxes. These details are not required.
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Assigning Client Access Privileges
To assign client access privileges to a user, perform the following steps:
1. In the NVBU User Properties window, click the Group Memberships tab.

Figure 14-2:
Client Groups
under Group
Memberships
tab

2. To allow access to all Clients within the Domain, select the User is a Member
of All Clients Group check box under Client Groups. When you select this
check box, the user account is automatically granted membership to any
Client/Client Group that are added in future.
Alternatively, select default in the Not Member Of list under Client Groups,
and click the Left Arrow.
3. To grant access to selective Client Groups, select the group in the Not
Member Of list and click the Left Arrow.
4. To allow access to a Client only when the user is locally logged on to the
Client, select the Local Access Only check box. When you select this check
box the user cannot target the Client for backups remotely from the NVBU
Server or any other Client.
5. To remove a Client Group membership, select the group in the Member Of
list and click the Right Arrow.

14.6.0

Granting Privileges for NVBU Operations
To grant privileges for NVBU operations, perform the following steps:
1. In the NVBU User Properties window, click the Privileges tab.
2. To grant full access to NVBU, select the User is Granted All Privileges
check box under Privilege Flags.
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Figure 14-3:
Privileges tab

3. To grant access to selective functions, select the functions in the Denied list.
Use Shift+Click or Ctrl+Click to select the functions. Then, click the Left
Arrow. These privileges are now added to the Granted list.
4. You can save these selections into a preset and apply the preset to another
user account. This eliminates the chances of error while assigning necessary
privileges to a user. To save the privileges into a set, click Save Preset. In the
Select Preset window, enter a name for the set in the box provided at the
bottom of the window. Then, click OK.
5. To apply a preset, click Load Preset. In the Select Preset list, select the set
you want to apply. Then, click OK.
6. To revoke any granted privilege, select it in the Granted list and click the
Right Arrow. This moves the privilege to the Denied list.
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Assigning Media Group Memberships
To assign media group memberships to a user, perform the following steps:
1. In the NVBU User Properties window, click the Group Memberships tab.
2. For no media group restrictions, select the User is a Member of All Media
Groups check box under Media Groups. When you select this check box,
the user account is automatically granted access to any new media groups
that are added.
3. To restrict the user account to target specific media groups for backups (e.g.,
DB-Full and DB-Inc media groups for the backups of a database), select the
media group in the Not Member Of list and click the Left Arrow.
4. To remove a Media Group membership, select the group in the Member Of
list and click the Right Arrow.

14.8.0

Setting Media Usage Quota
By default, NVBU users have access to unlimited media quota. No restrictions
apply to the amount of media used by any user account. You can, however,
override this default setting and configure a quota for a user to curtail media
usage. When the usage reaches the defined quota, the jobs submitted by the user
will fail. The media usage amount is calculated from the existing records in the
media database. When a saveset expires, the media used by it becomes available
for new jobs. To set the media usage quota for a user account, perform the
following steps:
1. On the Privileges tab, select the option Media Usage Up to under Media
Quota.
2. In the box to the right enter the media usage quota in GB.

14.9.0

Setting Job Quota
By default, NVBU users can run infinite number of jobs. No restrictions apply to the
number of jobs performed by any user account. You can, however, override this
default setting and configure the maximum number of jobs for a user. When the
total number of existing jobs reaches the defined quota for a user, the user will not
be able to submit more jobs. The number of jobs performed by a user is derived
from the existing records in the scheduler database. For the deleted job
definitions, the user can submit an equal number of new jobs. To set the maximum
number of jobs for a user, perform the following steps:
1. On the Privileges tab, select the option Job Count Up to under Job Quota.
2. In the box to the right enter the maximum number of jobs for the user.
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14.10.0

Setting a User Notification Profile
NVBU provides a set of pre-defined events for which you can configure global and/
or user-specific notification methods. For details on pre-defined events, refer to
Predefined Events on page 249. You can choose to generate an email or a
Windows pop-up message whenever the event is raised within the Domain. To set
an event notification profile for a user account, perform the following steps:
1. Open the NVBU Access Control window.
2. In the user list, right-click the user, and select User Properties.
3. In the NVBU User Properties window, click the Notification Profile tab.
4. Double-click an event class node, or right-click it and select Show Event
Types. The available event types are listed under this node.
5. Double-click an event type node, or right-click it and select Show
Notification Methods.
6. The available notification methods are listed under this node. Select the
required method.


E-mail – Select this method to send an email notification to the user when
the event is raised. The email is sent to the mail address configured in the
E-mail-1 box on the User Details tab.



Windows Pop-up Message – Select this method to display pop-up
messages to the user when the event is raised. This method is only
supported on Windows. Note that the pop-up messages will not be
displayed if firewall or other settings block such messages. The pop-up
message notification method is not available on recent versions of
Windows.

7. Repeat steps 4–6 to set up notification methods for other events.
8. Click Save User Details on the toolbar. Alternatively, on the File menu, click
Save User.

14.11.0

Setting User Account Password
To set or change the password for a user account, perform the following steps;
1. Open the NVBU Access Control window.
2. In the user list, right-click the user, and select Set Password.
3. Configure the following parameters in the Set User Password window:


Existing Password – Enter the current password for the account. Leave
it blank if no password was set.



New Password – Enter the new password for the user account. A
password can contain a maximum of 100 characters. It can contain any
character.
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Confirm Password – Re-enter the password for confirmation.

4. Click OK.
To set the Password Never Expires flag, perform the following steps:
1. In the NVBU Access Control window, right-click the user and select User
Properties.
2. Click the Privileges tab.
3. Under General, select Password Never Expires.
4. Click Save User Details on the toolbar. Alternatively, on the File menu, click
Save User.
This setting overrides any global password expiration policy you have set.

14.12.0

Setting Global Password Expiration Policy
To define a global password expiration policy for all NVBU user accounts, perform
the following steps:
1. Open the NVBU Access Control window.
2. Click Edit Password Policy.

Figure 14-4:
Edit Password
Policy window

3. In the Edit Password Policy window, select the Passwords have a
Maximum Age check box.
4. In the box next to this check box, enter the age for user password in number
of days.
5. In the Display Reminder box, enter how many days before the expiration
date you want NVBU to start displaying the reminder. The message is
displayed when the user logs on to the NVBU system.
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14.13.0

Deleting a User Account
To delete a user account, perform the following steps:
Important: Do not remove the admin user account.
1. Open the NVBU Access Control window.
2. In the user list, right-click the user, and select Remove User.
3. In the confirmation window, click OK.
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REPORTING
This chapter describes how to use the NVBU Reporting system. The information in
this chapter is organized into the following topics:


NVBU Reports – An Overview


Types of Reports



Supported Report Formats



The NVBU Reports Management Window



The Reports Database



Reporting and Event Notification



Generating a Canned Report



Creating a Custom Report





Selecting the Report Components



Inserting Custom Headers and Footers



Defining Job Schedule



Setting up a User-Defined Notification Event



Finalizing and Submitting a Job



Retaining Excluded Data for Historic Reports

Working with User-defined Components


Selecting the Base Component



Selecting Fields for a Component



Sorting the Output



Specifying the Output Type



Setting the Output Options



Defining Headers and Footers for the Component



Setting Filter Conditions




Creating or Modifying Filter Expressions

Saving a Component



Working with Historic Reports



Editing/Viewing a Report Template



Viewing Logs for Report Jobs



Deleting a Report Template
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15.1.0

NVBU Reports – An Overview
NVBU' s comprehensive reporting system includes a number of predefined
reports, which provide you detailed and summarized information on NVBU
components and operations, including the current status, utilization details and
performance statistics. If these predefined reports do not meet your information
needs, the advanced reporting capabilities allow you to build your own custom
reports without having to understand where and how the data is stored.

15.1.1

Types of Reports
NVBU offers two types of reports:


Canned Reports – Canned Reports are predefined reports that allow you to
quickly and easily retrieve information on the backup and restore jobs, online
and offline media, clients and devices, and other common queries. These
reports are generated using built-in HTML templates. You can run and view
these reports from the NVBU Reports window. For a list of available canned
reports, refer to Available Canned Reports on page 255.



Custom Reports –Custom reports are reports that you create and design to
meet specific information requirements. You can use this feature for a
consolidated report on several components and operations, view averages
and totals, or add custom headers, footers and output filter conditions.
Custom reports are generated using user-defined report templates, which
can be created in HTML, Text or Comma Separated Value (CSV) file formats.
The custom reports can be saved for reuse, and scheduled to run at
predefined time and intervals. You can create and view the custom reports
from the NVBU Reports window.

Note: A basic version of the NetVault: Report Manager for Backup (NRMB) is
included in NVBU DataCenter and Enterprise Editions. You can use this software if
the NVBU Server is running on an operating system supported by NRMB. NRMB
consolidates information from multiple NVBU Servers, and provides visual
monitoring and alerting capabilities with additional backup reporting. The system
identifies potential problems early on and graphically communicates vital data
protection results to key constituents. NRMB reduces administrative time, and
helps centralize operations and lowers media costs. For details on NRMB, refer to
the NetVault: Report Manager Administrator’s Guide at the following address:
http://www.bakbone.com/documentation
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Supported Report Formats
The canned and custom reports can be generated in the following formats:

15.1.3



HTML – On Windows, you can use the built-in browser to view these reports.
On Linux/UNIX, you must configure a default browser for NVBU reports using
the Configurator. These options are present on the Browser sub-tab on the
GUI tab. For details, refer to the NetVault: Backup Configuration Guide.



Text – This format can be used to view the reports from the command line or
using any text editor.



CSV – This format can be used to generate CSV file which can be imported
to your spreadsheet or database application.

The NVBU Reports Management Window
Both Canned and Custom reports are run from the NVBU Reports window. The
NVBU Reports window contains the following tabs:

Figure 15-1:
NVBU Reports
Management
window



Jobs – The Jobs tab provides a list of job definitions for Canned and Custom
reports.



Status – The Status tab provides a list of scheduled, active and completed
report jobs. NVBU uses different background colors to display the current
status of the jobs listed on the Status tab. The default color codes for all job
types are listed in the table below:
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Job Status

Background Color

Running Jobs

Yellow

Scheduled Jobs

Blue

Completed Jobs

White (Normal)

You can change the status color-coding for all jobs from the GUI tab on the
Configurator. For details, refer to NetVault: Backup Configuration Guide.

15.1.4

The Reports Database
NVBU stores the report templates and components in the reports database, which
resides in the …/NVBU/reports directory (where … refers to the NVBU installation
directory). You can relocate the database using the Configurator. For details on
relocating the reports database, refer to the NetVault: Backup Configuration
Guide.

15.1.5

Reporting and Event Notification
The reporting functionality is integrated with the event notification system. This
allows you to set up global or user-specific notification methods, and receive
notification when a job completes or fails, or when certain conditions are met. You
can use this feature to send reports as email attachments to the Administrator or
any other NVBU user.

15.2.0

Generating a Canned Report
To run a canned report, perform the following steps:
1. Click Reports Management on the toolbar or Large Buttons panel to open
the NVBU Reports Management window. Alternatively, on the Operations
menu, click Reports.
2. On the Jobs tab, locate the required canned report. Double-click the report,
or right-click and select Run and View. Select Run and Notify, if you want to
raise the associated events and receive a notification.
3. If any filter condition is set for the report (e.g., reports that are to be generated
for a particular period or for a particular job), the Set Filters for Report
window will be displayed. Enter the values and click OK.
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Figure 15-2:
Set Filters
window

4. The report opens in the built-in or the configured browser.

15.3.0

Creating a Custom Report
Custom reports can include predefined as well as user-defined components. Userdefined components are customized components derived from a predefined
component. For details on creating a user-defined component, refer to Working
with User-defined Components on page 212. For a list of predefined components
that can be included in a custom report, refer to Available Report Components on
page 257. The procedure for creating a custom report can be divided into the
following steps:


Selecting the Report Components



Inserting Custom Headers and Footers



Defining Job Schedule



Setting up a User-Defined Notification Event



Retaining Excluded Data for Historic Reports



Finalizing and Submitting a Job

These steps are described in detail in the following sections.

15.3.1

Selecting the Report Components
To select the components for a report job, perform the following steps:
1. Click Reports Management on the toolbar or Large Buttons panel to open
the NVBU Reports Management window. Alternatively, on the Operations
menu, click Reports.
2. Click Report Job on the toolbar to open the Reporting Job Editor window.
Alternatively, on the Reports menu, click Report Job.
3. The available predefined and user-defined components are listed under
Available Components. The default view method is By Class, which
arranges the components under their respective classes.
You can change the view to All in the Viewing Method list for an alphabetical
listing of the components. The By Output Type viewing method organizes
the components by their output type – Comma Separated Values, HTML
Text or Plain Text.
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4. To add an available component, perform the following steps:
a. Open the parent class or output type. You can double-click the node, or
right-click and select Show Components.
b. Double-click a component. Alternatively, right-click it and select Add to
Job. The added component is displayed under Selected Components
c. To add other available components, repeat steps a–b.

Figure 15-3:
Reporting Job
Editor window

5. To change the order in which the components appear in the report, select the
component in the Selected Components list, and click Up or Down.
6. To include a new user-defined component in the report, click New
Component. For details on creating a user-defined component, refer to
Working with User-defined Components on page 212. After creating the
component, click Save and Add to Job on the toolbar. Repeat this step for
any other new component you want to include in the report.
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7. To modify an added component, select it in the Selected Components list
and click Edit. This opens the Report Component Editor window. For
details on modifying a report component, refer to Working with User-defined
Components on page 212.
8. To remove a component, select it and click Remove.

15.3.2

Inserting Custom Headers and Footers
Each report contains a default header and footer, which is in HTML or text format
depending on the output format of the component. To replace them with your own
custom header/footer, perform the following steps:
1. In the Reporting Job Editor window, click the Header/Footer tab. The
available header templates are listed under Choose Header.

Figure 15-4:
Header/Footer
tab on
Reporting Job
Editor window

2. To insert a custom header, first clear the check box for the Default header.
3. If the required header is already defined, select it in the Choose Header list.
Ignore the remaining steps in this section.
4. To define a new header, select one of the following methods.
Note: To create HTML headers, you must be familiar with the HTML tags.


Clone an Existing Header Template – To create a new header from an
existing template, right-click the header, and select Clone.



Create a New Header Template – To create a header using a blank
template, click New at the bottom of the window.

5. In the Edit Header window, enter a name and make the required changes as
described in the following steps:
a. In the Header Name and Text box, enter a name for the template
b. In the box below, enter or modify the text. You can use any HTML tag in an
HTML template.
c. To include images (e.g., company logo) in an HTML template, use the
SRC HTML tag. The image must be in .jpeg or .gif format.
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d. Click OK. The template is added and displayed under Choose Header.
6. Select the template.
7. If you have added images, copy the file to
..\reports\jobheaders\HTMLJobDefault\images folder. Then, right-click the
new custom header and select Add Image. In the browse window, enter the
file path or select the file.

15.3.3

Defining Job Schedule
To define a schedule, click the Schedule tab on the Reporting Job Editor
window. You can define a daily, weekly, monthly or any other custom schedule for
the report job. For details on configuring the scheduling options, refer to Job
Scheduling on page 113. You can omit this step if you want to run the report job
immediately.

15.3.4

Setting up a User-Defined Notification Event
NVBU supports three types of custom events for a report job:


Conditional Event – Raised only when the conditions are met. For details on
specifying event conditions, refer to Setting Filter Conditions on page 221.



Job Completion Event – Raised when the job completes.



Job Failure Event – Raised when the job fails.

You can set up both global and user-specific notification methods for these events.
The custom report events are added to the Report Job class in the Global
Notification window. You can use this feature to send reports as email
attachments to the Administrator or any other user. To raise a custom report event,
perform the following steps:
1. In the Reporting Job Editor window, click the Options tab.
2. Under Output Options, configure the following parameters:




Raise an Event Conditionally – To raise an event conditionally,
configure the following parameters:


Select the Run as Condition Check check box.



Select or enter the event name in the Event to Raise if Condition is
Met list.



To raise an event only when conditions set for all components are met,
select the Conditions of all Components must be Met to Raise an
Event check box.

Raise an Event when the Job Completes – The conditional event and
job completion events are mutually exclusive. If the Run as Condition
Check check box is selected for a report job, then this option will not be
available. To raise an event when the job completes, select or enter the
event name in the Event to Raise when the Job Completes list.
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Raise an Event if the Job Fails – To raise an event if the job fails, enter
or select the event name in the Event to Raise on Job Failure list.

Figure 15-5:
Options tab for
custom report
events

3. Set up a notification method for the event. For details on global notification
methods, refer to Setting up a Global Notification Method on page 189, and
for details on user-specific notification methods refer to Setting a User
Notification Profile on page 200. Note that a new event is only listed in the
Global Notification and the NVBU User Properties window when you save
or submit the job definition.
Note: To send the report as an email attachment to the Administrator or any user,
set up the Sysop E-mail global notification method or the E-mail user notification
method.

15.3.5

Retaining Excluded Data for Historic Reports
NVBU keeps a copy of the data set that was used to generate a report, allowing
you to re-analyze the historic data by applying new settings and filters. By default,
the data that is excluded as a result of some filter condition is not saved. Saving
the excluded data allows you to conduct a reanalysis on the entire data set, and
view the excluded records by modifying or removing the filter condition. The Keep
Filtered Out Records option controls whether or not NVBU keeps a copy of the
excluded data. By default, this option is not enabled. You can select it individually
for each report, or globally enable it for all reports using NVBU Configurator. To
globally enable the Keep Filtered Out Records option for all reports, refer to the
NetVault: Backup Configuration Guide. To enable the Keep Filtered Out Records
option for an individual report, perform the following steps:
1. In the Reporting Job Editor window, click the Options tab.
2. Select the Keep Filtered out Records check box. While generating the
report again, you can remove the exclude condition or set a new filter to view
the excluded records. Note that the filters can only be based on the fields
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selected for the original report job. For details on making changes to historic
reports, refer to Working with Historic Reports on page 226

15.3.6

Finalizing and Submitting a Job
Complete the following steps to finalize and submit the job.
1. Enter a title for the job in the Job Title box at the top right corner of the
Reporting Job Editor window.
2. Choose one of the following methods to save, submit and/or run the report.
a. Save the Definition without Scheduling the Job – To save the job
definition without scheduling it, click Save on the toolbar. Alternatively, on
the File menu, click Save.
A saved job does not appear in the Status tab of the Reports window and
does not run unless you submit it (or use the Triggered scheduling
option). You can load a saved job again in the Reporting Job Editor
window, or open it for editing from the Jobs tab of the Reports window.
For details on editing a job definition, refer to Editing/Viewing a Report
Template on page 228.
b. Schedule the Job – To submit the job and run it at the defined schedule,
click Submit on the toolbar. Alternatively, on the Accept menu, click
Submit Backup.
c. Run the Job Immediately – To run the job immediately and view the
report, click Save, Run and View Job on the toolbar. Alternatively, on the
Accept menu, click Save, Run and View.

15.4.0

Working with User-defined Components
NVBU allows you to customize a predefined component and derive your own
custom component. This gives you the ability to choose the fields, reorder the
fields, sort the records and set custom filter conditions for a component. The
procedure for creating or modifying a user-defined component can be divided into
the following steps:


Selecting the Base Component



Selecting Fields for a Component



Sorting the Output



Specifying the Output Type



Setting the Output Options



Defining Headers and Footers for the Component



Setting Filter Conditions



Saving a Component
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Selecting the Base Component
To select the base component, perform the following steps:
1. Select one of the following methods to choose the base component:
a. Define a New Component for the Current Job – To add a new
component to the job you are defining, click New Component in the
Reporting Job Editor window.
b. Modify a Component for the Current Job – To change a component
added to the job you are defining, perform the following steps:
1. In the Reporting Job Editor window, select the component in the
Selected Components list.
2. Click Edit.
c. Create a Component for Future Use – To create a component for future
use, perform the following steps:
1. In the Reports window, click Report Component on the Reports
menu. This opens the Report Component Editor window.
2. In the Report Component Editor window, click New on the toolbar, or
on the File menu, click New.
d. Modify a Component for Future Use – To modify a component for future
use, perform the following steps:
1. Open the Reports window. On the Reports menu, click Report
Component.
2. In the Report Component Editor window, click Load on the toolbar,
or on the File menu, click Load. This opens the Choose New
Component’s Class window.
3. Double-click a class, or select it and click OK.
2. In the Choose New Component’s Class window, double-click a component,
or select it and click OK.
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Figure 15-6:
Choose New
Component’s
Class window

15.4.2

Selecting Fields for a Component
To select the fields for a component, perform the following steps:
1. In the Report Component Editor window, click the Field Selection tab.
2. Under Available Fields, you will find the list of fields that can be included.
Refer to the Description column in the table to find out the value stored in
these fields.
3. To include a field double-click it. The added field is displayed under Selected
Fields. Repeat this step to add the other fields.
4. Under Selected Fields, two views are provided – Simple and Advanced/
Free Format.


Simple View – The Simple view lists the selected fields in a tabular
format.


To change the order of the fields, select it in the Selected Fields list
and click Up or Down.



To remove a field, select it and click Remove.
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Figure 15-7:
Simple View
for field
selection



Advanced/Free Format View – The Advanced/Free Format view uses t
HTML table tags to display the order of the selected fields. If you are
familiar with HTML tags, you can use this view to add, rearrange or
remove fields. Use the names listed under the Real Name column under
Available Fields. Prefix each field name with % to replace it with the
actual field value in the report.

Figure 15-8:
Advanced
View for field
selection

15.4.3

Sorting the Output
To sort the output on multiple fields, perform the following steps:
1. In the Report Component Editor window, click the Sort Order tab.
2. Under Available Fields, you will find the list of fields that can be used to
specify the sort order.
3. To sort the records by a particular field, select it in the Available Fields list.
Click Add as Ascending or Add as Descending. The added field is
displayed under Sort Order. To add other fields, repeat this step.
4. To change the order of the fields, select it in the Sort Order list and click Up
or Down.
5. To remove a field, select it and click Remove.
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Figure 15-9:
Sort Order tab

15.4.4

Specifying the Output Type
To specify the type of output generated by the component, perform the following
steps:
1. In the Report Component Editor window, click Set Output Type on the
toolbar. Alternatively, on the Options menu, click Output Type.
2. In the Choose Component’s Output Type list, select Plain Text, HTML
Text or Comma Separated Values list.
3. Click OK.

15.4.5

Setting the Output Options
To configure the output options for a component, perform the following steps:
1. In the Report Component Editor window, click the Output Options tab.
2. Depending on the type of output generated by the component, refer to the
following points:
a. HTML Text – For a component that produces HTML output, configure the
following parameters:
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Figure 15-10:
Output
Options for
HTML format



Automatically Generate Column Headers – Leave this check box
selected to include a header row for the columns. The titles are
obtained from the Field Name column under Available Fields on the
Field Selection tab.
If you have defined a custom header row in the HTML template, clear
the check box.



Disable Main Record Output – Select the Disable Main Record
Output check box if you just require the total and average record
counts and do not want to view the list of records.



Output Total Record – Select the Output Total Records check box to
include total record count.



Output Average Record – Select the Output Average Record check
box to include average record count.



Advanced Options – NVBU uses built-in templates to format the
output for HTML reports. You can customize the formatting styles and
specify how the headers, total and average rows or the body cells
should be displayed. The custom formatting styles can be globally
applied to all HTML report templates from the Reporting tab on the
Configurator. For details, refer to the NetVault: Backup Configuration
Guide. To apply custom formatting to an individual report, select the

218

Chapter 15
Reporting
Advanced Options check box. Configure the formatting options that
are displayed below. These settings must only be configured by users
with a good knowledge of HTML. Improper configuration could result in
incorrect output.
Use the pre-text boxes to specify the following:


Opening HTML tags for custom formatting styles, e.g., font type,
font size, bold, etc.



Text or description for headers, total or average rows, or body cells

Use the post-text boxes to specify the following:


Closing HTML tags for custom formatting styles

For reports with no records, you can replace the default text “Nothing
to Display” with your own text in the Default Text to Output for an
HTML Report With No Records box.
b. Plain Text – For a component that produces plain text output, configure
the following parameters:


Automatically Generate Column Headers – Leave this check box
selected to include a header row for the columns. The titles are
obtained from the Field Name column under Available Fields on the
Field Selection tab. Clear the check box if you do not require the
column headers.



Disable Main Record Output – Select the Disable Main Record
Output check box if you just require the total and average record
counts and do not want to view the list of records.



Variable Width Output – The plain text format uses fixed field length
for proper alignment. However, this results in truncation of the records.
If you do not want to truncate the field values and display the entire
contents, select the Variable Width Output check box. The output will
not be aligned when you select this check box.



Output Total Records – Select the Output Total Records check box
to include total record count.



Output Average Record – Select the Output Average Record check
box to include average record count.
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Figure 15-11:
Output
Options for
Text format



Advanced Options – NVBU uses built-in templates to format the plain
text reports. You can customize the formatting styles to add line
breaks, tabs, separators, etc., and specify how the output should be
displayed. The custom formatting can be globally applied to all plain
text report templates from the Reporting tab on the Configurator. For
details, refer to the NetVault: Backup Configuration Guide. To apply
custom formatting to an individual report, select the Advanced
Options check box. Configure the formatting options that are
displayed below. These settings must only be configured by users
familiar with the use of control characters and escape sequences in
text output. Improper configuration could result in incorrect output.
Use the pre-text boxes to specify the following:


Line breaks, separators, etc.



Text or description for headers, total or average rows, or body cells

Use the post-text boxes to specify the following:


Line breaks, separators, etc.

For reports with no records, you can replace the default text “Nothing
to Display” with your own text in the Default Text to Output for a Plain
Text Report With No Records box.
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c. Comma Separated Values – For a component that produces a CSV
output, configure the following parameters:

Figure 15-12:
Output
Options for
CSV format



Automatically Generate Column Headers – Leave the
Automatically Generate Column Headers check box selected to
include a header row for the columns. The titles are obtained from the
Field Name column under Available Fields on the Field Selection
tab. Clear the check box if you do not require the column headers.



Advanced Options – NVBU uses built-in templates to generate and
format the CSV reports. You can customize the formatting styles, to
define custom delimiter, add line breaks, tabs, separators, etc., and
specify how the output should be displayed. The custom formatting
can be globally applied to all CSV report templates from the Reporting
tab on the Configurator. For details, refer to the NetVault: Backup
Configuration Guide. To apply custom formatting to an individual
report, select the Advanced Options check box. Configure the
formatting options that are displayed below. These settings must only
be configured by users familiar with CSV output and the use of control
characters and escape sequences. Improper configuration could result
in incorrect output.
Use the pre-text boxes to specify the following:


Line breaks, tabs, separators, etc.



Text or description for headers, total or average rows, or body cells

Use the post-text boxes to specify the following:


Custom delimiter



Line breaks, separators, etc.

For reports with no records, you can replace the default text “Nothing
to Export” with your own text in the Default Text to Output for a CSV
Report With No Records box.
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Defining Headers and Footers for the Component
The user-defined components inherit the header and footer templates from the
base component. However, you can replace them with your own custom headers
or footers. To define custom headers or footers, click the Header/Footer tab in the
Report Component Editor window. Perform steps 2–10 described in the section
Inserting Custom Headers and Footers on page 209.

15.4.7

Setting Filter Conditions
The filter conditions for a component include the include and exclude conditions,
and the conditions for raising a custom event. To set the filter conditions for a
component, perform the following steps:
1. In the Report Component Editor window, click the Filter tab.
2. In the Filter list, select the filter type:


Include – Select this filter when you want to include those records that
meet the condition you specify and exclude the remaining.



Exclude – Select this filter when you want to exclude those records that
meet the condition you specify and include the remaining.



Condition – Select this filter when you want to include those records that
meet the condition and at the same time raise an event.

3. NVBU provides two views to create and view filter expressions – Simple and
Advanced.
a. Simple View for Filter Expression – The Simple view lists the filter
expressions in a tabular format. This view is recommended for users who
do not have advanced knowledge of Structured Query Language (SQL).
Note that in this view you can join the multiple expressions using either
and or or. You cannot combine both clauses in joins. To create a filter
expression in this view, perform the following steps:
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Figure 15-13:
Simple Filter
View

1. To create a filter, click New. To create a filter expression, refer to
Creating or Modifying Filter Expressions on page 223.
2. To join another expression with and, select Match All Clauses under
Simple Filter View. Then, click New. To create a filter expression,
refer to Creating or Modifying Filter Expressions on page 223.
3. To join another expression with or, select Match Any Clause under
Simple Filter View. Then, click New. To create a filter expression,
refer to Creating or Modifying Filter Expressions on page 223.
4. To edit an expression, select it and click Edit. This opens the Edit
Filter Expression window. To modify a filter expression, refer to
Creating or Modifying Filter Expressions.
5. To remove an expression, select it and click Delete.
b. Advanced View for Filter Expression – The Advanced view uses a tree
structure to display the filter expressions. This view is intended for users
with advanced knowledge of SQL. This view allows you to use both and
and or to join expressions. To create a filter expression in this view,
perform the following steps:
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Figure 15-14:
Advanced
Filter View

1. Under Advanced Filter Tree View, right-click the root and select Add
an Expression. To create a filter expression, refer to Creating or
Modifying Filter Expressions on page 223.
2. To join another expression with and, right-click the node where you
want to add the expression. Then, select Insert Expression (AND’d).
3. To join another expression with or, right-click the node where you want
to add the expression. Then, select Insert Expression (OR’d).
4. To edit a particular expression, right-click that node and select Edit
Expression. This opens the Edit Filter Expression window. To
modify a filter expression, refer to Creating or Modifying Filter
Expressions on page 223.
5. To edit the whole filter, right-click the root node and select Edit Whole
Filter. This opens the Edit Whole Filter window. In the Edit the Filter
Here box at the bottom of the window, re-order, add, delete or change
the clauses as required. Include only the field names that are provided
in the list above.
6. Click OK to save the filter.

15.4.7.a

Creating or Modifying Filter Expressions
NVBU supports three types of filter expressions – value comparison, regular
expression comparison and field state comparison. The state comparison option is
designed for advanced NVBU users who have a good understanding of the
Reporting system.
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Figure 15-15:
Filter
Expression
window

To create or modify a filter expression, perform the following steps:
1. Depending on the expression type, choose one of the following methods:
a. Value Comparison – To generate an expression that compares a
constant, perform the following steps:
1. Select the Check Field Value option.
2. Select the field in the list. Refer to the Available Fields list on the Field
Selection tab for the field description.
3. Select the operator (=, !=, >, <, >= or <=).
4. Enter the value for comparison in the box next to the operator list. The
value you enter must match the field type. For example, enter numeric
values for Integer fields, enter YES/NO/TRUE/FALSE for boolean
fields, etc. Refer to the field type table under Information for
information on the supported value type for the fields.
b. Regular Expression Comparison – To generate an expression that
compares regular expressions, perform the following steps:
1. Select the Check Field Value option.
2. Select the field in the list. Refer to the Available Fields list on the Field
Selection tab for the field description.
3. Select Regexp Search.
4. Select the operator (=, !=, >, <, >= or <=).
5. Enter the filter expression in the box next to the operator list.
c. Field State Comparison – You can use this method to include or exclude
records based on the field state. For example, you can choose the state
Unknown to find/exclude records that are not available in one of the
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tables. To generate an expression that compares the field state, perform
the following steps:
1. Select the Check Field State option.
2. Select the field in the list. Refer to the Available Fields list on the Field
Selection tab for the field description.
3. Select the operator (=, !=, >, <, >= or <=).
4. Select the field state in the list.
2. To provide a value during runtime, select Prompt for Value. For example, to
view the details for a particular job, you can set a filter condition using the Job
ID field and select the Prompt for Value check box. When you run the report,
NVBU waits for user input, allowing you to enter the Job ID that is to be used
as the filter value. This option will only work if the report is run immediately.
The prompt will not appear if the job is scheduled to run later. For scheduled
jobs, the filtering will be done on the basis of the value you set for the field in
the Edit Filter Expression window.
3. In conjunction with the Prompt for Value check box, you can also select the
Inherit Value check box, if you want the other report components included in
the job to use the same value entered during runtime for filtering the records.
4. Click OK to save the expression.

15.4.8

Saving a Component
To select save the component, perform the following steps:
1. To create a new user-defined component, change the component title in the
Component Title box at the top right corner of the Reporting Component
Editor window.
2. Choose one of the following methods to save the component:
a. Add the Component to a Job – To add the component to a job that you
are currently defining, click Save and Add to the Job on the toolbar.
Alternatively, on the File menu, click Save to Job.
b. Save the Component for Future Use – To save a component for future
use, click Save on the toolbar. Alternatively, on the File menu, click Save.
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15.5.0

Working with Historic Reports
NVBU keeps a copy of the data set that was used to generate a report, allowing
you to re-analyze the historic data by applying new settings/filters. By default, the
data that is excluded as a result of some filter condition is not saved. To keep a
copy of the excluded data, the Keep Filtered out Records check box must have
been selected for the template. For details on this option, refer to Retaining
Excluded Data for Historic Reports on page 211. This allows you to re-apply the
filters on the entire data set. To run a historic report again, perform the following
steps:
1. Open the Reports window.
2. Click Historic Reports on the toolbar. Alternatively, on the Reports menu,
click Historic Reports. This opens the Historic Reports View window.

Figure 15-16:
Historic
Reports vView

3. The historic reports are listed under Available Components. By default, the
reports are arranged by job date in a descending order.
You can change the view to Title in the Viewing Method list for an
alphabetical listing of components. To view run date with the alphabetical
listing, select All in the Viewing Method list.
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4. To run all the components for a historic report again, right-click the report and
choose Select All Job Components or Select Everything from Job.
To add selective components, right-click the report and select Show
Components. The components included in the report are listed under this
node. Double-click a component to include it in the report.
5. To include components from multiple reports, repeat step 4 for each historic
report. The added components are displayed under Selected Components.
6. In the Selected Components list, you can change the order of the
components in which they appear in the report. Select the component in the
list, and then click Up or Down.
7. To modify an added component, select it in the Selected Components list
and click Edit. This opens the Report Component Editor window. For
details on modifying a component, refer to Working with User-defined
Components on page 212.
This allows you to add, remove and modify the include, exclude and
conditional filters.
Important: Any changes you make to the component are applied only to the
current instance of the historic report. You cannot save the changes made to the
component.
8. To remove a component, select it in the Selected Components and click
Remove.
9. To modify header/footer, click the Header/Footer tab. For details on
modifying or inserting a header, refer to Inserting Custom Headers and
Footers on page 209.
10.If a conditional filter has been set for the report, the Apply Condition Filters
check box is selected by default. To disable the conditional filters, you can
either delete the condition filters as described in step 7, or clear this check
box.
11. To generate and view the report, click View Report on the toolbar.
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15.6.0

Editing/Viewing a Report Template
To edit/view a report template, perform the following steps:
1. Choose one of the following methods to load the report definition:
a. Load the Template from the Report Window – This method can be
used for both saved and scheduled jobs.
1. Open the Reports window.
2. Click Report Job on the toolbar. Alternatively, on the Reports menu,
click Report Job. This opens the Reporting Job Editor window
3. Click Load on toolbar, or on the File menu, click Load.
4. In the Select the Report to Load window, select the report and then
click OK. The template is loaded in the Reporting Job Editor window.
b. Load the Template from the Jobs Tab of the Reports Window – This
method can be used for both saved and scheduled jobs.
1. Open the Reports window.
2. On the Jobs tab, right-click the job and select Edit/View Job. The
template is loaded in the Reporting Job Editor window.
c. Load the Template from the Status Tab of the Reports Window – This
method can only be used for scheduled jobs.
1. Open the Reports window.
2. Click the Status tab; right-click the job and select Edit/View Job. The
template is loaded in the Reporting Job Editor window.
2. Refer to the following sections to modify the template:

15.7.0



Selecting the Report Components



Inserting Custom Headers and Footers



Defining Job Schedule



Setting up a User-Defined Notification Event



Finalizing and Submitting a Job

Viewing Logs for Report Jobs
To view the report job logs, perform the following steps:
1. Open the Reports window.
2. On the Status tab, right-click the report and select View Log. This opens the
NVBU Logs window. Only the logs messages related to the selected report
job are displayed in this window.
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15.8.0

Deleting a Report Template
To delete a report template, perform the following steps:
1. Open the Reports window.
2. On the Jobs tab, right-click the report and select Delete.
3. In the confirmation window, click Yes.
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Chapter 16:

DOMAIN MANAGEMENT
This chapter describes how to use an NVBU Server to manage multiple sites. The
information in this chapter is organized into the following topics:


Domain Management – An Overview



Adding an NVBU Server


16.1.0

Locating an NVBU Server



Controlled Server Status Summary



Logging on to a Controlled Server



Changing the Default NVBU Server



Viewing Properties of a Controlled Server



Checking Access to a Remote NVBU Server



Removing a Controlled Server

Domain Management – An Overview
NVBU is designed to work in an environment in which one machine is configured
as an NVBU Server and various other machines throughout the network act as
NVBU Clients assigned to it. A single Server and its Clients make up a NVBU
Domain. NVBU allows you to administer a Domain either locally from the machine
acting as the NVBU Server, or remotely from another NVBU Server outside the
Domain. This enables centralized administration of multiple sites from a single
location.
An NVBU Server that is accessed remotely is referred to as a Controlled Server.
To control an NVBU Domain remotely, the first step is to grant access to the
Domain by adding the remote NVBU Server to a Controlling Server. This is done
from the NVBU Domain Management window.
To perform a remote operation, just open the corresponding window and select the
Server in the Server Selection list under the menu bar. For example, to add a
Member Client to a remote NVBU Server, open the NVBU Client Management
window. In the Server Selection list, select the NVBU Server for that Domain, and
complete the steps for adding a Client. Similarly, to backup a Member Client of a
remote NVBU Server, open the NVBU Backup window. In the Server Selection
list, select the NVBU Server for that Domain, and complete the steps for
submitting a backup job.
To use this feature, the Controlling and the Controlled Servers must run the same
version of NVBU Server software.
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16.2

Adding an NVBU Server
To add an NVBU Server to a Controlling Server, perform the following steps:
Note: Before proceeding ensure that both the Controlling and the Controlled
Servers run the same version of NVBU Server
1. On the Administration menu, click Domain Management.
2. Under Available NVBU Servers, you will find a list of NVBU Servers located
in the network. The current status of a Server is represented with the
following status indicators:

Figure 16-1:
NVBU
Domain
Management
window



Blue – This icon represents an online Server.



Red – This icon represents an offline Server.

3. To add a Server that is currently available, double-click the Server in the
Available NVBU Servers list. Alternatively, right-click the Server and select
Add as Server.
4. In the Password Required, configure the following parameters:
Figure 16-2:
Password
Required
window
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Enter Password – In the Enter Password box, enter the NVBU
password for the Server.



Save Password – To save the Server password, select Save Password.
This allows automatic logon to the Controlled Server without waiting for
user input. Otherwise, you must enter the password manually each time
you want to perform a remote operation.

5. Click OK to add the Server. The added Server is listed under Controlled
Server.

16.2.1

Locating an NVBU Server
To locate a Server that is not listed under Available NVBU Servers, perform the
following steps:
1. Under Find NVBU Machine at the bottom right, enter the NVBU name for the
Server or its IP address.
2. Click Find. NVBU rescans the network to locate the Server. If found, the
Server is listed under Available NVBU Servers in alphabetical order
Note that a search can also fail for a number of reasons, including the
following:

16.3



The DNS lookup table or the machine’s host table cannot be contacted.



The NVBU Service is not running on the machine.



NVBU is removed from the machine.

Controlled Server Status Summary
The Controlled Servers are listed under Controlled Servers on the NVBU
Domain Management window. Each Server is accompanied by one of the
following status indicators:
A Blue icon indicates that the Server is up and running. It can be
accessed to perform any operation remotely.
A Red icon indicates that the Server is currently unavailable. Either the
machine is offline or the NVBU Service is not running.

16.4

Logging on to a Controlled Server
To log on to a Controlled Server in order to manage it remotely, perform the
following steps:
1. Open the corresponding window. For example, to backup a Client added to a
remote NVBU Server, open the Backup window.
2. In the Server Selection list, select the Server for the remote NVBU Domain.
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Figure 16-3:
Controlled
Servers listed
in Sever
Selection list

3. When you log on to the Remote Server, the Console will switch to that of the
Controlled Server. For example, when you change the Server in the Backup
window, the Selections tab will display the Clients added to the selected
Server.
4. If you saved the Server password while adding it, no action is required in this
step. If the password was not saved, perform the following steps:
a. In the Password Required window, enter the valid password for the
Server.
b. Select Save Password to enable auto logon for future operations.
c. Click OK.
5. Perform the steps to complete the task. Refer to the relevant section of the
guide for instructions.

16.5

Changing the Default NVBU Server
To make remote management easier, NVBU allows you to designate a remote
NVBU Server as the Default Server. This eliminates the need to select the Server
in the Server Selection list before performing each operation. Until you change the
default Server again, all the operations are performed on the selected NVBU
Server. To designate a remote NVBU Server as the Default Server, right-click the
target Server under Controlled Servers and select Make Default. You can reset
the default Server or designate another Controlled Server as the default Server by
performing the same step.
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Viewing Properties of a Controlled Server
To view the properties of a Controlled Server, perform the following steps:
Note: This procedure can only be used if you are logged on to the Controlled
Server. For details, refer to Logging on to a Controlled Server on page 233.
1. Under Controlled Servers, right-click the Server and select Properties.
2. The Server Properties window contains five tabs – System, Plugins,
Installed Software, Capabilities and Usage. Click the corresponding tab to
view the following information:

Figure 16-4:
Server
Properties
window



The System tab displays the Machine Name and Description, NVBU
Version and Build Number, Machine ID, Network Name of the machine, IP
Address, Release Information and OS Version.



The Plugins tab lists the NVBU Plugins installed on the Server. The
details include the Plugin Name, Version, Plugin ID, and Installation Date
and Time.



The Installed Software tab lists all the NVBU Plugins installed on the
Server. The details include the plugin name and the installation date.



The Capabilities tab provides the license information for the built-in
plugins.



The Usage tab provides the license usage information for the built-in
plugins.

3. Click OK to close the window.
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16.7

Checking Access to a Remote NVBU Server
To check access between the Controlled and the Controlling Servers, perform the
following steps:
1. Under Controlled Servers, right-click the machine and select Check
Access.
2. NVBU attempts to connect to the Controlled Server and displays the status
message corresponding to the machine accessibility.
3. Click OK to close the dialog.

16.8

Removing a Controlled Server
To remove a Controlled Server, perform the following steps:
1. Under Controlled Servers, right-click the Server and select Remove.
2. In the confirmation window, click Yes.
The Server is removed and listed again under Available NVBU Servers.
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Chapter 17:

NVBU CLIENT CLUSTERS
This chapter provides guidelines and information that will help you set up and use
NVBU in a cluster environment. The information in this chapter is organized into
the following topics:


NVBU Client Cluster Support – An Overview



Virtual Clients – An Overview



Installing a Cluster-aware Plugin





Prerequisites



Installation Procedure

Configuring a Cluster-aware Plugin


Configuring Preferred Network Address



Configuring Default Parameters



Configuring Tape Devices in a Cluster Environment



Managing Virtual Clients





Modifying a Virtual Client



Checking Access to a Virtual Client



Finding the Real Client



Granting User Access to a Virtual Client



Removing a Virtual Client



Upgrading a Cluster-aware Plugin

Backing up Data Using a Cluster-aware Plugin


Cluster Failover During Backups



Restoring Data Using a Cluster-aware Plugin



Viewing Logs and Job Status
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17.1.0

NVBU Client Cluster Support – An Overview
NVBU provides several cluster-aware plugins, which require Cluster Support
License Keys. The cluster nodes are grouped together into a Virtual Client on
which the cluster-aware plugin is installed. The cluster backups and restores are
performed using the Virtual Client. The NVBU plugins which can be deployed in a
cluster setup include the following:


File System Plugin – This plugin is shipped with the NVBU software and can
be used to backup the shared file system data on the following platforms:


Windows Server Clusters



Linux Clusters



Sun Clusters (Solaris SPARC)

For details on the supported cluster software versions, refer to the NetVault:
Backup Supported Platforms Matrix at www.bakbone.com/compatibility. A
default installation of NVBU does not require licensing of its native File
System Plugin. However, to use this plugin in a cluster setup, a File System
Cluster Support license key is required.

17.2.0



NVBU APM for SQL Server (SQL Server APM) – This APM can be used in
an SQL Server Failover Cluster setup to backup the database. For details,
refer to the NetVault: Backup APM for SQL Server User’s Guide.



NVBU APM for Exchange Server (Exchange Server APM) – This APM can
be deployed in an Exchange Server Single Copy Cluster (SCC)/Failover
Cluster or Cluster Continuous Replication (CCR) setup to backup the
Exchange Server. For details, refer to the NetVault: Backup APM for
Exchange Server User’s Guide.

Virtual Clients – An Overview
In NVBU, the cluster nodes are grouped together into a single entity called the
Virtual Client. This entity is created when you install a cluster-aware plugin.
A Virtual Client is managed just like any other standard NVBU Heterogeneous
Client. You can browse this Client in the same manner as any other
Heterogeneous Client in NVBU, add it to Client Groups and Policies, grant or deny
user access to it, and generate reports for it. A Virtual Client is represented with a
yellow icon (instead of blue).
Although the NVBU Server administers the creation and configuration of a Virtual
Client, the plugin runs locally on the Member Client and the data is processed
locally. Therefore, a SmartClient configured within a cluster will send data directly
to the attached physical or virtual tape library.
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Installing a Cluster-aware Plugin
This section explains how to install a cluster-aware plugin.

17.3.1

Prerequisites
Before starting the plugin installation, refer to the following notes and complete the
required tasks:

17.3.2



Install the NVBU Server software on the designated machine. The Server
must be a separate machine outside the cluster setup. For instructions on
installing the software, refer to the NetVault: Backup Installation Guide.



Install the NVBU Client software on the cluster nodes. For instructions on
installing the software, refer to the NetVault: Backup Installation Guide.



Add NVBU Clients to the NVBU Server. For details on adding a
Heterogeneous Client, refer to NVBU Client Management on page 25.



Copy the installation file (.npk) for the cluster-aware plugin to ...\packages
folder on the NVBU Server (where ... represents the NVBU installation
directory). The File System Plugin (for the Server operating system) is
already available in this folder. You can also copy the installation files to subfolders within.

Installation Procedure
To install a cluster-aware plugin, perform the following steps:
1. Open the Client Management window (click Client Management on the
toolbar or Large Buttons panel, or on the Administration menu, click Client
Management).
2. On the Cluster menu, click Create Virtual Client to open the NetVault
Virtual Client Installation window.

Figure 17-1:
NetVault
Virtual Client
Installation
window

3. Under Cluster Eligible Client List, the available NVBU Clients are listed in
the box to the left. Use Shift+Click to select consecutive Member Clients and
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Ctrl+Click to select non-consecutive Member Clients, and then click the right
arrow. The selected Clients are moved to the box to the right and grouped as
a Virtual Client.
Note: Although NVBU Server is listed as an eligible Client, it must not be included.
To remove any Client from the group, select the Client in the box to the right
and click the left arrow.
4. In the Package list, select the installation file for the plugin. This list contains
all the cluster-aware .npk files copied to the packages directory and its subdirectories The files are named as follows (where x-x-x-x refers to the build
and version numbers):
Plugin Name

Binary File Name

File System Plugin for Windows

win-x-x-x-x.npk

File System Plugin for Linux

nvf-x-x-x-x.npk

File System Plugin for Solaris (SPARC)

nvf-x-x-x-x.npk

SQL Server APM

sql-x-x-x-x.npk

Exchange Server APM

exs-x-x-x-x.npk

5. In the Virtual Client Name box, enter a unique name for the Virtual Client.
The name cannot be changed. Spaces are not recognized in a Virtual Client
name and will be replaced with underscores (“_”).
6. In the Application IP Address box, enter the cluster application’s IP
address.
7. Click OK. The NVBU Server begins installing the plugin on all the Member
Clients. This process overwrites any standard version of the same plugin
installed on the members. However, you can use the cluster-aware version to
make backups of the local/non-shared data.
Once the installation is complete, the Virtual Client is displayed under Clients
in the NVBU Client Management window, represented by a yellow icon.

17.4.0

Configuring a Cluster-aware Plugin
This section explains how to configure a cluster-aware plugin.

17.4.1

Configuring Preferred Network Address
To access the cluster nodes via their public IP addresses, perform the following
steps:
1. Determine the IP address for the cluster node. (You can use the ifconfig
method on Linux/UNIX platform, or the ipconfig command on Windows.)
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2. Start the NVBU Configurator.
3. Click the Network Manager tab and then click the Connections tab.
4. In the Preferred Network Address box, enter the machine's public IP
address.
5. Click Apply to save the setting, followed by OK to close the window.
6. Repeat steps 1-4 for each Member Client.

17.4.2

Configuring Default Parameters
To configure the default attributes for cluster backups and restores, perform the
following steps. These values can be changed on a per-job basis from the NVBU
Backup window. To configure these parameters for backups of local data, refer to
the relevant APM/Plugin User’s Guide.
1. Open the NVBU Backup window on the NVBU Server (click Backup on the
toolbar or Large Buttons panel, or on the Operations menu, click Backup).
Note: The default attributes for cluster backups and restores can be set only via
the Backup Selections tab. Setting these attributes via the Configurator or
Remote Configurator is not supported for the cluster backups and restores.
2. On the Selections tab, locate the Virtual Client. Double-click this node, or
right-click and select Open.
3. Right-click the cluster-aware plugin and select Configure to open the
Configure window. The configuration settings for the cluster-aware version
are the same as the standard version. Refer to the relevant APM/Plugin
User’s Guide to configure these settings.
4. Click OK to save the settings. These settings are stored on the NVBU Server
in a configuration file specific to the Virtual Client and applied during cluster
backups and restores. These settings only apply to backups and restores of
shared data performed via Virtual Client.

17.5.0

Configuring Tape Devices in a Cluster
Environment
In a cluster setup, a backup device can be connected in different ways. This
section describes the pros and cons of some of the device configuration methods.


Connecting a Device to NVBU Server or SmartClient – The pros and cons
of this configuration are described below:


This type of configuration allows the control of a robotic arm.



However, during backups and restores, the data is transferred over the
network.
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17.6.0

Sharing Drives – A derivative of the previous method can be used by
connecting the physical library to the NVBU Server, thus, giving it the control
of robotic arm, and sharing the drive with the cluster nodes. This allows the
control of robotic arm and at the same time enables local data transfers. The
pros and cons of this configuration are described below:


This configuration offers high drive availability. With all Member Clients
sharing the control of drives, the drives are always available.



However, the member Client that currently controls the drive need not be
the node that currently controls the cluster.

Connecting a Device to a Cluster Node – The pros and cons of this
configuration are described below:


This configuration offers the fastest method of data transfer as the data is
routed directly to a locally attached device.



However, the disadvantage is that the robotic arm cannot be controlled by
a machine within the cluster, limiting the device type usage for this type of
configuration to standalone drives.



Moreover, the drive becomes unavailable when the cluster node is down.

Managing Virtual Clients
This section describes the various Virtual Client administration procedures.

17.6.1

Modifying a Virtual Client
To add or remove Member Clients, or to change the application IP address,
perform the following steps. For details on upgrading the cluster-aware version of
the plugin, refer to Upgrading a Cluster-aware Plugin on page 244.
1. Open the NVBU Client Management window.
2. Under Clients, right-click the Virtual Client and select Edit Virtual Client
Configuration.
3. In the NetVault Virtual Client Installation window, configure the required
parameters:


Cluster Eligible Client List – To add Member Clients, select the Clients
in the box to the left under Cluster Eligible Client List. Use Shift+Click to
select consecutive Member Clients and Ctrl+Click to select nonconsecutive Member Clients, and then click the right arrow. The selected
Clients are moved to the box to the right and added to the Virtual Client.
Although NVBU Server is listed as an eligible Client, it must not be
included.
To remove any Client from the group, select the Client in the box to the
right and click the left arrow.
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Application IP Address – To change the IP address for the application,
enter the new IP in the Application IP Address box.

4. Click OK to save the updated settings. NVBU Service must be stopped and
restarted if you have changed the Application IP address.

17.6.2

Checking Access to a Virtual Client
At least one of the Member Clients must be online and active for a backup/restore
job to succeed. In order to check accessibility to a Virtual Client, perform the
following steps:
1. Open the NVBU Client Management window.
2. Under Clients, right-click the Virtual Client and select Check Access.
3. NVBU will check access between the Server and each machine within the
cluster and return a message with the current status.

17.6.3

Finding the Real Client
To determine which machine within the cluster is currently in control of the cluster
application, perform the following steps:
1. Open the NVBU Client Management window.
2. Under Clients, right-click the Virtual Client and select Current Real Client.
3. The NVBU name of the controlling cluster node is displayed in a dialog box.

17.6.4

Granting User Access to a Virtual Client
To grant access to a Virtual Client while denying access to individual Member
Clients, perform the following steps:
1. Click the Client Groups tab in the NVBU Client Management window and
create a Client Group with only the Virtual Client as the member. For details
on creating a Client Group, refer to Creating Client Groups on page 32.
2. On the Administration menu, click Access Control.
3. Right-click a User and select User Properties.
4. Click the Group Memberships tab
5. Select the Client Group in the Not Member Of box and click the left arrow. Do
not select the User is a Member of All Clients Group and Local Access
Only check boxes.
6. Click Save User Details.
Note: To add and/or remove Virtual Clients, a user must have the Add/Remove
Virtual Client and Manage Software privileges. Additionally, the user requires
privileges to perform backups and restores, and to manage devices. For details on
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granting these privileges, refer to Granting Privileges for NVBU Operations on
page 197.

17.6.5

Removing a Virtual Client
If you do not want to use the plugin in a cluster setup, perform the following steps
to remove the Virtual Client:
1. Open the NVBU Client Management window on the NVBU Server.
2. Under Clients, right-click the Virtual Client and select Remove. The Virtual
Client is removed but the Member Clients are displayed as standard NVBU
Clients under Clients.
This removes the ability of the plugin to backup cluster nodes.

17.6.6

Upgrading a Cluster-aware Plugin
To upgrade to a newer version of the cluster-aware plugin, perform the following
steps:
1. First, remove the Virtual Client that was created during plugin installation. For
details on removing a Virtual Client, refer to Removing a Virtual Client on
page 244.
2. Then, create a new Virtual Client using the upgraded version of the clusteraware plugin. For details on installing the plugin, refer to Installation
Procedure on page 239. Assign the same name to the Virtual Client. If a
different name is assigned, the jobs defined for the previous Virtual Client
cannot be run again.

17.7.0

Backing up Data Using a Cluster-aware Plugin
The procedure for backing up data is similar for both the Standard Clients and the
Virtual Clients for the File System Plugin. The File System Plugin is used in the
same manner as the standard version and all the options that can be set for the
standard version are also available with the cluster-aware version. The only
difference is that when you open the Virtual Client node, just the cluster-aware
plugin that was installed during the creation of the Virtual Client is displayed.
The File System Plugin displays both the shared and local drives/mount points on
the Selections tab and does not differentiate between the two. You must make a
note of the drive letter/mount point for the shared resource and make data
selections accordingly.
For detailed instructions on backing up data in a SQL Server Failover Cluster or
Exchange Server Clustered environment, refer to the relevant APM/Plugin User’s
Guide.
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Cluster Failover During Backups
Typically, if a failover occurs when a backup job is running, the job aborts and
returns Job Failed status. You can use the Job Retry feature to run the job again
when the failover is complete. For details on scheduling job retries, refer to
Scheduling Number of Job Retries on page 124.
With the File System Plugin, when a failover occurs in Windows, the reason for the
failover has a direct bearing upon the status of the aborted job. Accordingly,
perform one of the following:

17.8.0



If the machine in control of the cluster resources goes offline during backup,
the job is aborted and returns the status Job Failed. You can use the job retry
feature to run the backup again.



If the machine in control of the cluster remains online but the actual cluster
resource that is being backed up fails, then the job is aborted and returns the
Backup Completed with Warnings status. The scheduled job retries do not
work for such jobs. In this scenario, examine the job logs to find the missing
data or run the job again to backup all data.

Restoring Data Using a Cluster-aware Plugin
The procedure for restoring data using the File System Plugin is similar for both
the Standard Clients and the Virtual Clients. The only difference is that the
backups are restored from the Virtual Client node and not the actual Client node.
When a restore job is initiated, NVBU communicates with the cluster service to
determine the controlling node and targets this machine for the restore.
For detailed instructions on restoring data in a SQL Server Failover Cluster or
Exchange Server Clustered environment, refer to the relevant APM/Plugin User’s
Guide.

17.9.0

Viewing Logs and Job Status
When you backup a Virtual Client, the data is essentially backed up from a single
client and it is accessed from the controlling node. NVBU displays the Virtual
Client name in the NVBU Jobs and NVBU Server Status windows for Virtual
Client backups and restores. The NVBU Logs window, however, displays the
actual NVBU Client name to facilitate quick troubleshooting.
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Appendix A:

PREDEFINED EVENTS
This appendix provides a brief description of the predefined event classes and
events. The information in this appendix is organized into the following topics:


A.1.0

Predefined Event Description

Predefined Event Description
NVBU includes the following predefined events:






Event Class – Audit


Failed to Update Audit File – Raised when NVBU is not able to update
the audit trail.



Update Session Map Failed – Raised when NVBU is not able to update
the session owner mapping file.

Event Class – BakBone Time


No Time Source – Raised when the BakBone Time Server is not
configured for the Domain.



Server Time Inconsistency – Raised when the BakBone Time on the
two (2) NVBU Servers controlling the NVBU Client do not match.



Server Time Unknown – Raised when the Time Server is not able to
fetch BakBone Time from the Source. By default, a Sysop Operator
Message method is set for this event.



Time Server Changed – Raised when the Time Server changes for an
NVBU Domain.



Time Server Not Responding – Raised when the Time Server does not
respond to a time request.



Time Server Removed – Raised when the Time Server is removed from
the NVBU Domain.

Event Class – Device


Check – Raised for a request to check a device.



Close Door – Raised for a request to close a library door.



Close EEPort – Raised for a request to close an Entry/Exit port.



Close EEPort Clean – Raised for a request to close an Entry/Exit port
containing cleaning media.



Device Forced Offline – Raised when any device controlled by the NVBU
Server is forced to become offline.
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Device Gone Offline – Raised when any device controlled by the NVBU
Server becomes offline.



Drive Unavailable – Raised when any drive controlled by the Server goes
offline.



Library Gone Offline – Raised when any library controlled by the Server
goes offline.



Library Scan Completed – Raised when a media scan request
completes.



Map – Raised when an ACSLS drive is mapped.



No Suitable Drive – Raised when NVBU is not able to find a suitable
drive to run a backup or restore job. By default, a Sysop Operator
Message method is set for this event.



Open Door – Raised for a request to open a library door.



Open EEPort – Raised for a request to close an Entry/Exit port.



Reconfigure Device – Raised when the device properties are modified
for an added device.



Remove – Raised when a device is removed.



Restart Library – Raised when a library is restarted.



Unmap – Raised when an ACSLS drive is un-mapped.

Event Class – Job


All Job Retries Failed – Raised when all retry attempts for a job have
failed.



Job Aborted – Raised when a job is aborted.



Job Completed Successfully – Raised when a job completes
successfully.



Job Completed with Warnings – Raised when a job completes with
warnings.



Job Created – Raised when a new job is created.



Job Deleted – Raised when a job is deleted.



Job Died – Raised when a job dies unexpectedly.



Job Failed – Raised when a job fails.



Job Finished – Raised when a job execution completes.



Job Hold – Raised when a running job is put on hold.



Job Modified – Raised when a job is modified.



Job Phase Starting – Raised when any phase of a job starts.



Job Resume – Raised when a job on hold is resumed again.
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Job Retry Scheduled – Raised when NVBU schedules retry attempt for a
failed job.



Job Run Now – Raised when a job is submitted to run immediately.



Job Scheduled – Raised when a job is submitted.



Job Stopped – Raised when a running job is halted.



Scheduled Phase Deleted – Raised when any scheduled phase for a job
is deleted.



Set Created – Raised when a new selection set is created.



Set Deleted – Raised when a selection set is deleted.



Set Modified – Raised when a selection set is modified.

Event Class – Licensing


License Exceeded – Raised when usage exceeds the available licenses.
By default, a Sysop Operator Message method is set for this event.



License Expiring – Raised when the NVBU evaluation license is nearing
expiry or has expired. It is raised when the validity period for an NVBU
evaluation license is less than or equal to 7 days. By default, a Sysop
Operator Message method is set for this event.

Event Class – Log Daemon
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Home Drive Becoming Full – Raised when the disk space usage
reaches warning or critical threshold. By default, a Sysop Operator
Message method is set for this event.

Event Class – Machines


Client Added – Raised when a new NVBU Client is added to the Domain.



Client Down – Raised when an NVBU Client becomes offline or
unavailable.



Client Group Created – Raised when a Client Group is created.



Client Group Deleted – Raised when a Client Group is deleted.



Client Group Modified – Raised when a Client Group is modified.



Client Group Renamed – Raised when a Client Group is renamed.



Client Removed – Raised when a Client is removed from the Domain.



Virtual Client Added – Raised when a cluster-aware plugin is installed on
the Server.



Virtual Client Removed – Raised when a cluster-aware plugin is
removed.

Event Class – Media


Blank – Raised for a request to blank a piece of media.



Delete Group – Raised when a media group is deleted.
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Delete Job Instance – Raised when a job instance is deleted.



Export – Raised when a piece of media is exported to an Entry/Exit port.



Import – Raised when a NetApp VTL’s shadow tape is imported to an
Entry/Exit port.



Import Clean – Raised when a cleaning tape is loaded on a drive.



Label – Raised when a media label is assigned.



Load – Raised when a piece of media is loaded on a drive.



Media Blanked – Raised when a piece of media is blanked.



Media Deleted – Raised when a piece of media is removed from the
NVDB.



Medial Full – Raised when a piece of media becomes full.



Media Labelled – Raised when a media label request completes.



Medial Loaded – Raised when a media load request completes.



Media Marked Bad – Raised when a piece of media is marked bad.



Media Request Change Priority – Raised when the media request
priority is changed.



Media Request Timeout Expired – Raised when media request has
timed out for a backup job; NVBU could not find suitable media within the
specified timeout interval.



Media Suspect – Raised when a piece of media is marked suspect.



Media Unloaded – Raised when a piece of media is unloaded.



Media Unusable – Raised when a piece of media is rejected by a drive.



No Suitable Media – Raised when NVBU is not able to find a suitable
media to complete the backup job. By default, a Sysop Operator
Message method is set for this event.



Request Off Hold – Raised when a media request is taken off hold.



Request On Hold – Raised when a media request is put on hold.



Reuse – Raised when a piece of media is marked for re-use.



Scan Request – Raised for a request to scan a foreign media.



Unload – Raised when a piece of media is unloaded.



Update Properties – Raised when media properties are modified.

Event Class – Media Database


Backup Retired – Raised when a saveset is retired and its information is
deleted from the NVDB.



Index Compressed – Raised when a backup index is compressed.



Index Decompression Failure – Raised when index de-compression
fails due to insufficient disk space.
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Index Loaded – Raised when an offline index is temporarily loaded.



Index Offlined – Raised when the backup index for a saveset is deleted
from the NVDB.



Index Read Failure – Raised when NVBU cannot read the index for a
saveset.



Index Uncompressed – Raised when a backup index is de-compressed.



Media Database Check Failed – Raised when database integrity or
reference check fails for the media database during NVDB backup.



Media Database Check Passed – Raised when the media database
check completes successfully during NVDB backup.



Media Database Check Passed with Warnings – Raised when the
media database check generates warnings during NVDB backup.



Media Database Compacted – Raised when the media database
compaction completes successfully during NVDB backup.



Media Database Compaction Failed – Raised when the media database
compaction fails during NVDB backup.



Modify Backup Expiry – Raised when the retention period is modified for
an existing saveset.

Event Class – Policy


Policy Branch Errors Acknowledged – Raised when errors/warnings
are acknowledged at a policy level.



Policy Created – Raised when a policy is created.



Policy Deleted – Raised when a policy is deleted.



Policy Errors Acknowledged – Raised when errors/warnings are
acknowledged for a particular policy job.



Policy Modified – Raised when a policy is modified.



Policy Quiesce – Raised when a quiesce request is raised for a policy.



Policy Quiesced – Raised when a policy placed in a quiesced state.

Event Class – Scheduled Database


Scheduler Database Check Failed – Raised when database integrity or
reference check fails for the scheduler database during NVDB backup.



Scheduler Database Check Passed – Raised when the scheduler
database check completes successfully during NVDB backup.



Scheduler Database Check Passed with Warnings – Raised when the
scheduler database check generates warnings during NVDB backup.



Scheduler Database Compacted – Raised when the scheduler
database compaction completes successfully during NVDB backup.
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Scheduler Database Compaction Failed – Raised when the scheduler
database compaction fails during NVDB backup.

Event Class – Stats Collection


Cache Too Small – Raised when cache memory for the Statistics
Manager process is running low; this would result in the process running
slowly.



Cannot Accept Records – Raised when the Statistics Manager process
refuses to accept data from other processes.



Lost Server – Raised when the Statistics Manager discards the I/O data
collected for a Server on polling timeout.



Stats Manager Ready – Raised when the Statistics Manager process
starts.
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Appendix B:

PREDEFINED REPORTS AND
COMPONENTS
This appendix provides a brief description of the predefined NVBU reports and
components. The information in this appendix is organized into the following
topics:

B.1.0



Available Canned Reports



Available Report Components

Available Canned Reports
NVBU includes the following canned reports:


Client Groups – Provides a list of client groups.



Client Statuses – Provides the current status of clients.



Expired Offline Media – Provides a summary of retired offline media which
can be reused.



Failed ULA Requests – Provides a summary of failed user requests for a
given period.



Full Online Media – Provides a list of online media with no free space.



Global Notifications – Provides a list of events for which any global
notification method has been set.



Historic Jobs - By Date – Provides a date-wise summary of jobs performed
during a given period. The details include the Job ID, transfer size, run length,
the job completion status, etc.



Historic Jobs - By Size – Provides a size-wise summary of jobs performed
during a given period. The details include the Job ID, transfer size, run length,
the job completion status and other details.



Library Contents – Provides a summary of currently online media. The
details include the current location (the drive or slot in a library), and the used
and available space on the media.



Media General – Provides a summary of used media. The details include the
current location, used and available space, saveset expiry date, etc.



Media Contents Query – Provides a summary of media contents. The
details include the job title, plugin name, saveset expiry date, etc. The output
can be filtered on the basis of backup target, media label, media group, job
title or plugin.
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Media Quotas and Usage – Provides a summary of used and assigned
media quota for each user.



Media Segment Contents Query – Provides a summary of media segments.
The details include the plugin name, job title, target client, etc.



Media Utilization – Provides a summary of used media, and the count of
blank media available in each backup device.



NDMP Jobs – Provides a summary of NDMP filer backups. The details
include the Job ID, title, start time, run length, client name, transfer size and
the job completion status.



NetVault Error Logs – Provides a summary of error logs generated during a
given period.



NetVault Events – Provides a summary of events raised during a given
period.



NetVault Logs – Provides a summary of system logs generated during a
given period.



Offline Devices – Provides a list of currently offline devices.



Outstanding Operator Messages – Provides a list of unacknowledged
operator messages.



Overnight Job Summary – Provides a summary of jobs scheduled to run at
night. The details include the total amount of data written, the number of
successful jobs, failed jobs, and jobs completed with warnings.



Policies Summary – Provides a summary of policy jobs performed during a
given period. For each policy, the report displays the policy name, client and
job count, policy status, list of clients, number of failed jobs and jobs
completed with warnings, and the details of failed jobs.



Restore Summary – Provides a summary of restore jobs. The details include
the Job ID, target client, job completion status, etc.



Server License - Capabilities and Usage – Provides a summary of
available and used licenses for NVBU.



Single Job Summary – Provides the job details, drive events, media transfer
details, logs and media used for a single job.



Single Policy Summary – Provides the policy status, target clients, job
details, number of failed jobs, the transfer size and transfer rate for the policy
for a single policy.



Single User's Audit Trail – Provides a summary of audit logs generated for
for a particular user. The report can be further filtered for a specific period.



User Details – Provides user details.



User Notifications – Provides a list predefined and user-defined events for
which any user notification method has been set.
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User Privileges – Provides a summary of privileges granted to individual
users.



User-defined Event Types – Provides a list of user-defined events.



Workstation Client Failed Jobs – Use this report to obtain a list of the
Workstation Client backups that have failed.



Workstation Client Jobs - By Client – Use this report to obtain a list of the
Workstation Client backup jobs sorted alphabetical by Workstation Client
name.



Workstation Client Jobs - By Date – Use this report to obtain a list of
Workstation Client backup jobs sorted in chronological order with the most
recent jots at the top of the report.



Workstation Client Successful Jobs – Use this report to obtain a list of the
Workstation Client backups that have been successfully completed.



Workstation Client Inactive For a Week – Use this report to obtain a list of
the Workstation Client that have not had a backup attempted for more than
seven (7) days. This report is ideal to determine which Workstation Clients
have not connected to the network where the NVBU Server resides long
enough for a backup to occur. It helps identify the workstation data that may
be at risk by not being protected for long-term retention or disaster recovery.

Available Report Components
NVBU includes the following predefined components:


Component Class – Advanced Options






Component Class – Audits


Audits - CLI Default Template – Use this component to view the auditor
logs in text format.



Failed ULA Requests – Use this component to view failed user requests.



Single User’s Audit Trail – Use this component to view the auditor logs
for a particular user.

Component Class – Backup Targets




Advanced Options - CLI Default Template – Use this component to
view the advanced options for a backup job in text format.

Backup Targets - CLI Default Template – Use this component to view
the target device and media details for a backup job.

Component Class – Client Groups


Client Groups – Use this component for a list of client groups.



Client Groups - CLI Default Template – Use this component for a list of
client groups in text format.
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Component Class – Clients


Client Machines - CLI Default Template – Use this component for a list
of clients in text format.



Client Statuses – Use this component to view client status.

Component Class – Defined Jobs


Defined Jobs – Use this component to view job details, including the Job
ID, title, policy name, job type and the selection sets used to define the
job.



Defined Jobs - CLI Default Template – Use this component to view the
job details in text format.

Component Class – Drive Events


Drive Events - CLI Default Template – Use this component to view the
drive events for all jobs.



Single Job’s Drive Events – Use this component to view the drive events
for a particular job.

Component Class – Drive Performance Statistics


Drive Performance Statistics - CLI Default Template – Use this
component to view the drive performance logs.



Single Job’s Data Transfer Rate – Use this component to view the data
transfer rates for a particular job.

Component Class – Drives


All Drives – Use this component to view the read/write information for
drives, including the total amount of data read/written, number of
read/write errors, and the cleaning details for the drive.



Drives - CLI Default Template – Use this component to view the drive
read/write details in text format.



Offline Devices – Use this component for a list of currently offline
devices.

Component Class – Entry/Exit Ports




Entry/Exit Ports - CLI Default Template – Use this component for a list
of entry/exit ports, and the label and barcode of the media residing in the
entry/exit ports.

Component Class – Job History


Count of Data Stored in Overnight Jobs – Use this component to view
the amount of data stored by the overnight backup jobs.



Count of Failed Overnight Backup Jobs – Use this component to view
the number of overnight backup jobs that failed.
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Count of Overnight Jobs Finished with Warnings – Use this
component to view the number of overnight backup jobs that completed
with warnings.



Count of Successful Overnight Backup Jobs – Use this component to
view the number of overnight backup jobs that completed successfully.



Currently Active Jobs – Use this component for a list of active policy
jobs.



Executed Job History – Use this component for a summary of jobs
performed during a given period. The details include the Job ID, title, client
name, plugin and the completion status for the job.



Executed Job History - CLI Default Template – Use this component for
a summary of jobs performed during a given period in text format.



Failed Jobs within Single Policy – Use this component for a summary of
failed jobs for a policy.



Failed Overnight Backup Jobs – Use this component for a summary of
failed overnight backup jobs.



Failed Policy Jobs – Use this component for a summary of failed policy
jobs.



Historic Jobs - By Date – Use this component for a date-wise summary
of jobs performed during a given period. The details include the Job ID,
transfer size, run length, the job completion status, etc.



Historic Jobs - By Size – Use this component for a size-wise summary of
jobs performed during a given period. The details include the Job ID,
transfer size, run length, the job completion status, etc.



Policy Totals – Use this component to view the total and average backup
size and transfer rates for policy jobs.



Restore Summary – Use this component for a summary of restore jobs.
The details include the target client, run length, job completion status, etc.



Single Job Main Summary – Use this component to view the job details,
including the plugin name, start and end time, transfer size, transfer rate
and the job completion status for a single job.

Component Class – Libraries


Blank Media Items in Libraries – Use this component to view the
number of blank media items available in each library.



Libraries - CLI Default Template – Use this component for a summary of
added libraries in text format.

Component Class – Drives


Library Drives - CLI Default Template – Use this component for a
summary of added drives in text format.
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Component Class – Slots








Component Class – License Capabilities


Server License Capabilities and Usage – Use this component for a
summary of available and used licenses for NVBU.



Server License Flags – Use this component to view the features
available with the installed licenses.



This Server’s License Capabilities and Usage - CLI Default
Template – Use this component for a summary of available and used
license information in text format.

Component Class – Media


Expired Offline Media – Use this component for a summary of retired
offline media which can be reused.



Full Online Media – Use this component for a list of online media with no
free space.



Libraries’ Media Contents – Use this component for a summary of
currently online media. The details include the current location (the drive
or slot in a library), the used and available space on the media.



Media - CLI Default Template – Use this component for a summary of
currently online media in text format.



Media - General – Use this component for a summary of used media. The
details include the current location, used and available space, saveset
expiry date, etc.



Media Utilization – Use this component for a summary of used media,
and the count of blank media available in each backup device.

Component Class – Media Capacities






Library Slots - CLI Default Template – Use this component for a
summary of library slots in text format.

Media Capacities - CLI Default Template – Use this component to view
the capacity of online media.

Component Class – Media Job Contents


Media Contents Query – Use this component for a summary of media
contents. The details include the job title, plugin name, saveset expiry
date, etc. The output can be filtered on the basis of backup target, media
label, media group, job title or plugin.



Media Contents Query- Textual – Use this component for a summary of
media contents in text format.



Media Used by a Single Backup – Use this component to view the
details of the media used for a particular backup job.

Component Class – Media Requests
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Media Requests - CLI Default Template – Use this component to view
the pending media requests.

Component Class – Media Segment Contents


Media Segment Contents Query – Use this component for a summary of
media segments. The details include the plugin name, job title, target
client, etc.



Media Segment Contents Query - CLI Default Template – Use this
component for a summary of media segments in text format.

Component Class – Media Transfer Requests


Media Transfer Requests - CLI Default Template – Use this component
for a summary of media read and write requests.



Single Job’s Media Transfers – Use this component for a summary of
media read/write requests for a particular job.

Component Class – NetVault Event Types


NetVault Event Types - CLI Default Template – Use this component for
a list of predefined event types.



User-Defined Event Types – Use this component for a list of custom
events.

Component Class – NetVault Events


NetVault Events – Use this component for a summary of events raised
during a given period.



NetVault Events - CLI Default Template – Use this component for a
summary of raised events in text format.

Component Class – NetVault Logs


NetVault Logs – Use this component for a summary of system logs
generated during a given period.



NetVault Logs - CLI Default Template – Use this component for a
summary of system logs in text format.



Recent Error Logs – Use this component for a summary of error logs
generated during a given period.



Single Job’s Logs – Use this component for a summary of logs
generated for a particular job.

Component Class – Notifications


Global Notifications – Use this component for a list of events for which
any global notification method has been set.



User’s Selected Notifications - CLI Default Template – Use this
component for a list of events selected for user notification in text format.
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User’s Selected Notifications – Use this component for a list of
predefined and user-defined events for which any user notification method
has been set.

Component Class – Operator Messages


Operator Messages - CLI Default Template – Use this component for a
list of operator messages in text format.



Outstanding Operator Messages – Use this component for a list of
unacknowledged operator messages.

Component Class – Policies


Policies - CLI Default Template – Use this component for a summary of
policy jobs performed during a given period in text format. For each policy,
the report displays the policy name, client and job count, policy status, and
the list of clients.



Policy Basics – Use this component for a summary of policy jobs
performed during a given period. For each policy, the report displays the
policy name, client and job count, policy status, list of clients, number of
failed jobs and jobs completed with warnings, and the details of failed
jobs.



Policy Status Information – Use this component for a summary of policy
jobs performed during a given period. For each policy, the report displays
the policy name, client and job count, number of failed jobs and jobs
completed with warnings, and the policy status.

Component Class – Policy Clients


Policy Clients – Use this component for the client list for a policy.



Policy Clients - CLI Default Template – Use this component for the
client list for a policy in text format.

Component Class – Policy Jobs


Defined Policy Jobs – Use this component for a summary of jobs
included in a policy.



Policy Jobs - CLI Default Template – Use this component for a
summary of jobs for a policy in text format.

Component Class – Privileges


Granted Privileges - CLI Default Template – Use this component for a
summary of individual user privileges in text format.



User Privileges – Use this component for a summary of privileges
granted to individual users.

Component Class – Report Templates


Report Templates Installed on System – Use this component for a list
of report templates stored in the report database.
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Component Class – Schedule Sets




Selection Options Sets - CLI Default Template – Use this component
for a summary of available backup options sets.

Component Class – Selection Sets




Segments - CLI Default Template – Use this component for a summary
of media contents in text format.

Component Class – Selection Options Sets




Schedule Sets - CLI Default Template – Use this component for a
summary of available schedule sets.

Component Class – Segments
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Selection Sets - CLI Default Template – Use this component to view the
details of the available backup selection sets.

Component Class – Users


Quotas and Media Usage – Use this component for a summary of used
and assigned media quota for each user.



User Details – Use this component to view the user details.



Users - CLI Default Template – Use this component to view the user
details in text format.
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Appendix C:

USER PRIVILEGES
This appendix provides a brief description of the user privileges required to
perform NVBU operations. The information in this appendix is organized into the
following topics:


C.1.0

Privilege Description

Privilege Description


Clients – Add/Remove Clients – Permission to add Clients to NVBU Server,
and remove them.



Clients – Add/Remove Virtual Clients – Permission to add or remove
Virtual Clients.



Clients – Administer Client Groups – Permission to create, modify and
delete Client Groups.



Clients – Configure Client – Permission to access the Remote Configurator.



Clients – Get Client Properties – Permission to view Client properties.



Clients – Set Firewall Relationship – Permission to establish the inside/
outside firewall relationship between the NVBU Server and Client.



Devices – Add Libraries – Permission to add libraries to the NVBU Server.



Devices – Add Simple Drive – Permission to add a standalone drive to the
NVBU Server.



Devices – Clean Drives – Permission to run the Clean command for an
added drive.



Devices – Manage Devices – Permission to configure device properties and
perform device management tasks.



Devices – Open and Close Entry/Exit Ports – Permission to issue open/
close entry/exit port commands.



Devices – Open and Close Library Doors – Permission to issue open/close
library door commands.



Devices – Perform Device Checks – Permission to run self-test on an offline device.



Devices – Reconfigure Devices – Permission to re-configure an added
device.



Devices – Remove Devices – Permission to remove devices from the NVBU
Server.
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Devices – Set Drive Cleaning Properties – Permission to establish a
cleaning routine for the drives.



Jobs – Abort Jobs – Permission to abort the running jobs.



Jobs – Acknowledge Policy Errors – Permission to acknowledge errors for
a policy and remove the error flags.



Jobs – Administer Backup/Restore Set – Permission to create, modify,
copy and delete backup/restore selection sets.



Jobs – Administer Policies – Permission to define and manage backup
policies.



Jobs – Delete Job – Permission to delete a job.



Jobs – Delete Scheduled Phase – Permission to delete a job schedule.



Jobs – Hold Job – Permission to put a job on hold.



Jobs – Jobs Owned by this User may Run – Permission to submit jobs.



Jobs – Quiesce Policy – Permission to quiesce an active policy.



Jobs – Restart Job – Permission to resume a stopped File System Plugin
job.



Jobs – Resume Job – Permission to resume a job that is put on hold.



Jobs – Run Predefined Job Instantly – Permission to issue the Run Now
command for a job.



Jobs – Stop Job – Permission to issue the Stop command for a restartable
File System Plugin job.



Jobs – Submit/Update Backup Jobs – Permission to submit/modify backup
jobs.



Jobs – Submit/Update Restore Jobs – Permission to submit/modify restore
jobs.



Jobs – View Backup Jobs – Permission to view the job definition for a
backup job.



Jobs – View Policies – Permission to view the policy definition.



Jobs – View Restore Jobs – Permission to view the job definition for a
restore job.



Media – Blank ANSI Media – Permission to blank a piece of media.



Media – Blank Bad Media – Permission to blank a piece of media that is
marked as Bad.



Media – Blank Media – Permission to blank a piece of media.



Media – Blank Non-NetVault Media – Permission to blank a piece of media
not used by NVBU.



Media – Export Media – Permission to export a piece of media to entry/exit
port.
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Media – Get Media or Device Status Item – Permission to view the status of
libraries and drives.



Media – Import Media – Permission to import NetApp VTL’s shadow tapes.



Media – Load/Unload Media from Drives – Permission to load or unload
media.



Media – Manage Media Requests – Permission to set the priority for media
requests and/or put a media request on hold.



Media – Mark Media for Reuse – Permission to manually mark a piece of
media as re-usable.



Media – Modify Backup Expiry Data – Permission to modify the retention
period for savesets.



Media – Remove Media – Permission to remove media information from the
NVDB.



Media – Scan a Foreign Media – Permission to scan a piece of media that is
marked as Foreign.



Media – View and Diagnose Media Requests – Permission to view and
diagnose media requests.



Media – View Backup Expiry Data – Permission to view the retention period
for a saveset.



Media – View Media Properties – Permission to view the media properties.



Media – Write Media Labels – Permission to perform individual and bulk
media labeling operations.



Reports – Modify/Edit Report Jobs and Components – Permission to
create/modify user-defined reports and report components.



Reports – View and Run Reports – Permission to generate and view
reports.



System – Change Global Notification Profile – Permission to set up
notification methods for pre-defined events.



System – Dump Log Entries – Permission to dump logs in binary or text
format.



System – Install/Remove Software Packages – Permission to install and
remove the NVBU plugins.



System – Install License Key – Permission to install license keys for the
NVBU products.



System – Manage Operator Message – Permission to acknowledge and/or
delete operator messages that are logged when an event is raised.



System – Permitted to Use CLI Tools – Permission to use the NVBU CLI
Utility.



System – Purge Log Entries – Permission to delete logs from the NVDB.
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System – Administer User Accounts – Permission to create, modify and
delete user accounts.



System – Reset Password for User – Permission to set, change or reset
password for a user.
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Appendix D:

NVBU ENVIRONMENT
VARIABLES
This appendix provides a brief description of the NVBU environment variables
which can be used in user scripts. The information in this appendix is organized
into the following topics:


D.1.0

Using Environment Variables

Using Environment Variables
NVBU provides the following environment variables which can be used in user
scripts.


NETVAULTCLIACCOUNT – Use this variable to specify a user account
name. The named account must have privileges to use the CLI utility.
NETVAULTCLIACCOUNT=<Account Name>



NETVAULTCLIPASSWORD – Use this variable to specify the password for
the CLI user account.
NETVAULTCLIPASSWORD=<Password>



NV_HOME – Use this variable to refer to the NVBU installation directory.



NV_JOBCLIENT – Use this variable to refer to the target client for the job.
NV_JOBCLIENT=<Name for the NVBU Client>



NV_JOBID – Use this variable to refer to a particular job using its Job ID.
NV_JOBID=<Job ID>



NV_JOBTITLE – Use this variable to refer to a particular job using its title.
NV_JOBTITLE=<Job title>



NV_JOB_WARNINGS – This variable indicates whether a job had warnings
during its previous phases. It returns TRUE or FALSE. This variable can only
be used in a post script. It is currently used by mail scripts but has general
applicability.



NV_SERVERNAME – Use this variable to refer to an NVBU Server.
NV_SERVERNAME=<Name of the NVBU Server>



NV_SESSIONID – Use this variable to refer to a particular job using its
session ID.
NV_SESSIONID=<Session ID>
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NV_STATUS – This variable provides the exit status of the previous phase of
a job. It returns either SUCCEEDED or FAILED. For example, when a
backup job completes successfully, NV_STATUS returns SUCCEEDED. You
can use this variable in the script to perform any conditional action based on
the job exit status.
This variable can only be used in a post script. The return value for this script
is not localized. It is SUCCEEDED or FAILED in English.



NV_USER_ARG – Use this variable to refer to the variables passed with the
pre and/or post scripts.
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NVBU PROCESSES
This appendix provides a brief description of the NVBU processes that run on the
Server and the Clients. The information in this appendix is organized into the
following topics:

E.1.0



NVBU Processes – An Overview



Process Description

NVBU Processes – An Overview
NVBU comprises several static and dynamic processes which run on the NVBU
Server and its Clients. The static processes remain active while the NVBU Service
is running and have a single digit fixed process ID. These processes generally
require the same amount of system resources throughout. The dynamic
processes are initiated and destroyed during process execution, and are assigned
a changing ID. These processes require a varying amount of system resources.
On Linux/UNIX platforms, the following command can be used to view the NVBU
processes:
ps -ef | grep nv
On Windows, these can be viewed from the Task Manager.

E.2.0

Process Description
The section briefly describes the functions of various NVBU processes.


nvpmgr (Process Manager)
nvpmgr runs on all NVBU Server and Clients. This process manages all other
NVBU processes. It creates and destroys the transient NVBU processes. The
Process Manager also manages the allocation of shared memory area for the
process table, trace buffers and progress buffers. Although the Process
Manager is assigned a static process ID, it is seen as a Dynamic process due
to its need for varying levels of system resources.
Process Type – Dynamic
Process ID – 1



nvcmgr (Inter-Process Communications Manager)
nvcmgr supports the inter-process messaging system. It runs on all NVBU
Server and Clients. The Communications Manager runs as a process on

272

Appendix E
NVBU Processes
UNIX/Linux, and as a thread within the nvpmgr process on Windows. It
handles communication between the NVBU processes on local machine.
Process Type – Static
Process ID – 2


nvnmgr (Network Manager)
nvnmgr supports the inter-process messaging system. It runs on all NVBU
Server and Clients. The Network Manager runs as a process on UNIX/Linux,
and as a thread within the nvpmgr process on Windows. It transmits the interprocess messages to remote clients. The Network Manager also broadcasts
availability messages, which help determine the current status of NVBU
Clients.
Process Type – Static
Process ID – 3



nvmedmgr (Media Manager)
nvmedmgr runs on the NVBU Server. It manages the media database, which
contains information about the media contents and online backup savesets.
The Media Manager issues high-level instructions for loading and unloading
media, which are carried out by the Device Manager processes. It controls
the selection of device and media for a job based on the media requests
submitted by the Job Manager process.
Process Type – Static
Process ID – 4



nvsched (Schedule Manager)
nvsched runs on the NVBU Server. It manages the job schedules and
queues. The Schedule Manager initiates the Job Manager process to launch
a job instance, and reschedules the next instance for recurring jobs. The
actual job execution is carried out by the Job Manager. The Scheduler
Manager manages the Scheduler database. It updates the NVBU Jobs
window, which provides an interface to view the Scheduler records. The
Schedule Manager is also responsible for providing job scheduling data to the
NVBU Reporting Tool.
Process Type – Static
Process ID – 5



nvlogdaemon (Log Daemon)
nvlogdaemon runs on the NVBU Server. It manages the system logs
generated by various NVBU processes and writes them to log files. System
logs are useful in tracking activities and troubleshooting problems. The Log
Daemon also performs periodic disk space checks, and issues alerts when
the space usage reaches the defined warning or critical threshold for Home,
Database, Logs and Reports directories.
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Process Type – Static
Process ID – 7


nvavp (Audit Verification Manager or Auditor)
nvavp runs on the NVBU Server. It tracks and controls user activities. The
Auditor Daemon validates each user request, and depending on the user
permissions, grants or denies the request.
Process Type – Static
Process ID – 8



nvstatsmngr (Statistics Manager)
nvstatsmngr runs on all NVBU Server and Clients. It collects drive statistics,
event history, media requests, server capacity and transfer information for the
NVBU reporting system.
Process Type – Static
Process ID – 9



nvrepdbmngr (Report Manager)
nvrepdbmngr runs on the NVBU Server. It manages the reports database.
The Reports Database Manger polls the Statistics Manger at periodic
intervals to get the collected data, and writes the data to the reports
database. It provides the information in the reports database to the NVBU
reporting tool and performs periodic purging of the reports database.
Process Type – Static
Process ID – 10



nvdevmgr (Device Manager)
nvdevmgr runs on the Server and Clients which have a locally-attached
device (e.g., NVBU Server and SmartClients). It performs the media reads
and writes, and handles loading and unloading of media. NVBU creates an
instance of the Device Manager process for each configured drive. In a SAN
environment, an instance runs for each NVBU Client that shares the device.
Process Type – Dynamic
Process ID – Varies



nvndmpdevmgr (NDMP Device Manager)
nvndmpdevmgr runs on the NVBU Server. It performs media reads and
writes, and handles loading and unloading of media for NDMP Filer-attached
devices. NVBU creates an instance of the NDMP Device Manager process
for each configured drive.
Process Type – Dynamic
Process ID – Varies
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nvchgmgr (Changer Manager)
nvchgmgr controls the robotic arm changer. It runs on the Server and Clients
to which the robotic arm changer is connected. NVBU creates one instance
for each arm changer.
Process Type – Dynamic
Process ID – Varies



nvndmpchgmgr (NDMP Changer Manager)
nvchgmgr runs on the NVBU Server. It controls the robotic arm changer for
NDMP filer-attached devices. NVBU creates one instance for each arm
changer.
Process Type – Dynamic
Process ID – Varies



nvjobmgr (Job Manager)
nvjobmgr runs on the NVBU Server and manages the execution of a job. It is
initiated by the Schedule Manager. A single instance of Job Manager runs for
each job until the completion of a job. The Job Manager reports on the job
state changes and the exit status of a job. It coordinates with the Data Plugin
and fetches the required information from the NVBU Server. It is also
responsible for sending drive and media requests to the Media Manager
process.
Process Type – Dynamic
Process ID – Varies



nvgui (GUI Process)
nvgui manages the Console for NVBU and runs on any NVBU machine on
which you start the Console.
Process Type – Dynamic
Process ID – None



nvguiproxy (GUI Proxy Process)
nvguiproxy allows a Server to be controlled remotely. It runs on the Controller
Server.
Process Type – Dynamic
Process ID – None



nvduplicate (Duplicate Process)
nvduplicate performs backup duplication. It runs on the selected NVBU
machine when you select the Secondary Copy phase for a backup job.
Process Type – Dynamic
Process ID – None
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nvverify (Verification Process)
nvverify performs backup verification. It verifies the stream length written to
the media and makes sure that no blocks were dropped during backup. It
runs on the selected NVBU Server or Client when you select the verification
phase for a backup job.
Process Type – Dynamic
Process ID – None



nvplgscript (Plugin Script Process)
nvplgscript executes the pre and post scripts for a job. It runs on the target
client when you select the pre and post script execution options for a job.
Process Type – Dynamic
Process ID – None
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